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1
Creating Contracts

This chapter covers the following topics:

• Overview of Oracle Service Contracts

• Elements of a Service Contract

• Managing the Service Contract Life Cycle

• Creating a Contract

• Copying Information from an Existing Contract

• Searching for a Contract or Template

• Creating a Template from a Contract

Overview of Oracle Service Contracts
Oracle Service Contracts provides a complete contract authoring execution solution
to manage warranties, extended warranties, usage, subscription services, as well as
complex service agreements. With Oracle Service Contracts you can:

• Sell multiple types of service

• Define pricing and billing schedules

• Ensure timely service entitlement checks

• Automate renewals for recurring revenue opportunities

• Simplify change management

• Minimize service revenue leakage

Elements of a Service Contract
A contract in Oracle Service Contracts comprises:

• a header, page 1-2

• one or more lines, page 1-2

• one or more sublines, page 1-3

Creating Contracts 1-1



Header
The header is where you enter a brief description and specify the contract duration. You
can default values from the header of a contract down to the lines and, if applicable, to
sublines as well.

The header level is composed of the fields at the top of the Service Contracts Authoring
form as well as the Summary tab. The Summary tab also includes several secondary
tabs. Following is a brief description of these pages:

• Parties: Enter information about the customer, including the bill to and ship to
information for the contract.

• Pricing/Billing: Assign a price list and various accounting rules for pricing and
billing contracts. In most cases, Oracle Service Contracts retrieves the contractual
prices of services or usage from Oracle Advanced Pricing, however, pricing is done
manually in some situations.

• Renewals: Define the renewal rules applied during manual or automatic renewal of
the contract.

• Administration: Define administrative components used to process the
contract, such as the QA checklist, contract groups, and workflow.

• Security/Text: Grant contract access by the resource group or user level.

Note: There are additional topics that provide detailed information
on how to default information within a contract:

• Entering Defaults for Lines, page 3-1 explains how to speed up
entry of individual contract lines in a contract by making entries
at the summary level.

• Entering Defaults for Contracts, page 2-1 explains how to enter
information which affects the contract as a whole and cannot be
changed at the line level.

Lines
Lines list the individual service, usage, and subscription items included in the contract. A
single contract can have multiple lines.

Each line inherits certain information from the contract header such as effectivity
dates, bill to and ship to information, and billing rules and schedules. These can be
changed as appropriate to allow the contract to conform to the customer requirements. A
contract line may be related to one or more sublines.

There are three line types:

• Service lines: Cover a broad category of items that can include activities such as
field service, depot repair, call center, technical support, or any other user-defined
business activities.

Each service line can cover one or more items that a customer owns.

See Entering Service Lines, page 4-3 for more information on service lines.

• Usage lines: Charge customers for usage. For example, a photo copier company
might wish to charge for the number of copies made within a period.

See Entering Usage Lines, page 5-1 for more information on usage lines.
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• Subscription lines: Cover subscriptions for both tangible and intangible
items. Tangible items include magazines, collateral, or any other physical item
that can be shipped through Oracle Order Management. Intangible items can be
collateral sent via e-mail.

See Entering Subscription Lines, page 6-1 for more information on subscription lines.

Note: Subscription lines do not have sublines.

The Lines tab includes several secondary tabs, which include:

• Accounts

• Effectivities

• Pricing/Products

• Exemption/Payment Options

• Counters

• Events

Note: The fields within each secondary tab are unique to the line
type that you select.

For details on entering lines refer to the specific line type topics.

• Entering a Service Line (General Procedure), page 4-3

• Entering a Usage Line in a Contract, page 5-3

• Entering a Subscription Line, page 6-4

Sublines
Sublines specify what the service covers or the counters where the usage is tracked. You
can access this information from the Pricing/Products subtab of the Lines tab.

Following is a description of how each line type utilizes sublines:

• Service lines: Sublines for service lines specify what the service covers. A service
line can cover a party, a customer, a site, a system, a product, or an item. See Levels
of Coverage and Their Uses, page 4-11.

• Usage lines: Sublines for usage lines specify the counters where the usage is
tracked. See Entering a Counter, page 5-17.

• Subscription lines: Subscription lines do not have sublines. See About
Subscriptions, page 6-4.

Managing the Service Contract Life Cycle
Oracle Service Contracts makes it possible for you to manage the entire contract life
cycle, including contract creation, renewal, and termination. For detailed information
refer to the following procedures:

• Creating a Contract, page 1-4

• Approving Contracts, page 10-1

• Extending and Renewing Contracts, page 14-1
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• Terminating Contracts, page 16-1

• Managing the Contract Lifecycle, page 12-1

Creating a Contract
You can create a contract manually. In addition, a contract can be created automatically
through Oracle Order Management or by creating a product that has a warranty in
Oracle Install Base. See About Ordering Service in Oracle Order , page 7-2.

To create a contract:
1. Log in under the Service Contracts Manager.

2. Navigate to Launch Contracts.

The Oracle Contracts window appears.

3. Choose New from the Tools menu.

The Create a New Contract window appears.

4. To create a contract manually:

1. Select the Create a New Contract Manually radio button.

2. Select a category using the list of values (LOV):

• If you are creating a contract with service agreements for individual items
(covered products) in the customer’s installed base, then selectWarranty
and Extended Warranty or Service Agreement. Warranty and Extended
Warranty category does not permit you to add usage lines or to sell service
to other levels of coverage (a party, site, or system).

• If you are creating a usage contract or a service agreement for levels other
than items in the customer’s install base (Products), then you must select
Service Agreement.

• If your contract includes subscriptions, then select Subscription
Agreement. Subscription agreements permit you to enter
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subscriptions, service, and usage lines. However, they do not permit
electronic renewals.

5. To create a contract using a template:

1. Select the Create a Contract from a Template radio button.

2. Select a template using the Template LOV. If you do not know the template name
you can search for the template by description and other criteria by clicking
Find. See Searching for a Contract or Template, page 1-8.

6. Click Create.

The Service Contracts Authoring window appears. The category you selected
appears in the Category field at the top of the window. The start date defaults to
today’s date.

The application supplies a contract number for you automatically after you first save
the contract, but you can instead enter a number of your own. The contract number
can be a combination of any characters, but it must be unique.

7. Optionally, enter another short identifier in the Known As field to help you identify
the contract later.

8. Specify the dates the contract is effective by entering:

• The start date or end date

• Duration and period

The dates you enter here are automatically defaulted to each new line in
the contract. The dates individual lines are effective cannot fall outside this
range, they cannot have a start date earlier then the contract start date or an
end date later than the contract end date. If you enter dates outside this range
in a contract line, then you must extend the contract dates accordingly for your
contract to pass Quality Assurance (QA).
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9. To help you identify the contract later, enter a description in the Short Description
field.

10. Save.

11. You are now ready to enter the rest of the contract information required for your
contract to become active:

Note: To speed up entry, you can copy information from an existing
contract. See Copying Information from an Existing Contract, page
1-6.

• General contract information about the contract as described in Entering
Defaults for Contracts, page 2-1. This includes the vendor and customer, what
quality check the contract must pass to become active, and how the contract
will be renewed.

• Information that will help speed up the entry of contract lines as described in
Entering Defaults for Lines, page 3-1.

• Contract lines according to procedures described in:

• Entering a Service Line (General Procedure), page 4-3

• Entering a Usage Line in a Contract, page 5-3

• Entering a Subscription Line, page 6-4

12. You can create different versions of the contract for your customer and at different
price points and send them out for review. See Creating Different Contract Versions
for Your Customer, page 12-12.

13. Check to see if you have entered all the required information in the contract or if
there is some external reason why the contract cannot be implemented, by running
the quality assurance (QA) check.

14. The QA check alerts you of any issues with your contract.

Following are examples of issues that are tracked in the QA check:

• Failure to create a billing schedule for the customer.

• Failure to include an e-mail address for the customer contact.

• Sales Credits for contract lines are absent

• Accounting department has placed the customer credit on hold.

Your contract becomes active only after it passes the QA check list and obtains the
approvals required by the Oracle Workflow process specified in the contract.

See About the Quality Assurance Check (QA Check), page 9-1 and Approving
Contracts, page 10-4.

Copying Information from an Existing Contract
You can copy information from an existing contract into a new contract, an existing
contract, or to a new modifier of the existing contract.

Note: For existing contracts, you cannot copy the components of
a contract across categories. For example, you cannot copy the
components from a Warranty into a Service Agreement.
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To copy information from an existing contract:
1. From the Contract Navigator window, right click a contract and select Copy.

The Copy window appears and is populated with the contract number that you
selected.

2. Select the information you wish to copy in the left half of the window.

You can make multiple selections by holding down the Shift or Ctrl keys on your
keyboard. You can expand the tree outlining the information by clicking on any
of the nodes.

3. Use the right arrow button to copy information from the left-side of the window
to the right (the new contract).

4. From the Copy To field select New Contract.

Note: To copy into an existing contract or create a new modifier you
can select Existing Contract or New Modifier respectively.
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5. To copy into a new contract, and make that contract a template, select the Template
check box.

When you create a new contract, you will see that template in the list of available
template contracts.

6. If you are copying a large contract and you do not want to utilize too many system
resources, you can select the Submit as Concurrent Program check box.

7. Click Create.

The application confirms the copy with a message.

8. From the message window, select OK to view the new contract.

Note: Your administrator can set the profile OKS: Copy Notes to
control whether notes are copied. If this profile is set to yes, the
notes within the existing contract are copied into the new contract.

Within the Notes window, the Entered By field indicates
ANONYMOUS if the note was copied from an existing contract.

Searching for a Contract or Template

To search for a contract or template:
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window

appears.

2. From the View menu, select Find.

The Search Templates and Contracts window appears.
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3. Enter your search criteria.

You may wish to select either a contract number or template name from the Contract
Number LOV.

4. If you have selected the Service Agreement category, click theMore button for an
enhanced search criteria for finding contracts.

1. When you click the More button, the system displays the Service Module Search
window. This window provides the ability to search on specific attributes for
service contracts, such as agreement names, date signed, order number, bill
to address, organization, and e-mail.

2. Click OK to return to the Search Templates and Contracts window.
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5. Select Search.

A list of contracts that match your search criteria appear in the Results region.

6. Select a contract, right click and select Open.
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Creating a Template from a Contract
A template makes it possible for you to speed up the contract creation process by filling
in frequently used values.

Prerequisite

Display a contract.

To create a template from a contract:
1. From the Actions menu, choose Save as Template.

The Save As Template window appears.

2. Enter a template name.

3. Click OK.

The application responds with a note informing you that the template has been
created.

Note: You can save any contract as a template.

When you create a new contract from a template, the system creates
a new contract in the Entered status. The header, lines, and sublines
from the template are copied into the new contract.

See Creating a Contract, page 1-4.
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2
Entering Defaults for Contracts

This chapter covers the following topics:

• Overview of Entering Defaults for Contracts

• Entering Parties to the Contract

• Entering Party Contacts

• Creating or Modifying a Customer Contact Record

• Specifying a Receivables Transaction Type for Payment

• Specifying How Billed Amounts Appear on Invoices

• Suspending Billing for a Contract

• Placing a Hold On Credit Memos

• Requiring and Specifying a Purchase Order for Service Charges

• Specifying How a Contract Will Be Renewed

• Automatically Renewing a Contract on Expiration

• Automatically Sending a Renewal Notice by E-Mail

• Notifying the Sales Representative to Renew the Contract Manually

• Having the Automatically Renewed Contract Submitted for Approval

• Specifying How the Renewed Contract will Be Priced

• Allowing a Grace Period for Renewals

• About Grace Periods

• Specifying a Grace Period for the Current Contract

• Specifying a Grace Period for the Renewed Contract

• Specifying and Launching the Contract Approval Workflow

• Organizing Contracts by Assigning Them to Contract Groups

• Specify a Different Quality Assurance Check List

• Entering an Estimate of Contract Revenue

• Specifying Contract Terms

• Granting Additional Access Privileges

• Entering an Additional Description or Comments
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• Setting Up Defaults for Contract Renewal

• Overview of Defaulting Levels

• Entering Default Renewal Rules

• Setting Up System Profiles for Renewal Defaults

Overview of Entering Defaults for Contracts
This group of topics explains how to enter information which affects the contract as
a whole and cannot be changed at the line level. This includes information on how
the contract is to be renewed, which quality assurance process verifies a contract’s
completeness, and the approval process the application uses to get the contract approved.

Entering Parties to the Contract
Usually entering parties to the contract is limited to your organization and the
customer, but you can also enter a third party such as a distributor or a dealer. You
can only bill accounts belonging to the parties you enter here or to related accounts as
defined in Oracle Receivables.

Prerequisites

Set up Customers and Third parties

Define profile MO: Operating Unit

To enter the parties to the contract:
1. From the Service Contracts Authoring window, select the Summary tab and Parties

subtab.

2. In the Party region, enter your organization as the vendor:

On a new line, select Vendor (orMerchant for Subscription Agreements) from the
Role LOV.

The Operating Unit set up in profile MO: Operating Unit automatically populates
in the Name field.

3. Enter the customer:

1. Choose Customer (or Subscriber for Subscription Agreements) from the Role
LOV.

2. Enter the customer name using the Name LOV.

4. Enter any third party such as a dealer or distributor:

1. Select Third Party using the Role LOV.

2. Enter the third party using the Name LOV.

Note: You can only enter third parties that do not have an
account-level relationship to the customer. Such relationships
between accounts can be set up in Oracle Receivables.

5. Save.
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Entering Party Contacts
You can enter contacts for the different parties to the contract, this includes the sales
people in your organization (the vendor).

Note: You must enter the sales person as a contact for the vendor to run
the Service Contracts Bookings report.

To enter party contacts:
1. From the Service Contracts Authoring window, select the Summary tab and Parties

subtab.

2. Select the party for which you wish to enter the contact.

3. Choose the contact’s role using the Role LOV.

4. Choose the contact from the Name (LOV). If the contact does not exist in the database
or the contact information needs to be modified, you can create a new record or
modify the existing one by choosingMaintain Contact from the Actions menu. See
Creating or Modifying a Customer Contact Record, page 2-3 for details.

5. Enter an e-mail address in the Email field or you can modify the existing e-mail
address.

6. To modify or verify phone contact information for the contact then chooseMaintain
Contact from the Actions menu. See Creating or Modifying a Customer Contact
Record, page 2-3 for details.

7. Save.

Creating or Modifying a Customer Contact Record
Using this feature, you can create or modify only basic contact information such as the
contact name, phone number, and e-mail address. You cannot use it to create a new
customer address or enter other details. To create a full customer contact record, use
the Customer Standard window in Oracle Receivables or the Contact Center window
which is available under the Customer Support responsibility. See the contact creation
procedures described in the Oracle TeleService User Guide and Oracle Receivables User
Guide for details.

To create or modify a customer contact record:
1. From the Service Contracts Authoring window, select the Summary tab and the

Parties subtab.

2. In the Party region, select the party for which you wish to create the contact. You can
create a contact either for the customer or a third party.

3. In the Contacts region, place the cursor in the Role field.

4. ChooseMaintain Contact from the Tools menu.

The Contact window appears.
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5. If you are creating a new contact, then:

1. Choose a role for this contact using the Contact Role LOV.

2. Enter the contact last and first name.

3. Use the following guidelines for entering other information:

• Choose the titles and job descriptions from the Titles and Job LOVs. These
are preset by your application administrator.

• Phone, fax, and mobile numbers are composed of three fields: a country
code (LOV), an area code, and the number itself. Do not use any delimiters
in entering your number.

• For the contact address, you can only choose one of the existing party
locations. You can add a mail stop or a mail box, however, by pressing the
Tab key after entering the address.

6. If you are modifying an existing contact, then you can:

• Change the title and job description by selecting a different one from the Title
and Job LOVs.

• Change the phone, fax, and mobile numbers.

• Change the e-mail address.

Note: When modifying existing contact information, be aware
that you are modifying the contact record for all Oracle
E-Business Suite applications.

You cannot modify the address or mail stop number. to select
another address or enter a different mail stop, then you must:

• Navigate back to the Service Contracts Authoring window.

• Delete the contact by selecting it and clicking Delete in the toolbar.

2-4 Oracle Service Contracts User Guide



• Create a replacement contact with the correct address information.

Note: Deleting the contact from the contract does not delete
it from the database. Creating a replacement record creates a
duplicate.

7. If you are modifying an existing contact and wish to revert to the existing
record, then click Reset.

8. Click OK to return to the Service Contracts Authoring window.

9. Save.

Specifying a Receivables Transaction Type for Payment
Oracle Receivables uses transaction types to specify which accounts are credited for
customer payment.

Prerequisite

Review the Oracle Receivables transactions types created for your organization.

To specify a Receivables transaction type for payment:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. Choose the transaction type from the Transaction Type LOV.

Specifying How Billed Amounts Appear on Invoices
You can have the amounts itemized for each subline or included in the contract line.

To specify how billed amounts appear on invoices:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. If your organization has implemented a custom invoices solution for billing
contracts, then you can use that solution by selecting the Summary check box.

3. To summarize billed amounts by contract line, then select the Summary Transaction
check box.

4. To itemize charges by subline, then leave the Summary check box unselected.

Note: The contract administrator must set the system profile
OKS: Summary Transactions to No. If this profile is set to Yes, then
the application sends the summarized billing details even when you
leave this check box unselected.

5. Save.
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Suspending Billing for a Contract
Normally all eligible billing records are automatically passed to Oracle Receivables for
invoicing on the invoice date you specify in the billing schedule. An example of when
you may wish to suspend billing for a contract is because the customer has disputed
the invoice.

To suspend billing for a contract:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. Deselect the AR Interface check box.

3. Save.

When you wish to resume billing, select this check box again and the customer is
billed for all outstanding charges since your suspension started.

Placing a Hold On Credit Memos
You can place a hold on credit memos until the next billing cycle. This setting does
not hold invoices.

By default the holds credit check box is not selected, so the credit memo immediately
picks up the billing amount.

To place a hold on credit memos:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. Select the Hold Credits check box.

3. Save.

Deselect this check box when you wish to credit the customer immediately.

Requiring and Specifying a Purchase Order for Service Charges
You can specify a purchase order or require an agent to specify a purchase order number
for charges not covered by the contract.

To determine which purchase order number appears in invoices, the application first
checks the service request associated with the service being performed. It only uses the
purchase order you enter here when no number is entered in the service request.

Requiring the entry of a purchase order, prevents the contract from passing the QA
check and reaching Active status until the entry is made. It does not prevent the service
from being scheduled or performed.

To require or specify a purchase order for service charges:
1. From the Service Contracts Authoring window, select the Summary

tab, Pricing/Billing subtab, and Service Charges region.
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2. To require entry of the purchase order number and prevent the contract from
becoming active until the entry is made, then select the Purchase Order Required
check box.

3. To enter the purchase order number, you can do so in the PO Number field.

4. Save.

Specifying How a Contract Will Be Renewed
Your application administrator can set up automatic defaults for contract renewals. See
Setting Up Global Defaults for Renewals. If such defaults exist, then you may not be
required to enter renewal information. Check with your application administrator.

To renew the contract, you must also specify how to renew each line. See Specifying
How a Contract Line is to Be Renewed, page 4-9.

To specify how the contract is to be renewed:
1. From the Service Contracts Authoring window, select the Summary tab and the

Renewals subtab.

2. Choose the renewal type from the Type LOV and enter information appropriate for
each type. The information you must enter differs based on your selection. You can:

• Prevent a contract from being renewed, by choosing Do Not Renew.

• Have the contract renewed automatically by choosing Active Contract. See
Automatically Renewing a Contract on Expiration, page 2-8 .

• Have the application automatically notify the customer by e-mail to renew
over the Web, by choosing Electronic Renewal. See Automatically Sending a
Renewal Notice by E-Mail, page 2-8.
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• Notify the sales agent when the contract comes up for renewal, by choosing
Notify Sales Rep. See Notifying the Sales Representative to Renew the Contract
, page 2-9.

• Create a renewed contract and submit it for approval, by choosing Submit
for Approval. See Having the Automatically Renewed Contract Submitted
for Approval, page 2-9.

3. To specify a billing schedule for the renewed contract, then select a billing profile
using the Billing Profile LOV.

Billing profiles are templates you can use to specify simple periodic billing schedules
and accounting and invoicing rules for the renewed contract. This schedule
overrides any billing schedule in the contract that is being renewed. Creating Billing
Profiles, page 11-3.

4. Specify how the renewed contract is to be priced. For details, see Specifying How
the Renewed Contract will Be Priced, page 2-10.

5. Save.

Automatically Renewing a Contract on Expiration
You can have the contract renewed automatically after it expires. The contract continues
to renew until a date you specify.

To automatically renew a contract on expiration:
1. From the Service Contracts Authoring window, select the Summary tab and the

Renewals subtab.

2. Choose Active Contract from the Type LOV in the Renewal region.

3. Specify a date in the Renew Up To field. The contract will keep on renewing
automatically until this date.

4. Save.

Automatically Sending a Renewal Notice by E-Mail
Electronic renewal is available for Warranty and Extended Warranty and Service
Agreement categories of contracts. It is not available for contracts of category
Subscription Agreement.

The e-mail the application sends includes a hyperlink the customer can use to access
your organization’s web site and renew the contract.

Prerequisite

Confirm the setup of electronic renewal.

To automatically send a renewal notice by e-mail:
1. From the Service Contracts Authoring window, select the Summary tab and the

Renewals subtab.

2. Choose Electronic Renewal from the Type LOV in the Renewal region.

3. In the Quote to region, use the LOV to enter the contact, e-mail address, and phone.
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Note: The contact must have an existing e-mail address. You cannot
add new addresses here.

4. Save.

Notifying the Sales Representative to Renew the Contract Manually
You can have the application automatically send a notification to the Inbox of the sales
representative associated with your contract. The application determines the appropriate
sales representative based either on sales territories or, if the system profile OKS: Use
Territories to Default Sales Person is set toNo, it notifies the sales representative specified
in the system profile OKS: Default Sales Person for Renewal.

Note: Setting the renewal type to Notify Salesrep does not necessarily
guarantee that the contract will be renewed accordingly. The system
may override this option based on the Evergreen and Online renewal
types as well as thresholds specified in the Global Contracts Defaults.

Prerequisites

Confirm the setup of sales territories, or set OKS: Use Territories to Default Sales Person
toNo and specify the sales person who will handle renewal requests in the profile option
OKS: Default Sales Person for Renewal.

To notify the sales representative to renew the contract manually:
1. From the Service Contracts Authoring window, select the Summary tab and the

Renewals subtab.

2. Choose Notify Sales Rep from the Type LOV in the Renewal region.

3. To require the sales representative to enter a purchase order before the contract can
be renewed, select the PO Required check box.

Having the Automatically Renewed Contract Submitted for Approval
You can have the application create a renewed contract and submit it for approval to the
person specified in the system profile OKC: Contract Approver.

Prerequisite

Specify the approver in OKC: Contract Approver

To have the automatically renewed contract submitted for approval:
1. From the Service Contracts Authoring window, select the Summary tab and the

Renewals subtab.

2. Choose Submit for Approval from the Type LOV in the Renewal region.

3. To require the entry of a purchase order before the contract can be approved, then
select the PO Required check box.
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Specifying How the Renewed Contract will Be Priced

To specify how the renewed contract will be priced:
1. From the Service Contracts Authoring window, select the Summary tab and the

Renewals subtab.

2. From the Pricing Method LOV, choose a pricing method. The available choices are:

• Price List: Charges the customer based on the price list you enter in the Price
List field. The price charged is the current price listed in the price list at the
time the contract is renewed.

• Manual: The application retains the price of the original contract for the
renewed contract.

• Markup Percent: Automatically adjusts the price up or down by a percentage
you enter. (A positive number marks up the price; a negative number discounts
it.) Optionally, you can cap the maximum adjustment based on a price list.

3. If you have selected Price List, then enter the price list to be used for the renewal in
the Price List field.

4. If you have selected Markup Percent, then:

1. Enter the percentage you wish the price to be adjusted. Entering a positive
number marks up the price. A negative number discounts the contract renewal.

2. If you are marking up the contract price and wish to put a limit on the maximum
price the customer will pay, then enter a price list in the Price List field. The price
of the renewed contract cannot go over the price listed in the price list.

For example, if you enter 20% as your markup and the current list price of the
service is $100, then the renewed contract is priced at $120. If you enter a price list
that lists the service at $110, however, then this price list caps the maximum price
for the service at $110. The customer pays a maximum of $110 for the renewal.

Note: The price cap works only for (positive) markups and not
for discounts.

Allowing a Grace Period for Renewals
By entering a grace period, you can extend the service a customer receives while a
renewed contract is in the process of being negotiated and approved. This group of
topics explains how grace periods work and how to set them up:

• About Grace Periods, page 2-10

• Specifying a Grace Period for the Current Contract, page 2-11

• Specifying a Grace Period for the Renewed Contract, page 2-12

About Grace Periods
By specifying a grace period you grant the customer the services of a contract beyond
the expiration date at no extra charge. Grace periods ensure the customer does not
experience an interruption of service while a contract is being renegotiated, for example.
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The actual start and end dates of the contract and the billing schedule are unaffected
by the grace period.

If the renewal happens within the grace period, the new contract takes effect the day
after the original contract expired and the customer is billed accordingly.

Suppose, for example, that a customer calls on January 15 to renew a service contract
that expired on December 31. Because the contract had a one month grace period, the
customer did not experience any interruption of service, but the new contract goes
into effect and is billed from January 1 rather than from the date of the call or the end
date of the grace period.

You can specify a grace period both for the current contract and for the renewed contract.

You can use the Global Contracts Defaults form to set up a standard grace period for
the contracts that are renewed.

The grace period affects only lines and sublines that expire on the same day as the
contract.

For example:

• Contract start date: 01-JAN-2003 end date 31-DEC-2003

• Service 1 start date 01-JAN-2003 end date 31-JAN-2003

• Service 2 start date 01-JAN-2003 end date 31-DEC-2003

• Service 3 start date 01-OCT-2003 end date 31-DEC-2003

If you add a 30 day grace period to this contract, services 2 and 3 are eligible for
entitlement until 30-JAN-2004. Service 1 is not.

The same logic applies to sublines and coverage terms. Only those items that end on
the same day as the contract end date are considered for coverage during the grace
period. As long as the business processes are eligible for entitlement, the original terms
associated with the business process (preferred engineer, coverage times, reaction
times, resolution times, and billing types) will continue through the extended period.

You can delete the grace period from the contract at any time, either before the contract
expires, when the grace period goes into effect, or when the renewed contract becomes
active.

Specifying a Grace Period for the Current Contract
You can grant, modify, or deny a grace period for the current contract. During a grace
period, the customer continues the same level of service as under the old contract, at
no extra charge, if the contract expires.

Prerequisite

Set the profile option OKS: Enable Grace Period to Yes at the Site Level.

To specify a grace period for the current contract:
1. From the Service Contracts Authoring window, select the Summary tab and the

Administration subtab.

2. To grant a grace period:

1. Enter a number in the Grace Duration field. (For example: 30)
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2. Choose the unit of measure from the Grace Period LOV. (For example: Days)

3. To adjust the grace period, make changes in these same fields.

4. To deny an existing grace period, delete the entry in the Grace Duration field.

5. Save.

Specifying a Grace Period for the Renewed Contract
A grace period becomes effective upon the expiration of the renewed contract.

Prerequisite

Set the profile option OKS: Enable Grace Period to Yes at the Site Level.

To specify a grace period for the renewed contract:
1. From the Service Contracts Authoring window, select the Summary tab and the

Renewals subtab.

2. To grant a grace period, then:

1. Enter a number in the Grace Duration field. (For example: 30)

2. Choose the unit of measure from the Grace Period LOV. (For example: Days)

3. To adjust the grace period, then make changes in these same fields.

4. To deny an existing grace period, then delete the entry in the Grace Duration field.

5. Save.

Specifying and Launching the Contract Approval Workow
The approver for the default process supplied with your application is the individual
specified in the system profile OKC: Contract Approver.

The application automatically launches the process you specify, when the contract passes
the quality assurance check.

Prerequisite

Confirm the name of the Oracle Workflow process you wish to select.

To specify and launch the contract approval workow:
1. From the Service Contracts Authoring window, select the Summary tab and

Administration subtab.

2. In the Approval Workflow region, use the Name LOV to select the Oracle Workflow
process.

3. Click Submit.

The application automatically runs the Quality Assurance check on your
contract. You must correct any errors found.

The application automatically launches the Workflow process after the contract
passes the check with no errors.
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Organizing Contracts by Assigning Them to Contract Groups
Contract groups organize contracts in the Contract Navigator tab of the Oracle Contracts
window.

To organize contracts by assigning them to contract groups:
1. From the Service Contracts Authoring window, select the Summary tab and

Administration subtab.

2. In the Contract Groups region, use the Group Name LOV to select each contract
group where you wish this contract to appear.

3. Save.

Specify a Different Quality Assurance Check List
The application uses the quality assurance check list specified in the system profile
OKS: Default QA Checklist to check and validate the contract for errors and completeness
before it can become active.

Prerequisite

Create a QA checklist.

To specify a different quality assurance check list:
1. From the Service Contracts Authoring window, select the Administration subtab on

the Summary tab.

2. Use the Quality Assurance Checklist LOV to select the alternate check list.

3. Save.

Entering an Estimate of Contract Revenue
The revenue you enter appears in the Service Contracts Forecast Summary Report and
the Service Contracts Forecast Management Report.

To enter an estimate of contract revenue:
1. From the Service Contracts Authoring window, select the Administration subtab on

the Summary tab.

2. In the Estimation region, enter the number representing the percentage of revenue
you predict is going to be realized from this contract.

3. Enter the date the estimated the revenue will be realized.

4. Save.
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Specifying Contract Terms

To specify contract terms:
1. From the Service Contracts Authoring window, select the Administration subtab on

the Summary tab.

2. Click Contract Terms.

The application displays the Contract Terms page in a separate browser window.

Follow the procedures described inOracle Contracts Implementation and Administration
Guide.

Granting Additional Access Privileges
You can grant the ability to modify the contract either to an individual or a resource
group.

You cannot use this procedure to restrict access to a contract, only to grant additional
access. This is because the ability to view and modify contracts depends on a
combination of security privileges granted both by the responsibility and at the
individual contract level.

The access level granted by a responsibility takes precedence over the access you
grant using this procedure. This means that if users log into the application under a
responsibility that permits modification of contracts, then you cannot restrict their right
to modify a specific contract.

You can use this procedure if your implementation has created a responsibility with
view-only access. In this case, you can grant individual users or members of a resource
group the ability to modify a specific contract as well. Your entries affect only users
logging in under that responsibility.

Note: Users logging in under a view-only responsibility, cannot create
new contracts using the Service Contracts Authoring window.

Prerequisite

Set up a responsibility with read-only access to contracts.

To grant additional access privileges:
1. From the Service Contracts Authoring window, select the Security/Text subtab on

the Summary tab.

2. In the Security region use the Type drop-down list to choose one of the following:

• User: to grant the right to modify this contract to a user.

• Group: to grant the right to modify the contract to a specific sales group.

3. Choose the resource group or user name from the LOV.

4. ChooseModify from the Level drop-down list.

5. Save.
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Entering an Additional Description or Comments

To enter an additional description or comments:
1. Select the Security/Text subtab on the Summary tab.

2. Enter the text in the Text region either in the Description or the Comments fields.

3. Save.

Setting Up Defaults for Contract Renewal
This group of topics is intended to help application administrators set up default renewal
rules for groups of contracts. These rules, which are entered in the Global Contracts
Default window, can be overridden by agents for individual contracts.

Note: The Global Contracts Default is also used for entering defaults
required by contracts generated automatically from Oracle Order
Management orders. These defaults are described in Setting Up New
Contract Defaults for Order Management , page 7-16.

It covers:

• Overview of Defaulting Levels, page 2-15

• Entering Default Renewal Rules for Contracts, page 2-16

• Setting Up System Profiles for Renewal Defaults, page 2-20

Overview of Defaulting Levels
You can specify how attributes of a contract will be defaulted at the time of renewal
at three different levels:

1. Party

Makes it possible for you to specify different renewal rules for different customers.

2. Organization

Makes it possible for you to specify different renewal rules for different organizations
in your own company.

3. Global

Specify global defaulting rules that apply to contracts which do not satisfy any of the
defaulting rules you have specified for the previous levels.

The application looks for renewal rules in the above order (Party, Organization, and
Global) and uses the first applicable set of rules it finds.

For example, suppose you set up your renewal preferences for the customer Business
World and your organization Vision Enterprises.

If an agent creates a contract for Business World, the application automatically defaults
the preferences you have set up at the party level, regardless of the organization that
created the contract.

If an agent at Vision Enterprises creates a contract for ABC Corp., it is subject to the
renewal rules you set up at the organization level. A contract for ABC Corp. created by
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an agent at Vision Communications, another organization in your enterprise, is subject
to the global rules only.

An agent creating or editing a contract, can override the defaults you set at any level by
making an entry in the Summary tab and Renewals subtab.

Note: Agents specifying renewals in individual contracts, using the
Summary tab and Renewals subtab, do not see the default values you
enter here.

You enter all of the different levels of default renewal rules in the same Global Contracts
Default window. Although the entries you make are almost identical for each defaulting
rule level, the user interface layout is different for entering global defaults (in the top half
of the window) to defaults at the party or organization level (the tabs in the lower half).

To complete the setup of renewal defaults, you must also set the system profiles
described in Setting Up System Profiles for Renewal Defaults, page 2-20.

Entering Default Renewal Rules
You can specify defaults for contract renewals. The procedure follows the layout of
the Organizations and Parties tabs, but you can use it as a guide for entering global
defaults as well.

Prerequisite

To enter rules for organizations, confirm organization codes.

For customer rules, confirm party numbers.

In both cases the lists of values permit you to see the names of organizations or
parties, but you can search by number only.

To enter default renewal rules:
1. Under the Service Contracts Manager responsibility, navigate to Setup > Contract >

Global Contracts Defaults.

The Global Contracts Default window appears.
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2. Navigate to the appropriate region of the window, depending on which type of
renewal rule set you wish to enter:

• To specify rules for a customer, select the Parties tab.

• To specify rules for an organization within your business, select the
Organizations tab.

• To enter global defaults, make entries in the Global Region on the top half of
the window.

3. If you are entering a renewal rules for an organization, then select the Renewal Rules
subtab and enter the organization code using the Organization LOV.

4. If you are entering renewal rules for a customer on the Parties tab, then select the
Renewal Rules subtab and enter the customer number using the Party Number LOV.

5. For organization and party rules, you must specify when you wish the set of rules to
become effective by entering a date in the Start Date field. You can terminate a set
of rules by entering a date in End Date.

6. Choose the renewal type from the Renewal Type LOV and enter information
appropriate for each type. The information you must enter in the remaining tabs or
regions differs based on your selection. You can:

• Prevent contracts from being renewed by default, by choosing Do Not Renew.

• Have contracts renewed automatically at expiration by choosing Active
Contract.

• Have the application automatically notify the customer by e-mail to renew over
the web, by choosing Electronic Renewal.

• Notify the sales agent when the contract comes up for renewal, by choosing
Notify Sales Rep.
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The application determines the appropriate sales agent to notify based either
on sales territories or, if the system profile OKS: Use Territories to Default Sales
Person is set to No, it notifies the sales representative specified in the system
profile OKS: Default Sales Person for Renewal.

• Create a renewed contract and submit it for approval, by choosing Submit for
Approval. The application submits the contract for approval to the person
specified in the system profile OKC: Contract Approver.

7. From the Pricing Method LOV, choose a pricing method. The available choices are:

• Price List: Charges the customer based on the price list you enter in the Price
List field. The price charged is the current price listed in the price list at the
time the contract is renewed.

• Manual: The application charges the customer the same price for the renewed
contract as they paid for the original contract.

• Markup Percent: Automatically adjusts the price up or down by a percentage
you enter. (A positive number marks up the price; a negative number discounts
it.) Optionally, you can cap the maximum adjustment based on a price list.

8. If you have selected Price List as the pricing method, then enter the price list to be
used for the renewal in the Price List field.

9. If you have selected Markup Percent, then:

1. Enter the percentage you wish the price to be adjusted in the Markup %
field. Entering a positive number marks up the price. A negative number
discounts the contract renewal.

2. If you are entering a markup and wish to put a limit on the maximum price the
customer will pay, then enter a price list in the Price List field. The price of the
renewed contract cannot go over the price listed in the price list.

For example, if you enter 20% as your markup and the current list price of the
service is $100, then the renewed contract is priced at $120. If you enter a price list
that lists the service at $110, however, then this price list caps the maximum price
for the service at $110. The customer pays a maximum of $110 for the renewal.

Note: The price cap works only for (positive) markups and not
for discounts.

10. To require an agent to enter a purchase order number in the contract before it can
become active, select the PO check box (named PO Required in the Global region).

11. If you are entering rules for a party or organization, then select the Admin subtab.

Note: The Contract Group field New Contract (named New Order
in the Global region) specifies the contract group for new contracts
created automatically from Oracle Order Management orders. It
does not apply to renewals. See Setting Up New Contract Defaults
for Order Management, page 7-16.

12. To specify a different contract group for the renewed contract, choose the contract
group from the Renewal LOV in the Contract Group region.

13. A renewed contract automatically inherits the QA checklist from the original
contract. To specify a different one, choose it from the QA Checklist LOV.
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14. A renewed contract automatically inherits the approval workflow process from the
original contract. To specify a different one. choose it from the Approval Workflow
LOV.

15. Choose Third Party from the Role field LOV. Entry is required only for contracts
generated from Oracle Order Management.

16. If you are entering revenue rules for a party or organization, then select the Revenue
subtab. For global defaults, make entries in the Revenue region.

17. To indicate the estimated revenue of the renewed contract as a percentage of the
original:

1. Enter a number representing the percentage in the Estimated % field.

2. Enter the duration and period by which the revenue is realized.

18. To specify the credit card to be the only method of payment for contracts under a
certain value, enter the threshold amount and currency in the Credit Card Threshold
region.

19. If you have chosen Electronic Renewal as the default renewal method for
contracts, then make entries on the Electronic Renewal subtab (or header region):

1. Make sure the Enable check box is selected in the Global region.

2. Enter the threshold currency and amount below which electronic renewal is
permitted.

3. Choose the payment terms for the credit card payment from the Payment Terms
for Credit Card LOV.

4. Use the Help Desk LOV to enter the return e-mail address for the electronic
notice sent to customers. This address appears in the From: field of the outgoing
e-mails.

5. Specify the templates to be used for the outgoing e-mails using the Template
Set LOV.

20. To specify a billing schedule for the renewed contract, select a billing profile using
the Billing Profile LOV. (This field is located on the Electronic Renewals subtab).

Billing profiles are templates you can use to specify simple periodic billing schedules
and accounting and invoicing rules for the renewed contract. This schedule
overrides any billing schedule in the contract that is being renewed. See Creating
Billing Profiles, page 11-3.

21. If you are specifying renewal rules for organizations or customers (parties), then
select the Preferences tab.

22. If you chose Active Contract as the default renewal method for contracts (to renew
contracts automatically), then, in the Active Threshold region, specify the currency
and amount that is the limit for the automatic renewals. Contracts below this amount
are automatically renewed. Above this amount, they must be approved first.

23. To specify a grace period beyond the expiration date of a renewed contract at no
extra charge, then enter it in the Grace region using the Duration and Period fields.

Grace periods ensure the customer does not experience an interruption of service
after a contract has expired and is being renegotiated, for example.

24. Save.
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Setting Up System Proles for Renewal Defaults
You must also set up the following system profiles to supplement the entry of renewal
rules:

• OKS: Enable Sales Credits: This system profile determines how sales credits are
transferred to the renewed contract.

• Retain: Carries forward the sales credits from the existing contract to the
renewed contract.

• Derive: Derives a sales person for the renewal agreement according to the
setting of the OKS: Use Territories to Default Sales Person and OKS: Sales Person.

• Drop: The application does not carry forward and default any sales credit
information to the renewed contract.

• OKS: Use Territories to Default Sales Person: If set to Yes, the application
determines the default sales person assigned to the renewed contract based on sales
territories. If set to No, then the application determines the sales person for the
contract based on the value entered in OKS: Sales Person.

• OKS: Sales Person: If OKS: Use Territories to Default Sales Person is set to No, this
profile determines the sales person to receive sales credit and to be listed as the
vendor contact. You must enter a sales agent in this profile or the contract fails to
renew. An agent can manually add additional sales people to the Sales Credits
window and assign them sales credits after the renewal agreement has been created.

• OKS: Revenue Type Distribution for Sales Credit: This system profile assigns the
percentage of revenue you specify to the sales agent determined from the previous
two system profiles. Agents can specify additional sales credits in the Sales Credit
window, but the total of revenue sales credits must always add up to 100 percent.

• OKS: Revenue Type for Sales Credits: The setting of this system profile specifies
whether you wish to assign the sales agent revenue credit or non-revenue credit.

• OKS: Vendor Contact Role: This system profile specifies the vendor contact role to
the renewal agreement. By default this profile option is set to Salesperson.

• OKC: Contract Approver: Set this system profile to the individual in your
organization who is to approve renewed contracts. The application notifies the
agent you specify here to approve any contracts renewed under the Submit for
Approval renewal type.
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3
Entering Defaults for Lines

This chapter covers the following topics:

• Overview of Entering Defaults for Lines

• Speeding Up Contract Line Entry Using Default Values

• Specifying Contract Effectivity and Maximum Duration

• Entering the Default Billing Account and Address

• Entering the Default Shipping Account and Address

• Entering the Default Price List and Payment Terms

• Creating Default Billing Schedules

• Defaulting Billing Schedules Overview

• Creating a Default Billing Schedule Using Billing Profiles

• Creating a Billing Schedule Using Billing Streams

• Entering a Billing Stream

• Using Billing Streams to Handle Irregular Billing Periods

• Specifying a Default Payment Method

• Specifying Payment by Credit Card or Commitment Number

• Requiring a Purchase Order For Contract Lines

• Specifying a Default Purchase Order Number for Invoices

• Assigning Sales Credits

• Defaulting a Customer’s Tax Exemption Status

• Applying Default Values to Existing Contract Lines

Overview of Entering Defaults for Lines
This group of topics explains how to speed up entry of individual contract lines in a
contract by making entries in the Summary tab of the Service Contracts Authoring
window. Your entries are automatically defaulted into new lines and, if applicable, to
sublines as well.
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Speeding Up Contract Line Entry Using Default Values
There are multiple ways of speeding up entry of values to individual contract lines. If
you are creating a new contract similar to an existing contract, for example, then you
can simply copy the existing contract and modify it. Or for creating multiple similar
contracts, you may instead wish to save the original as a template and use that template
to create the new contracts.

This group of topics explains how you can default values from the header of a contract
down to the lines and, if applicable, to sublines as well.

For example, if you select the corporate price list on the Summary tab and enter a service
contract line, that line’s price list is automatically set to corporate as well.

With the exception of billing schedules, the defaults you enter on the Summary tab
apply only to new contract lines. Existing contract lines are not affected. If you later
change the default price list at the header level to the good customer discount price
list, for example, that change applies only to new line entries unless you use the cascade
attributes procedure to specifically change the existing lines as well.

Default billing schedules, by contrast, apply only to existing contract lines and
automatically overwrite any schedules you have entered at the line or subline
level. You must apply the default schedule again to any new lines because they do not
automatically inherit it.

Specifying Contract Effectivity and Maximum Duration
You can specify the dates your contract is effective. The dates you enter become the
default dates for each new contract line and set a limit to the duration of all lines in the
contract.

A contract line cannot have a start date earlier then the contract header start date or an
end date later than the contract header end date.

Entering effectivity dates using this procedure affects new lines only. To make the new
dates also apply to existing contract lines, you must cascade the values to those lines. See
Applying Default Values to Existing Contract Lines, page 3-15 for details.

Note: If you are using this procedure to modify the dates for a contract
with existing lines and your change makes any of the lines fall outside
the new date range, then you must cascade the values to existing lines. If
you do not, your contract will not pass the default quality assurance
check.

You can change the dates you specify here at the individual line or subline level provided
the changes do not fall outside this range.

To specify contract effectivity and maximum duration:
1. From the Service Contracts Authoring window, select the Summary tab and Parties

subtab.

2. Specify the dates the contract is effective by entering either:

• End date

• Duration and period
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3. Save.

Entering the Default Billing Account and Address
You can select the default billing account and address for new contract lines. You can bill
to an account belonging to the customer, to any third party you have entered as a party
to the contract, as well as to any account with an established relationship to either of
the two in Oracle Receivables.

The billing account number you select here:

• Specifies who is billed for the contract

If you enter an account belonging to a third party it will be that third party that
will receive the invoice.

• Filters the pricing information you enter on the Pricing/Billing tab.

If you are billing a third party for the contract, then the price list and other required
fields are for that third party rather than the party specified as Customer.

• Populates the account number field for each new contract line.

The entry you make here affects new contract lines only. To change existing contract
lines based on your entry, you must cascade the changes to them. See Applying Default
Values to Existing Contract Lines, page 3-15 for details.

Prerequisite

Enter the parties to the contract.

To enter the default billing account and address:
1. From the Service Contracts Authoring window, select the Summary tab and Parties

subtab.

2. Use the Account/Party LOV in the Bill To region to enter the account that will be
billed. The account you select here defaults as the account number for all lines in
the contract.

Note: The LOV includes customer accounts, accounts for any third
party you entered, as well as accounts that have an established
relationship to those accounts in Oracle Receivables.

3. Select the billing address where you want invoices to be sent using the Location LOV.

4. Save.

Entering the Default Shipping Account and Address
Although entry is required only if your contract includes physical items that must be
shipped to the customer address, the application also uses the shipping address to
estimate taxes on services.

The entry you make here affects new contract lines only. To change existing contract
lines based on your entry, you must cascade the changes to them. See Applying Default
Values to Existing Contract Lines, page 3-15 for details.

Prerequisite
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Enter the parties to the contract.

To enter the default shipping account and address:
1. From the Service Contracts Authoring window, select the Summary tab and Parties

subtab.

2. Use the Account/Party LOV in the Ship To region to enter the account for shipping
physical items. The account you select here defaults shipping account number for all
new lines in the contract.

Note: The LOV includes customer accounts, accounts for any third
party you entered, as well as accounts that have an established
relationship to those accounts in Oracle Receivables.

3. Select the shipping address using the Location LOV, if physical items need to be
shipped or location based tax should be estimated.

4. Save.

Entering the Default Price List and Payment Terms
You can specify the price list for the contract and payment terms for the account you
have selected as the billing account. The payment terms you enter here are automatically
defaulted to each new contract line.

To apply these entries to existing contract lines, you must edit each line separately.

Prerequisite

Enter the Bill To account.

To enter the default price list and payment terms:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.
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2. If your organization has a Pricing Agreement set up with the party you are
billing, then use the Agreement LOV to enter it. This automatically defaults all of
the other required fields including the price list, the accounting rule, the payment
terms, and the invoicing rule.

Pricing Agreements, which specify prices, discounts, and billing practices for a
particular customer, are created in Oracle Order Management. See Oracle Order
Management User’s Guide, “Pricing Tab: Setting Up a Blanket Sales Agreement”
for details.

Note: The values you enter in the contract by specifying a Blanket
Sales Agreement can be changed. For example, if you use a Billing
Profile to default billing schedules, the values you enter in the
Accounting Rule and Invoicing Rule fields are overwritten by those
in the Billing Profile.

3. If no Blanket Sales Agreement is available, or your wish to modify any defaulted
values, then:

1. Use the LOVs provided to enter the price list, accounting rule, and payment
terms.

2. Using the Invoicing Rule LOV, specify if the customer is to be billed at the
start of the billing period (Advance Invoice) or at the end of the billing period
(Arrears Invoice).

Note: Some usage contracts require you to specify arrears
invoicing. For example, a customer that is billed each month
based on a meter reading must be billed at the end of the month
after the counter is read. See Entering Usage Lines, page 5-1.
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Creating Default Billing Schedules
This group of topics explains how to create a billing schedule at the contract header level
to speed up the entry of multiple service and usage contract lines with similar billing
schedules. It covers:

• Defaulting Billing Schedules Overview, page 3-6

• Create a Default Billing Schedule Using Billing Profiles, page 3-7

• Creating a Billing Schedule Using Billing Streams, page 3-7

• Entering a Billing Stream, page 3-8

• About Using Billing Streams to Handle Irregular Billing Periods, page 3-9

Note: Do not use the procedures in this section for subscription
contracts. Instead, see Specifying a Billing Schedule for
Subscriptions, page 6-10.

Defaulting Billing Schedules Overview
A billing schedule determines when the customer is billed for the services they receive.

For contracts with service lines you can bill the customer either at the line level or the
subline level, but for contracts with usage lines you can only bill at line level.

For service lines, this means you can bill at the level of the service sold to the customer
(called the Top Level in the application) or individually at the level of each of the items
covered by that service (Covered Level), be it an individual item, a system, a covered
location, an account, or party.

For usage lines, you can only bill at the usage line level (Top Level).

(Subscription lines represent a special case and so are covered in Entering Subscription
Lines, page 6-1).

You can either create an individual billing schedule for each individual line or subline
in the contract, or create a billing schedule at the contract header level using either
of the two methods described in this section and then apply that schedule to existing
contract lines.

Note: Unlike the other information you enter in the Summary tab, billing
schedules are not automatically defaulted to new lines and sublines. To
default a schedule you create at the header, then you must first enter the
contract lines and then apply the schedule to them.

You can create billing schedules for defaulting to contract lines by one of the two
following methods. Which method you select depends on your implementation and the
complexity of the schedule you are creating:

• Using billing profiles, page 3-7

Build a schedule by selecting a schedule template set up by your application
administrator. Use this method for setting up simple periodic billing schedules, for
example, when a customer orders a year of service and wishes to be billed monthly
or quarterly.

• Using billing streams, page 3-7
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Using this method you can create complex billing schedules or billing schedules
with irregular periods, for example, when a customer orders additional service in
the middle of a billing period or requires service only intermittently.

Creating a Default Billing Schedule Using Billing Proles
You can create a default billing schedule from a template, called a billing profile.

Prerequisites

• Confirm the setup of billing profiles.

• Enter the contract lines for which you wish to set up the default billing schedule

To create a default billing schedule using a billing prole:
1. From the Service Contracts Authoring window, choose Cascade Attributes from

the Actions menu.

The Cascade Attributes window appears.

2. Select the Billing Profile check box.

3. Use the LOV in the field to the right to enter the billing profile template.

4. Make sure that Header to Lines is selected for the Cascade drop down list at the top
of the window and all the lines are selected on the right of the window.

5. Click Submit.

The Transaction Log appears.

6. Click Apply.

Note: The billing schedule overwrites any existing billing schedule
at the line and subline level.

If required, you can now edit the schedule at the individual line
or subline level.

Creating a Billing Schedule Using Billing Streams
Prerequisite

Enter an accounting rule and an invoicing rule on the Pricing/Billing subtab. See
Entering the Default Price List and Payment Terms, page 3-4.

To create a default billing schedule by using billing streams:
1. From the Service Contracts Authoring window, select the Summary tab and the

Pricing/Billing subtab.

2. Click Billing.

The Billing Schedule window appears.
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3. From the Level LOV choose one of the two following levels:

• Top Level: to default a schedule at the line level

• Equal Amount: To bill for equal amounts across sublines over the billing period
and have control over the amount.

Note: Equal Amount cannot be selected if Usage lines exist on
the contract.

4. Create the billing periods by entering one or more billing streams. See Entering a
Billing Stream, page 3-8.

5. Click Schedule to create the schedule.

The application displays a caution notice asking you if you wish to overwrite all
existing schedules.

6. Any contract lines you enter to the contract in the future are not defaulted with
this schedule. To apply this schedule to them, you must return to this window
and click Schedule again.

Entering a Billing Stream
A billing stream is designed to speed up the creation of a set of regular billing
periods. You specify that you want your customer billed in 12 periods of one month
each, for example, and the application automatically specifies the invoice dates and
schedules the billing.

If the dates of the ordered service coincide with billing dates, then you can set up the
billing periods with just one billing stream. However, you may need to set up multiple
billing streams to handle irregular billing situations (see About Using Billing Streams to
Handle Irregular Billing Periods, page 3-9).
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Prerequisites

• Display a billing schedule in the Billing Schedule window.

• Enter an accounting rule and an invoicing rule on the Pricing/Billing subtab. See
Entering the Default Price List and Payment Terms, page 3-4.

To enter a billing stream:
1. If this is the first or only billing stream, then:

1. Enter 1 in the Seq Num field.

The application defaults the start date from the start date of the contract.

2. Enter either the end date or the duration and period.

The application supplies the missing information.

2. If this is an additional billing stream, then:

1. In the Seq Num field, enter a number corresponding to the order in which the
billing periods are created.

The sequence numbers for billing streams must be in order of the billing period
dates. If you want to enter a billing period earlier than an existing billing
stream, then you must reorder the entire sequence.

Note: If you are reordering or otherwise editing billing stream
information, you must click Cascade Dates to recalculate and
refresh the dates in the Stream Level region.

The application defaults the start date from the end date of the previous billing
stream.

2. Enter either the end date or the duration and period.

The application supplies the missing information.

3. To adjust the date the customer sees as the invoice date, enter a positive or a negative
number of days in the Invoice field. For example, entering +2, shifts the invoice date
forward two days. Entering -2 shifts it back two days.

4. To adjust the date the application sends billing amounts to Oracle Receivables for
billing, enter a positive or a negative number of days in the Interface field.

5. Click Schedule to generate the schedule.

Using Billing Streams to Handle Irregular Billing Periods
You can set up multiple billing streams to handle irregular billing situations. For
example, to handle a customer who starts a contract in the middle of a month, but
wished to be billed at the beginning of each month.

This section illustrates how to use billing streams for the customer who wants to be
billed at the beginning of each month for two services with different durations and
incompatible start dates:

• General Service for January 1, 2005 - December 31, 2005

• Premium Service for May 15, 2005 - November 14, 2005
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To use billing streams to handle irregular billing periods:
Here is how to set up the first service:

1. Create a contract with 01-JAN-2005 - 31-DEC- 2005 as the start and end dates. The
first line is the longest line in the contract, so you must use its dates.

2. Because the customer wishes to be billed at the start of each month, choose Advance
Invoice as the Invoicing Rule for the contract. This is done on the Summary tab and
Pricing/Billing subtab.

3. Enter the service the customer wishes to purchase as a contract line on the Lines tab.

4. Click Billing on the Pricing/Products subtab to open the Billing window.

5. Enter one billing stream:

Seq Num Number of
Periods

Start Date End Date Duration Period

1 12 01-JAN-2005 1 Month

6. Save. The application calculates the end date automatically.

7. Click Schedule to generate a billing schedule. The table below shows the generated
schedule which bills the customer at the beginning of each month. The table includes
the following columns:

• Seq Num: The sequence number is the number of the billing stream. Each row
displays 1 in this case as the entire schedule was generated from one billing
stream.

• Level Seq: The number of the billing period within a sequence.

• Invoice Date: The date on the invoice. This is the first of the month because we
have selected an Advanced Invoice and not entered any invoice offset.

• Bill From: The start date of the billing period.

• Bill To: The End date of the billing period.

• Interface Date: The date the application sends the amount to be billed to
Oracle Receivables for billing. This is the same as the Invoice Date as we have
not entered any offset.
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Seq Num Level Seq Invoice
Date

Bill From Bill To Interface
Date

1 1 1-Jan-05 1-Jan-05 31-Jan-05 1-Jan-05

1 2 1-Feb-05 1-Feb-05 28-Feb-05 1-Feb-05

1 3 1-Mar-05 1-Mar-05 31-Mar-05 1-Mar-05

1 4 1-Apr-05 1-Apr-05 30-Apr-05 1-Apr-05

1 5 1-May-05 1-May-05 31-May-05 1-May-05

1 6 1-Jun-05 1-Jun-05 30-Jun-05 1-Jun-05

1 7 1-Jul-05 1-Jul-05 31-Jul-05 1-Jul-05

1 8 1-Aug-05 1-Aug-05 31-Aug-05 1-Aug-05

1 9 1-Sep-05 1-Sep-05 30-Sep-05 1-Sep-05

1 10 1-Oct-05 1-Oct-05 31-Oct-05 1-Oct-05

1 11 1-Nov-05 1-Nov-05 30-Nov-05 1-Nov-05

1 12 1-Dec-05 1-Dec-05 31-Dec-05 1-Dec-05

Adding a Six-Months Service that Starts in the Middle of a Month
Now suppose the same customer wishes to start an additional six-months of
service on May 15, in the middle of a billing period.

Here is how to modify the contract to ensure the customer is billed only one
time each month:

1. Enter the service as a second contract line on the Lines tab.

2. Click Billing on the Pricing/Products subtab to open the Billing window.

3. Create three billing streams:

Seq Num Number
of
Periods

Start
Date

End Date Duration Period Invoice
Offset
Days

1 1 15-MAY-
2005

31-MAY-
2005

-14

2 5 01-JUN-
2005

1 Month

3 1 01-NOV-
2005

14-NOV-
2005

1. Create the first billing stream for the partial month:

• Enter End Date as 31-May-2005. The application provides the
duration and period automatically.

• Enter -14 in the Offset Days Invoice field, to shift the invoicing date
to the beginning of the month. Otherwise, the customer receives
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two invoices, one dated on the first of the month and a second dated
May 15.

2. Create a second billing stream for the regular monthly periods:

• The application supplies the start date automatically based on the
first billing stream.

• When you enter 5 periods of 1 month, the application supplies the
start and end dates automatically.

3. Enter a third billing stream to cover the partial month at the end of the
six-month period:

• The application supplies the start date automatically based on the
second billing stream.

• Enter the End Date, the application supplies the duration and period
values automatically.

4. Click Schedule to generate the following billing schedule:

Seq Num Level Seq Invoice
Date

Bill From Bill To Interface
Date

1 1 1-May-05 15-May-05 31-May-05 1-May-05

2 1 1-Jun-05 1-Jun-05 30-Jun-05 1-Jun-05

2 2 1-Jul-05 1-Jul-05 31-Jul-05 1-Jul-05

2 3 1-Aug-05 1-Aug-05 31-Aug-05 1-Aug-05

2 4 1-Sep-05 1-Sep-05 30-Sep-05 1-Sep-05

2 5 1-Oct-05 1-Oct-05 31-Oct-05 1-Oct-05

3 1 1-Nov-05 1-Nov-05 14-Nov-05 1-Nov-05

Specifying a Default Payment Method
This group of procedures explains how to default a payment method for new contract
lines:

• Specifying Payment by Credit Card or Commitment Number, page 3-12

• Requiring a Purchase Order For Contract Lines, page 3-13

• Specifying a Default Purchase Order Number for Invoices, page 3-13

The payment method information you enter using the procedures described in this
section applies only to new contract lines. You must cascade the entries by selecting the
Payment method check box in the Cascade Attributes window to apply them to existing
lines as well. See Applying Default Values to Existing Contract , page 3-15 for details.

Specifying Payment by Credit Card or Commitment Number
Commitments, which are set up in Oracle Receivables, represent a customer’s
prepayment for goods or services (prepayments) or contractual agreements (guarantees).

Prerequisite
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Confirm the setup of commitments in Oracle Receivables. See the Oracle Receivables
User Guide.

To specify payment by credit card or commitment number:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. To specify payment by credit card, then:

1. Choose Credit Card from the Payment Type drop-down list.

2. Enter the credit card number and expiration date.

Note: If the application administrator has set the system
profile OKS: Credit Card Validation Level to Validate, a
quality assurance (QA) check validates the credit card number
using the checksum digit of the card number. Another QA
checks authorizes the transaction for the amount specified in
OKS: Credit Card Minimum Authorized Amount.

3. To specify payment by commitment, then:

1. Choose Commitment Number from the Payment Type drop-down list.

2. Enter the commitment number using the LOV.

4. Save.

Requiring a Purchase Order For Contract Lines
When you require the entry of a purchase order, the contract cannot pass the QA check
and become active unless a purchase order is entered for every line.

The requirement does not affect any existing contract lines. You must use the Cascade
Attributes window and select the Payment Method check box to enforce the requirement
to all lines.

To require a purchase order number for contract lines:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. Select the Purchase Order Required check box.

3. Save.

Specifying a Default Purchase Order Number for Invoices
You can default a purchase order number to new contract lines. This number is passed
to Oracle Receivables and appears on customer invoices.

The entry does not affect any existing contract lines. You must use the Cascade Attributes
window and select the Payment Method check box to copy the number to all lines.
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To enter a default purchase order number for invoices:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. Enter the purchase order number in the PO Number field.

3. Save.

Assigning Sales Credits
You can assign the default sales credits for each new contract line in your contract. You
can assign both revenue and non-revenue credits.

To apply the sales credits to existing contract lines, you must cascade the changes to
them. See Applying Default Values to Existing Contract Lines, page 3-15 for details.

To assign sales credit:
1. From the Service Contracts Authoring window, select the Summary tab.

2. Choose Sales Credits from the Actions menu.

The Sales Credits window appears.

3. Enter the sales agents and the revenue and non-revenue credit they are to
receive. Sales group entry is optional. Revenue credit must always add up to 100
percent.

4. Click OK.
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Defaulting a Customer’s Tax Exemption Status
The entry you make here applies to new contract lines only, to apply a change of status
to existing lines you must use the Cascade Attributes window (See Applying Default
Values to Existing Contract Lines, page 3-15).

To default a customer’s tax exemption status:
1. From the Service Contracts Authoring window, select the Summary tab and

Pricing/Billing subtab.

2. In the Tax Exemption region, select the customer’s tax status using the Status LOV.

3. Enter the tax exemption number.

4. Enter a reason for the exemption.

5. Save.

Applying Default Values to Existing Contract Lines
You can apply values you have entered in the Summary tab of the contract down to
existing lines.

To apply default values to existing contract lines:
1. From the Service Contracts Authoring window, choose Cascade Attributes from

the Action menu.

The Cascade Attributes window appears. The window automatically disables
contract attributes that have not yet been entered. For example, if you have not
entered any sales credits in your contract, the Sales Credits check box is disabled
and you cannot cascade sales credits.

2. Choose Header to Lines from the Cascade drop-down list.

3. Select the check boxes next to the attributes you wish to apply to the contract
lines. You can cascade the following values from the header to existing contract lines:

• Effective dates: The dates you entered in the Start Date and End Date fields.

Note: If you are changing the effective dates of an existing
warranty line, this method changes the contract dates only. It
cannot be used to change the installed date in Oracle Install
Base. To change both the contract and the installed date, then
use the procedure describe in Modifying the Dates a Warranty
Is Effective, page 7-13.

• Accounting Rule: The accounting rule you entered on the Summary tab and
Pricing/Billing subtab.

• Bill to Address: The Bill To account and location you entered on the Summary
tab and Parties subtab.

• Ship to Address: The Ship To account and location you entered on the Summary
tab and Parties subtab.

• Invoicing Rule: The invoicing rule entered on the Summary tab and
Pricing/Billing subtab.
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• Tax Status and Exemption Number: The tax status and any exemption number
you entered on the Summary tab and Pricing/Billing subtab.

• Payment Method: The payment method and details you entered in the Billing
region of the Summary tab and Pricing/Billing subtab.

• Sales Credits: The sales credits you entered at the contract header level.

Note: Only those fields in the Cascade Attributes window used
to copy values you have already entered on the contract header
are listed here. For example, you use the Bill to Contact and
Billing Profile fields to enter the values rather than to copy them.

4. In the Lines region, specify which lines you wish to change by selecting the check
boxes to the right of those lines. You can use the Deselect All and Select All buttons
to make your selection.

Note: By default, all of the check boxes are selected so all lines in the
contract will be changed.

5. Click Submit.

6. The Transaction Log displays status of the changes you are about to make.

7. Click Apply.

Note: By default when you select a header attribute to cascade on a
contract with multiple lines all lines are selected.

To control which lines inherit specific attributes, select the attribute
you wish to cascade and then deselect the lines that should not
inherit the attribute value. You can then select the next attribute and
deselect the lines that should not inherit the attribute.

For example, if you have a contract with two lines, Service Line 1
and Usage Line 2; and you wish to cascade the Accounting Rules
and Bill To Address attributes to Service Line 1 but not to Usage Line
2. You would select the Accounting Rules attribute and deselect
Usage Line 2, and then select the Bill To Address attribute and
deselect Usage Line 2.
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4
Entering Service Lines

This chapter covers the following topics:

• Overview of Entering Service Lines

• About Service Lines

• Entering a Service Line (General Procedure)

• Changing the Billing and Shipping Accounts and Locations

• Entering Billing and Shipping Contacts for a Contract Line

• Creating or Modifying a Contract Line Contact

• Specifying How a Contract Line is to Be Renewed

• Renewing Service Purchased for Seasonal or Peak Periods

• Specifying What a Service Covers

• Levels of Coverage and Their Uses

• Covering Customer Products (Instances in Oracle Install Base)

• Covering Customer Products

• Browsing Oracle Install Base to Identify Item Instances for Coverage

• Entering a Customer Product into Oracle Install Base

• Covering Parties

• Covering Customer Accounts

• Covering Party Sites

• Browsing Through Party Sites

• Covering Systems

• Browsing Through Oracle Install Base Systems

• Covering Inventory Items

• Viewing Details About a Covered Product

• Specifying How the Service Prints on an Invoice

• Omitting a Line or Subline from the Invoice

• Specifying the Invoice Text

• Specifying a Billing Schedule
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• Pricing What a Service Covers

• Adjusting the Price of a Service for a Covered Product or an Item

• Repricing a Service by Changing the Price List

• Manually Adjusting the Price

• Changing the Basis for Pricing a Service

• Pricing Service for a Party, Customer Account, Site, or System

• Specifying a Payment Method for a Contract Line

• Specifying Payment by Credit Card or Commitment Number

• Requiring a Purchase Order

• Specifying a Purchase Order Number

• Modifying Coverage Provided by a Service

• Scheduling Preventive Maintenance Activities

• Scheduling Multiple Activities at the Same Time

• Scheduling Individual Activities

• Scheduling Activities at Regular Intervals Using Schedule Streams

• Viewing Maintenance Program and Activity Details

• Ending Service Lines on a Day Specified by the Customer

• About Cotermination

• Applying the Cotermination Date to a Service

• Specifying Tax Status

• Applying Changes from a Service Line to the Covered Sublines

• Assigning Sales Credits for a Contract Line

Overview of Entering Service Lines
This group of topics explains how to enter service lines into your contract.

About Service Lines
A service can cover a broad category business processes such as field service, depot
repair, call center, technical support, safety inspections, and any other user-defined
business activities.

Each service is set up by the application administrator as an item in Oracle Inventory
and is associated with a coverage template. The coverage template specifies the business
processes covered, the times that the customer is entitled to the coverage, amounts
covered and applicable discounts, as well as any resources that are to be used and
their pricing.

If preventive maintenance is required as part of the service, the service is also associated
with a program of maintenance activities. These activities are scheduled automatically
when you enter the service line.
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The administrator can also restrict which customers or products are permitted to use
this service.

You must be familiar with the details of the services created for your organization
before using them in a contract because you choose a service in a service line by its
Oracle Inventory name.

A service can cover different types of entities. A safety inspection service can cover
individual customer sites or the entire enterprise. A depot repair service can cover
individual products, a group of products, all products at a specific location, or all
products grouped into a system.

For example, a service may cover field service for all of the computer equipment at site
A, or it may instead cover laptops L451, L359 and L863.

A service line can cover multiple entities, each of which you enter as a subline.

When you cover individual customer products (Oracle Install Base item instances or
Items in Oracle Inventory), you can have the application price the service automatically
and take advantage of Oracle Advanced Pricing features including discounts. Your
organization can price the same service differently by setting up multiple price lists and
it can offer different prices for the service based on service length. This means your
organization can offer discounts if a customer purchases service for a longer period of
time.

Entering a Service Line (General Procedure)
Prerequisites

Create the contract with the appropriate category:

• To cover products in a customer’s installed base, you can use any of the
available contract categories: Warranty and Extended Warranty, Service
Agreement, and Subscription Agreement. The first two categories permit electronic
renewals, subscriptions do not.

• If your contract includes usage lines, or the service covers other levels including
parties, sites, accounts, and inventory items, then you must choose Service
Agreement or Subscription Agreement.

• To include subscription lines in the same contract, then you must choose
Subscription Agreement.

• Enter the required fields on the header of the contract.

To enter a service line:
1. From the Service Contracts Authoring window, select Lines tab and Accounts subtab.
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2. Choose one of the following from the Line Type LOV depending on the contract
category:

• For a service contract of category Service Agreement or Subscription
Agreement, choose Service.

• For a service contract of categoryWarranty and Extended Warranty, choose
Extended Warranty.

Note: Both choices permit you to select from the same list of
service offerings.

3. Choose the service from the Name LOV which comprises all services your
organization offers. You must choose a service that is applicable to what you are
covering. Because you choose the service first and what it covers later, the application
informs you of a wrong choice only after you enter the items you are covering.

Note: If the application displays a note that your entry is “Not a
valid Service”, then the customer is excluded from using this service
by the application administrator.

4. Enter billing and shipping contacts specific to this contract line by following the
procedure described in Entering Billing and Shipping Contacts for a Contract , page
4-7. If a contact does not exist in the database, then you can add one following the
procedure described in Creating or Modifying a Contract Line Contact, page 4-8.

The contacts you enter here are different from the ones you entered in the contract
header.

5. Select the Effectivities subtab.
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6. Specify the duration of the service.

By default, the start and end date of the service and duration are copied from the
contract header.

You can specify a different duration by:

• Clicking Coterminate to end the service line on a day preferred by the customer.

This button is enabled only in contracts with a status of Entered for customers
to simplify renewals by terminating all contracts on the same day each
year, for example at the end of the calendar or fiscal years. This date is called
the cotermination date. See Ending Service Lines on a Day Specified by the
Customer, page 4-39 for more details.

• Entering either of the following:

• Start and end dates

• Duration and period

The application calculates the missing information. If you supply a duration
and period, then the start date is the start date of the contract.

Note: If your organization prices contracts differently based
on different periods, for example offering different prices
for a service purchased by month, quarter, and year, then
the value in the Period field determines which price applies.

You can change the price basis when you price the
service. You may need to do so whenever you sell a service
for an unusual service length, for example. By default a
customer purchasing a contract for one year and five days is
charged based on a daily and not the yearly price because
the line length is not divisible by a year, for example.

For more information see About Changing the Basis for
Pricing a Service, page 4-30.
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If the duration of the service starts earlier than the start date
or ends later than the end date of the contract, then you
must extend the start and end dates of the contract at the
header level before you can make the contract active.

7. If the contract can be renewed (you have not selected Do Not Renew on the
Summary tab and Renewals subtab), then specify how the line is to be renewed
using the Renewal Type LOV. For details see Specifying How a Contract Line is to
Be Renewed, page 4-9.

8. Select the Pricing/Products subtab and the Effectivity secondary tab.

9. Specify what the service line covers. For each subline, specify one of the covered
levels and then enter what is being covered.

A service can cover:

• A specific product the customer owns (an Oracle Install Base item instance)

• A party

• A customer account (party account)

• A party site

• An Oracle Install Base system

• An Oracle Inventory item

For covered products, you can either enter each subline individually, or you
can click the LOV indicator to open a browsing window where you can select
multiple sublines at once.

See Specifying What a Service Covers, page 4-11 for an explanation of the
covered levels and how to enter them.

10. If you are covering an inventory item or a product (instance) the customer owns, then
the application prices the service for you. You must, however, price the other
covered levels manually. See Pricing What a Service Covers, page 4-28.
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11. Much of the rest of the information for a service line is defaulted from the defaults
you entered in the Summary tab or by the application itself from the coverage
template associated with the service. You can make modifications by following
these procedures:

• Changing the Billing and Shipping Accounts and Locations, page 4-7

• Specifying a Payment Method for a Contract Line, page 4-32

• Specifying a Billing Schedule, page 4-27

• Specifying How the Service Prints on an Invoice, page 4-25

• Modifying Coverage Provided by a Service, page 4-33

• Scheduling Preventive Maintenance Activities, page 4-34

• Specifying Tax Status, page 4-40

• Assigning Sales Credits for a Contract Line, page 3-14

12. Save.

Changing the Billing and Shipping Accounts and Locations
The billing and shipping accounts and locations are defaulted from the entries you made
in the contract header. You can change the values to any account and location related to
the parties entered in the contract header.

The Bill To account and location you select for the line is the account that receives the
invoice for this line. Your entries also restrict the contacts you can enter for this line.

Note: You must choose the location by the application-generated
location codes. The corresponding addresses display at the bottom of
the tab.

Prerequisite

Enter the contract line.

To change the billing and shipping accounts and locations:
1. From the Service Contracts Authoring window, select Lines tab and Accounts subtab.

2. Select the contract line you wish to modify.

3. Use the lists of values to choose a Bill To and Ship To account and location.

Entering Billing and Shipping Contacts for a Contract Line
The contacts you enter here are separate from those entered for the party on the
Summary line.

Note: The list of contacts you can select is limited to those at that
particular account location. While you can create new contacts according
to the procedure described in Creating or Modifying a Contract Line
Contact, page 4-8, make sure that you do not create any unnecessary
duplicates.
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Prerequisite

Select the shipping and billing accounts.

To enter billing and shipping contacts for a contract line:
1. From the Service Contracts Authoring window, select the Lines tab and Accounts

subtab.

2. Select the service line at the top of the subtab.

3. Place your cursor in an empty record in the Role field in the Customer Contacts
region.

4. To enter a contact for the billing account, then choose Billing Contact from the Role
LOV. This entry limits the available names to contacts for the billing account.

5. To enter a contact for the shipping account, then choose Shipping Contact from the
Role LOV. This entry limits the available names to contacts for the shipping account.

Note: Entering any other available role, such as Technical
Contact, makes contact at both accounts available for selection.

6. Enter the contact using the Name LOV.

7. You can specify a start date and end date for a contact using the date fields.

8. To view the phone and other contact information for a contact, select the contact and
chooseMaintain Contact from the Tools menu.

Creating or Modifying a Contract Line Contact
The contact you create becomes a contact for the bill to account, the ship to account, or
both, depending on your selection.

Prerequisite

Enter a service contract line

To create or modify a contract line contact:
1. From the Service Contracts Authoring window, select the Lines tab and the Accounts

subtab.

2. Select the contract line where you wish to create a contact.

3. In the Customer Contacts region, place the cursor in the Role field.

4. ChooseMaintain Contact from the Actions menu.

The Contact window appears.

5. If you are creating a new contact, then:

1. Choose a role for this contract using the Contact Role LOV. Usually this is either
Billing Contact or Shipping Contact.

2. Select the Bill To or the Ship To radio button depending on whether you wish to
create a contact for the billing or shipping account in the contract line.
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The role you selected in the previous step restricts your choices: if you selected
the Billing Contact role, then you cannot select the Ship To radio button and
vice versa.

3. Enter the contact last and first name.

4. Use the following guidelines for entering other information:

• Choose the titles and job descriptions from the Titles and Job LOVs. These
are preset by your application administrator.

• Phone, fax, and mobile numbers are composed of three fields: a country
code (LOV), an area code, and the number itself. Do not use any delimiters
in entering your number.

• For the contact address, you can only choose one of the existing customer
locations associated with the account. You can add a mail stop or a mail
box, however, by pressing the Tab key after entering the address.

6. If you are modifying an existing contact, then you can:

• Change the title and job description by selecting a different one from the Title
and Job LOVs.

• Change the phone, fax, and mobile numbers.

• Change the e-mail address.

Note: When modifying existing contact information, be aware
that you are modifying the contact record for all Oracle
E-Business Suite applications.

You cannot modify the address or mail stop number after you
have saved them. To select another address or enter a different
mail stop, then you must:

• Navigate back to the Service Contracts Authoring window.

• Delete the contact by selecting it and clicking Delete in the toolbar.

• Create a replacement contact with the correct address information.

Note: Deleting the contact from the contract does not delete
it from the database. Creating a replacement record creates a
duplicate.

7. If you are modifying an existing contact and wish to revert to the existing
record, click Reset.

8. Click OK to return to the Service Contracts Authoring window.

9. Save.

Specifying How a Contract Line is to Be Renewed
This procedure applies to lines of all types (Service, Usage, and Subscription).

Prerequisites

• Enter a contract line.
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• You cannot renew a line if you have indicated that the contract is not to be renewed
at the header level. See Specifying How a Contract Will Be Renewed, page 2-7.

To specify how a line is to be renewed:
1. From the Service Contracts Authoring window, select the Lines tab and Effectivities

subtab.

2. Select the line you wish to set up.

3. Choose one of the renewal options from the Line Renewal Type drop-down list. The
choices are:

• Do Not Renew: The line will not be renewed when the contract is renewed.

• Full Duration: The line will be renewed for the whole duration of the new
contract. For example, if a customer ordered six months worth of a yearly service
in the current contract, but the renewed contract is for a period of one year, then
the service line is extended to the full year as well.

• Keep Duration: The duration of this line will remain the same in a renewed
contract. Use this setting for intermittent or seasonal service lines. For
example, a mountain resort may order special service for peak periods in winter
and summer. Using this setting you assure that the renewed contract retains the
same structure. See Renewing Service Purchased for Seasonal or Peak Periods,
page 4-10.

Renewing Service Purchased for Seasonal or Peak Periods
This topic explains how to set the renewal types for service lines in a contract that
includes intermittent or seasonal service.

Customer Problem
A mountain resort has installed power generators and wishes to purchase two kinds
of service:

• Regular service for the whole calendar year that entitles them to repair during
regular business hours.

• Premium 24/7 service for peak winter and summer periods.

Oracle Service Contracts Solution
The following guidelines explain how to structure a contract based on the customer
requirements.

Service Line Entry
Create a contract with three service lines:

• Line 1: Regular service for the whole year.

• Line 2: Premium for the winter

• Line 3: Premium for the summer
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Renewal Information
To keep the same contract structure when the contract is renewed in the future specify
the following renewal information for each line:

Line Renewal Type Explanation

1. Regular Service Full Duration Renewed for the full duration
of the new contract.

2. Premium Winter Keep Duration Keeps the same duration in the
renewed contract.

3. Premium Summer Keep Duration Keeps the same duration in the
renewed contract.

Specifying What a Service Covers
A service can cover everything from individual products a customer owns to telephone
support for a whole corporation.

Note: Contracts of category Warranty and Extended Warranty, restrict
you to covering products the customer owns (Oracle Install Base item
instances). The other covered levels are available for service lines you
enter in the Service Agreement and Subscription Agreement contract
categories.

This group of topics explains the different levels of coverage available and provides
procedures for entering them.

• Levels of Coverage and Their Uses, page 4-11

• Covering Customer Products, page 4-15

• Covering Parties, page 4-19

• Covering Customer Accounts, page 4-20

• Covering Party Sites, page 4-21

• Covering Systems, page 4-22

• Covering Inventory Items, page 4-24

Levels of Coverage and Their Uses
Service can cover products on multiple levels. For example, you can have a service cover
the repair of an individual product the customer owns or you can use it to provide
telephone support for a whole enterprise.

Covered Levels

The following table lists the different levels of coverage, specifies the contract categories
where they are available, and provides a brief explanation of each.
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Level LOV Name What It Covers Available in Contract
Category

Explanation

Party A party in the database Service Agreement
only

Covers:

• Item instances
owned by
all accounts
belonging to a
party in your
database. In
Oracle Install
Base, ownership
is defined as a
combination of
party and account.

• Business
processes
performed for the
party as defined in
service coverage.
Requires manual
pricing.

Customer A customer account
(an account belonging
to a party in the
database)

Service Agreement
only

Covers:

• All item instances
owned by the
customer account.

• Business
processes
performed for
the account as
defined in service
coverage.
Requires manual
pricing.

Site A party site Service Agreement
only

Covers:

• All items installed
at a particular
party site.

• Business
processes
performed for the
site as defined in
service coverage.
Requires manual
pricing.
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Level LOV Name What It Covers Available in Contract
Category

Explanation

System An Oracle Install Base
system

Service Agreement
only

Covers:

• Item instances
belonging to a
specific system.
A system is a
grouping of item
instances created
in Oracle Install
Base.

• Business
processes
performed for
the system as
defined in service
coverage.
Requires manual
pricing.
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Level LOV Name What It Covers Available in Contract
Category

Explanation

Product An item instance in
Oracle Install Base

Warranty and
Extended Warranty
Service Agreement

Covers:

• A specific
serialized or non-
serialized item
instance in Oracle
Install Base.
For a serialized
product such as
a computer or a
printer, the item
instance is always
an individual
product. But an
item instance can
represent multiple
quantities for non-
serialized items
such as printer
cartridges, for
example.

• Business
processes
performed for the
item instance as
defined in service
coverage.
Uses the price list
you have specified
in the contract line
to automatically
update the price.

Item An Oracle Inventory
item

Service Agreement
only

Covers:

• A serviceable
inventory item.

• Business
processes
performed on that
inventory item as
defined in service
coverage.
Uses the price list
you have specified
in the contract line
to automatically
update the price.

How to Use Coverage Levels

Which level you use depends on the type of service you are selling and on the different
needs of your enterprise.

The following table provides suggested guidelines. It lists some of the main business
uses and lists the recommended covered levels for each.
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Business Use Recommended Levels Example

Servicing a customer product • Product • A washing machine
manufacturer sells
extended warranties
for the products it has
sold.

• Any serialized product

• A fire safety equipment
vendor sells service for
emergency generators
installed in a building.

Servicing high volume and
low cost items

• Party

• Customer

• Site

• System

The fire safety equipment
vendor services fire sprinklers
by customer site because they
are too numerous to track in a
contract individually.

Providing services not tied to
any specific product such as
telephone support or safety
inspections.

• Party

• Customer

• Site

Sometimes a service covers
a business process rather
than any specific product a
customer owns.
For example:

• A computer manufacturer
provides telephone
support to troubleshoot
all of its products.

• A vendor of fire protection
equipment offers periodic
safety inspections at a
particular site or building.

Providing support for products
the customer plans to purchase
in the future

• Item Use the Item level to cover
products not yet in the installed
base.
For example, a customer
plans to purchase additional
generators in the near future
so they wish to include them
in the same service agreement
in order to receive a discount.

Covering Customer Products (Instances in Oracle Install Base)
This group of procedures explains how to cover one or more customer products by
a service:

• Covering Customer Products, page 4-16 provides the general procedure for entering
a product.

• Browsing the Oracle Install Base to Identify Item Instances for Coverage, page 4-17
explains how to use a built-in browsing window to identify the Oracle Install Base
item instances you wish to cover if you do not know their serial numbers or item
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instance numbers. Here you also learn how the browser speeds up your entries
of multiple sublines at the same time.

• Entering a Customer Product into the Installed Base, page 4-19 explains how to
create a record in Oracle Install Base so you can cover products a customer has
purchased from third parties.

Covering Customer Products
You can enter one or more products to be covered by the service.

You are not restricted covering products owned by the parties in the contract. You can
cover any product belonging to any party that is an item instance in Oracle Install
Base. However, Oracle recommends that you restrict the coverage to a party in the
contract or any party related to the contract party.

Prerequisites

• Enter a service line.

• If a product you wish to cover is not entered in Oracle Install Base, for example, if
you are selling service for a product the customer purchased from a third party, then
you must create an item instance as described in Entering a Customer Product into
the Installed Base, page 4-19.

To cover customer products:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service line that will cover the product.

3. Select the Effectivity secondary tab at the bottom of the window.

4. Enter the product or products to cover by one of the two following methods:
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• If you have a small number of products to cover and you know their serial
numbers or item instance numbers, you can enter each subline individually
making entries directly into the fields on each line:

1. On a new line on the Effectivity secondary tab, choose Product from the
Level LOV.

2. In the Name field, enter the Oracle Inventory name or a partial name with
the percent sign to indicate any missing characters. If the product inventory
name is AS45888, for example, then you can enter AS45888 or AS45%.

3. Press the Tab key.

The LOV search window appears:

4. You can search by complete serial number or the Oracle Install Base
item instance number. Enter it after the % sign in the Find field. For
example: AS54888%99855.

5. Click Find.

If the search identifies a unique customer instance, the application returns
you to the authoring window. Otherwise, you have to narrow your search
criteria or select an item on the list and click OK.

• To select multiple products for coverage at the same time, or if you do not
know the serial number or the item instance number of an individual product
to cover, you can make your selection from a graphical display of the contents
of the customer’s installed base by clicking the LOV indicator in the Name
field. For details see Browsing the Oracle Install Base to Identify Item Instances
for Coverage, page 4-17.

A product you enter is displayed in the Name field by its inventory item
name. You can see the customer product’s serial number, item instance
number, or both in the Description field.

5. Save.

The application automatically updates the price of the service line.

Note: The application calculates prices based on the quantity
attached to the item instance and the price list you have selected for
the service line. Most item instances are specified for individual
items, but non-serialized items, including consumables such as ink
cartridges, can come in any quantity. If the updated price is more
than you expected, then check the quantity attached to the item
instance by clicking Product Details.

Browsing Oracle Install Base to Identify Item Instances for Coverage
You can browse the customer’s Oracle Install Base records and select one or more
products for coverage. Each product you select appears as a separate line in the
authoring window.

Prerequisite

Enter a service line.
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To browse Oracle Install Base to identify item instances for coverage:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service line that will cover the product.

3. Select the Effectivity tab at the bottom of the window.

4. Choose Product from the Level LOV.

5. Click on the LOV indicator in the Name field.

The Product window appears.

6. Because the size of your Oracle Install Base can be too large for browsing, there are a
number of ways you can restrict view, you can:

• Choose different views.

By making a selection from the Level drop-down list, you can view the item
instances by:

• Item: Selecting this level displays all of the instances for a particular
inventory item.

• Model: If you have configured items in your installed base, you can view
them by model.

• System: If your Oracle Install Based item instances are grouped in
systems, you can display the instances by system.

• Site: Use this level to display all the item instances at a particular address.

• Customer: Use this level to view item instances by a customer account.

• Party: Organizes the display by customers in your database. This view is
most useful if you are selling to consumers.

• Specify which customer records display.

By selecting a Customer Context, you specify what customer records display:

• Customer: Limit the display to the party entered as the customer on the
Summary tab of the contract.

• Related Customer: Parties with a relationship to the customer in the Oracle
Trading Community Architecture (TCA) party model.

You can display item instances for:

• Both: Both the customer and related parties.

• All: All parties in the database.

• Restrict the list displayed in the window.

Enter a search term in the Name field to restrict what is displayed in the list. You
can use partial entries and the percent sign % to represent omitted characters.

For example, to view the installed base by inventory item but not view all
items, you can restrict the display to just the item you want by entering it in the
Name field.

7. After you have entered the display criteria, click Find.

The window displays the installed base in the form of a tree.
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8. View the details of any node on the tree, by clicking on it.

9. Select any item instance you wish to add, holding down the CTRL or Shift keys
for multiple selections.

10. Click OK to return to the Service Contracts Authoring window.

Each selection creates an individual line in the Effectivity secondary tab.

Entering a Customer Product into Oracle Install Base
You can cover a product that does not have an item instance in Oracle Install Base. You
may have to create an instance if you provide service for products a customer purchased
from a third party such as a vendor or a dealer, for example.

Prerequisites

• Set up product as an item in Oracle Inventory.

• Enter a service line.

To enter a customer product into Oracle Install Base:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service for the product you are about to create.

3. Select the Effectivity tab at the bottom of the window.

4. Choose Product for your Level.

5. Click on the LOV indicator in the Name field.

The Product window appears.

6. Click New.

The application opens the Item Instance Creation window for Oracle Install Base in a
new browser window.

7. Create the item instance following the procedures described in the Creating Item
Instances section of the Oracle Install Base User Guide.

8. Write down the instance number.

9. Use the instance number to enter the covered product as described in Covering
Customer Products (Instances in Oracle Install Base), page 4-15.

Covering Parties
You can cover one or more parties with a service. A party is a customer in your
database. This can be an individual consumer or an organization.

Prerequisite

Create a contract of category Service Agreement.
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To cover parties:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service.

3. Select the Effectivity tab at the bottom of the window.

4. If you are covering a small number of parties and you know the party names or a
partial party names, then make your entries on separate sublines. For each party:

1. In a new line, choose Party as the Level.

2. Enter the name or partial name in the Name field. (Use the % sign to indicate
omitted characters.)

3. Press the Tab key.

If the application does not find a unique match, it opens a search window where
you can refine your search.

5. To enter multiple parties at the same time or you do not know the name of the
party, then you can make a selection from a list of the parties in your database
displayed in a logical tree:

1. Click on the LOV indicator in the Name field.

The Party window appears.

2. Choose Related Customer from the Customer Context list.

3. Click Find.

The window displays a list of parties related to the customer on the contract.

4. Select one or more parties (use the Shift or Ctrl keys for multiple selections).

5. Click OK.

6. Save.

Covering Customer Accounts
You can select one or more customer accounts (party accounts) to cover with a
service. You can cover the accounts belonging to the parties in the contract or to any
parties with a relationship to them.

Prerequisite

Create a contract of category Service Agreement.

To cover customer accounts:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service.

3. Select the Effectivity tab at the bottom of the window.

4. If you know the party that owns the account you can enter each account individually
as a subline. For each subline:
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1. Choose Customer for your Level.

2. In the Name field, enter the name or partial name of the party.

3. Press the Tab key.

The application displays a list of accounts for the party you specified in a search
window.

4. Select the account to cover or refine your search by adding the % sign and the
account number to the search term.

5. Click OK.

The Name field displays the name of the party. The Description field displays
the account number.

5. To enter multiple parties at the same time or if you do not know the party name or
account, then you can browse through a list of related parties and accounts:

1. In a new line, choose Customer for your Level.

2. Click on the LOV indicator in the Name field.

The Party window appears.

3. Choose Related Customer from the Customer Context list.

4. Click Find.

The window displays a list of parties related to the customer on the contract.

You can view the accounts for the parties listed, by clicking on the party node.

5. Select one or more accounts (use the Shift or Ctrl keys for multiple selections).

6. Click OK.

6. Save.

Covering Party Sites
You can cover one or more party sites with a service.

Prerequisite

Create a contract of category Service Agreement.

To cover party sites:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service.

3. Select the Effectivity tab at the bottom of the window.

4. To enter individual sites where you know the site numbers, enter each site on a
separate subline:

1. On a new line, choose Site as the Level.

2. Enter the site number in the Name field. The site number is the unique
identifying number generated by the application for each party address.
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5. To cover multiple sites at the same time or if you do not know the site number, then
you can find the site to cover by browsing through a list of customers and their
sites. See Browsing Through Party Sites, page 4-22.

Browsing Through Party Sites
You can select sites to cover by browsing through a list of sites organized by party.

Prerequisite

Enter a service line.

To browse through party sites:
1. Navigate to Lines tab and Pricing/Products subtab.

2. Select the service line.

3. Select the Effectivity tab at the bottom of the window.

4. On a new line, choose Site from the Level LOV.

5. Click on the LOV indicator in the Name field.

The Site window appears.

6. Restrict which parties to display by choosing a Customer Context:

• To view only the sites for the contract customer, then choose Customer.

• Related Customer: Displays the parties with a relationship to the customer
in the Oracle Trading Community Architecture (TCA) party model.

• Both: Displays both the customer and related parties.

• All: Displays all parties in the database.

7. To restrict the list displayed to a particular party name, then enter a name or partial
name.

8. Click Find.

The window displays a list of parties that meet your criteria.

9. View the sites for any party, by clicking on the party node.

10. Select the sites to cover (hold down the Shift or Ctrl keys for multiple selections).

11. Click OK to return to the Service Contracts Authoring window.

Covering Systems
You can cover one or more systems with a service. A system is a grouping of item
instances created in Oracle Install Base.

Prerequisite

Create a contract of category Service Agreement.
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To cover systems:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service.

3. Select the Effectivity tab at the bottom of the window.

4. To enter systems individually and you know the system names, then for each system:

1. On a new line, choose System from the Level LOV.

2. Enter the name or partial name in the Name field. Use the % sign to represent
missing characters.

3. Press the Tab key.

5. To enter multiple systems at the same time or you do not know the system
names, you can browse through a list of systems by party, party account, or party
site. See Browsing Through Oracle Install Base Systems, page 4-17.

Browsing Through Oracle Install Base Systems
You can identify and select systems for coverage by browsing through a list of systems
organized by party, party account, or party site.

Prerequisite

Enter the service line.

To browse through Oracle Install Base systems:
1. Navigate to Lines tab and Pricing/Products subtab.

2. Select the service line.

3. Select the Effectivity tab at the bottom of the window.

4. Choose System from the Level LOV.

5. Click on the LOV indicator in the Name field.

The System window appears.

6. To limit the number of customer systems to browse through at any one time, you can:

• Choose different views

By making a selection from the Level drop-down list, you can view systems by:

• Customer account, by choosing Customer.

• Party, by choosing Party.

• Party site (identified by its number), by choosing Site.

• Specify which parties to display by choosing a Customer Context, you specify
what customer records display. The choices are:

• Customer: Limit the display to the party entered as the customer in the
contract.

• Related Customer: Parties with a relationship to the customer in the Oracle
Trading Community Architecture (TCA) party model.
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• Both: Both the customer and related parties.

• All: All parties in the database.

• Restrict the list displayed in the window

Enter a search term in the Name field to restrict what is displayed in the list.

For example, if you have selected Party as the level, you can limit the display to a
specific party by enter its name in this field.

7. After you have entered the desired display criteria, click Find.

The window displays the systems in the desired view of the installed base systems
in the form of a logical tree.

8. View the systems in any node on the tree by clicking on it.

9. Select the systems you wish to cover (use the Shift or Ctrl keys for multiple
selections).

10. Click OK to return to the Service Contracts Authoring window.

Covering Inventory Items
You can cover one or more Oracle Inventory items with a service. You can cover multiple
quantities of the item on each subline.

Prerequisites

• Create a contract of category Service Agreement.

• Identify the Oracle Inventory item name of the item to cover.

To cover inventory items:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service.

3. Select the Effectivity tab at the bottom of the window.

4. Choose Item for your Level.

5. Use the Name LOV to enter the item name.

6. Save.

7. Navigate to the Pricing tab.

8. Enter the quantity of item that is being covered in the Qty field.

9. Choose the unit of measure using the UOM LOV.

10. Save.

Viewing Details About a Covered Product
The products covered by a service line are identified in the Service Contracts Authoring
Window by their Oracle Inventory names. You can view the complete details about
a covered product (an instance in Oracle Install Base), including the installation
address, installation date, and pricing information.
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Prerequisites

• Set up the product as an item in Oracle Inventory.

• Enter a service line.

To view details about a covered product:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the service covering the product.

3. Select the Effectivity tab at the bottom of the window.

4. Select the covered line to display. (The Level must be of type Product.)

5. Click Product Details.

The Product Details window appears with the information.

Note: For service contracts of category Warranty and Extended
Warranty, you can view details for all of the covered products at the
same time, by clicking the Show All Products button.

Specifying How the Service Prints on an Invoice
By default, Oracle Receivables prints both the line and subline on the customer invoice.

You can specify:

• If a service line and subline is omitted from the invoice, page 4-25

• What text gets printed, page 4-26

Omitting a Line or Subline from the Invoice
The printing of contract line and subline details is controlled by the Invoice Print Flag
check box. By default, this check box is selected and the line and subline is printed. You
can prevent a selected line or subline from being printed on the invoice, by deselecting
the check box. Omitting the line or subline from the printed invoice does not remove the
price from the invoice subtotals.

Prerequisite

Enter a service line.

To omit a line or subline from the invoice:
1. From the Service Contracts Authoring window, select the Lines tab, Pricing/Products

subtab.
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2. To omit a line from the invoice, deselect the Print Flag check box on the right.

3. To omit a subline from the invoice:

1. Select the line.

2. Select the Administration secondary tab.

3. Deselect the Print Flag check box.

4. Save.

Specifying the Invoice Text
You can specify what text appears on the invoice for the service line and sublines.

The application automatically creates a description of the line and sublines for you. For
contract lines, this is the service description and the effective dates separated by colons.

For example, if the service name is Gold Service and the effective dates are 01-JAN-2005
to 31-DEC-2005, then the text invoice reads:

Gold Service:01-JAN-2005:31-DEC-2005.

For covered sublines, the description also includes the name of the item covered.

If you have sold Gold Service, 01-JAN-2005 to 31-DEC-2005, for washing machine
SuperWash, then the generated description reads:

Gold Service:01-JAN-2005:31-DEC-2005.

Prerequisite

Enter a service line.

To specify the invoice text:
1. From the Service Contracts Authoring window, select the Lines tab and Effectivities

subtab.

2. Select the service covering the product.
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3. Modify the line descriptions in the Invoice Text field.

4. If you are billing for individual covered items, then:

1. Select the Pricing/Product subtab.

2. On the Effectivity tab at the bottom of the window, modify the text in the Invoice
Text field.

5. Save.

6. You can copy the description you have entered to the sublines by using the Cascade
Attributes option from the Actions menu. See Applying Changes from a Service
Line to the Covered Sublines, page 4-41.

Specifying a Billing Schedule
You can specify how and when a customer is billed for a service and when the billing
records are sent to Oracle Receivables.

You can bill a customer for a service either at the contract line level or separately for each
of the sublines covered by the service. If you are billing separately for each subline, then
you can create a different billing schedule for each.

If you have entered a billing schedule at the contract header level, then this schedule is
defaulted for you.

Prerequisite

Enter a service line.

To specify a billing schedule:
1. From the Service Contracts Authoring window, select the Lines tab and the

Pricing/Products subtab.

2. Select the service line to set up.

3. Click Billing.

The Billing window appears.
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4. Choose a billing level from the Level LOV. Choose one of the following:

• Equal Amount: to bill for equal amounts over the billing period and have
control over the amount as well as the billing periods.

• Top Level: to bill customers for the service as a whole.

• Covered Level: to bill customers at the level of each subline.

5. Specify the billing schedule by entering one or more billing streams. This is the
same procedure as is used for creating schedules at the header level. See Entering a
Billing Stream, page 3-8 for details.

6. If you chose Covered Level you can modify the billing schedule for any of the
sublines:

1. Select the service line on the Lines tab and Pricing/Products subtab.

2. Select the Pricing secondary tab.

3. Select the subline you wish to modify.

4. Click Billing.

The Billing window appears for this subline.

5. Create a billing schedule for this subline using one or more billing streams.

6. Click OK.

Pricing What a Service Covers
The application automatically prices a service on an Oracle Inventory item or a product
the customer owns (an item instance in Oracle Install Base) based on the price list.

You must price the other covered levels manually. For this reason, you must follow
different procedures for entering and adjusting prices:

4-28 Oracle Service Contracts User Guide



Adjusting the Price of a Service for a Covered Product or an Item, page 4-29,Pricing
Service for a Party, page 4-29.

Additional ways of adjusting prices for your customer are covered in Adjusting Prices,
page 8-1.

Adjusting the Price of a Service for a Covered Product or an Item
The application automatically prices a service for an inventory item or a covered
product (an item instance in Oracle Install Base) using the price list you entered on
the Effectivities subtab.

To reprice you can:

• Apply preset discounts and surcharges by using the pricing Adjustments window (a
selection from the Tools menu). See Entering Price Adjustments.

• Adjust the price manually directly in the Authoring window when you enter the
subline. See Manually Adjusting the Price, page 4-29.

• Change the price list on the Effectivities subtab. See Repricing a Service by Changing
the Price List, page 4-29 for details.

Repricing a Service by Changing the Price List
You can reprice the service line or an individual subline by changing the price list.

Prerequisite

Enter a service line.

To reprice a service by changing the price list:
1. From the Service Contracts Authoring window, select the Effectivities subtab.

2. Choose a different price list from the Price List LOV.

3. Save.

4. Select the Pricing/Products subtab.

5. Select the line you wish to reprice.

6. To reprice an individual subline, then:

1. Select the Pricing secondary tab.

2. Select the subline you wish to reprice using the new price list.

3. Click Reprice to update the price.

7. To reprice the whole line, then click Reprice on the subtab itself.

8. Save.

Manually Adjusting the Price
You can manually adjust the price of a service covering an inventory item or a covered
product (Install Base item instance) in one of two ways:
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• By applying discounts or surcharges preset by the administrator using the
Adjustment window. See Entering Price Adjustments, page 8-3.

• By modifying the price directly in the authoring window as described in this
procedure.

Note: Your application administrator must set up this item or
product with a manual modifier in Oracle Advanced Pricing for you
to be able to adjust the price using this method.

Prerequisite

Enter a service line.

To manually adjust the price:
1. From the Service Contracts Authoring window, select the Lines tab and the

Pricing/Products subtab.

2. Select the service line to adjust.

3. Select the Pricing secondary tab.

4. Select the subline to reprice.

5. Adjust the price using the methods described below:

• Enter a different price in the Subtotal field and click Save. For example, if the
service costs $100, then you can give the customer a 10% discount by entering 90.

Note: The application applies the discount you enter here
provided the application administrator has set the system
profile OKS: Use Advanced Pricing for Manual Adjustment to
Yes. You can verify if the item has been discounted by clicking
the Price Calculation button. See Viewing Adjustments for the
Whole Contract, page 8-5.

• If your organization prices a service based on different time increments, for
example charging a different price if the service is purchased by the year, by
the quarter, or by the month, then you can use the Price UOM to specify
which increment to use to calculate the price. If you do not sell by different
increments, then leave this field blank.

To reprice:

1. Choose a length from the Price UOM LOV.

2. Save.

See About Changing the Basis for Pricing a Service, page 4-30 for details on
when and how to use this repricing method.

6. If you are not satisfied with the changes you have made, you can restore the original
price by clicking Reprice.

Changing the Basis for Pricing a Service
If your organization prices the same service based on different time increments, for
example offering different prices for a year contract and a monthly contract, you can

4-30 Oracle Service Contracts User Guide



specify which increment price will be the basis for charging the customer by making
an entry in the Price UOM field.

This makes it possible for you to:

• Offer a customer any of the available prices for the service.

For example, you can offer a customer who wishes to purchase a service for nine
months either the monthly, the quarterly, or the yearly price.

• Ensure a customer purchasing a contract for an irregular time period is charged
the correct price.

If you do not make any entries in the Price UOM field, then the customer is charged
based on the value of the Period field on the Lines tab, Effectivities subtab. The
period, which is defaulted by the application, may not always be the one you wish to
use as the basis for charging the customer.

Suppose your organization offers a service in yearly, quarterly, and daily
increments, and a customer wishes to start the service on January 1, 2005 and end it
on January 4, 2006. Because this period of one year and five days is not divisible by
one year or a quarter, the application defaults a day as the period.

This means that, unless you enter a different basis in the Price UOM field, the
customer will pay 370 times the price of a daily contract rather than the price of a
yearly contract plus a prorated price for the extra five days.

Note: If you specify a unit of measure (UOM) that is not priced on
the price list, the application charges the customer based on the
price of the UOM the administrator has specified as primary. If the
UOM is not priced and there is no UOM designated as primary, then
the application returns a price of 0.

Pricing Service for a Party, Customer Account, Site, or System
You can price a service for covered levels not priced automatically: party, customer
(party) account, site, and system. You must price each subline individually.

Prerequisite

Enter a service line.

To price a service for parties, customer accounts, sites, and systems:
1. From the Service Contracts Authoring window, select the Lines tab and the

Pricing/Products subtab.

2. Select the service line to set up.

3. Select the Pricing secondary tab.

4. Select the subline to price.

5. Enter the price using one of the two following methods:

• Calculate the extended price for the service based on a quantity and unit price:

1. Enter the quantity in the Qty field.

2. Choose the unit of measure from the UOM LOV.

3. Enter the unit price in Unit Price.
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4. Press the Tab key.

The application calculates the extended amount.

5. You can modify the Subtotal.

Note: The entries you make here are optional. They are
designed to aid you in making the calculation only.

• Enter the price directly into the Subtotal field.

6. Save.

Specifying a Payment Method for a Contract Line
This group of procedures explains how to specify a payment method for a specific
contract line.

• Specifying Payment by Credit Card or Commitment Number, page 4-32

• Requiring a Purchase Order, page 4-33

• Specifying a Purchase Order Number, page 4-33

To specify the same payment method for all the lines in your contract then instead create
a default payment method on the Summary tab according to the procedure describe in
Specifying a Default Payment Method, page 3-12.

If you have already set up the default payment method, then payment information is
already defaulted for you.

Specifying Payment by Credit Card or Commitment Number
Commitments, which are set up in Oracle Receivables, represent a customer’s
prepayment for goods or services (prepayments) or contractual agreements (guarantees).

Prerequisite

Confirm the setup of commitments, in Oracle Receivables first. See the Oracle Receivables
User Guide.

To specify payment by credit card or commitment number:
1. From the Service Contracts Authoring window, select the Lines tab and

Exemption/Payment Options subtab.

2. To specify payment by credit card, then:

1. Choose Credit Card from the Payment Type drop-down list.

2. Enter the credit card number and expiration date.

3. To specify payment by commitment, then:

1. Choose Commitment Number from the Payment Type drop-down list.

2. Enter the commitment number using the LOV.

4. Save.
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Requiring a Purchase Order
You can require the entry of a purchase order number for the contract line. The contract
then cannot pass the QA check and become active unless a purchase order is entered
for every line.

To require a purchase order:
1. From the Service Contracts Authoring window, select the Lines tab and

Exemption/Payment Options subtab.

2. In the Payment Method region, select the Purchase Order Required check box.

3. Save.

Specifying a Purchase Order Number
You can enter a purchase order number in a contract line. This number is sent to Oracle
Receivables and appears on customer invoices.

To specify a purchase order number:
1. From the Service Contracts Authoring window, select the Lines tab and

Exemption/Payment Options subtab.

2. In the Payment Method region, enter the purchase order number in the PO Number
field.

3. Save.

Modifying Coverage Provided by a Service
Each service you select as a contract line item comes with a predefined list of what that
service covers (terms of coverage). This includes:

• Covered business processes (service fulfilment channels)

• Pricing and discounts

• Time zones covered, and the days and times coverage is available

• Required reaction and resolution times

• Preferred resources to carry out the work

What coverage is provided by a service is defined by the application administrator using
a coverage template at the time the service item is defined in Oracle Inventory.

You can modify any of the coverage provided for an individual service line in the
contract. For example, you can change the response time, or extend a service providing
weekday telephone support to cover weekends as well. However, the contract price is
not affected by any of the modifications you make in an individual contract, so your
organization may prefer to make any coverage changes in the coverage template itself.

Prerequisite

Enter a service line.
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To modify coverage provided by a service:
1. From the Service Contracts Authoring window, select the Lines tab and the

Effectivities subtab.

2. Select the service line you wish to modify.

3. Click Edit Coverage.

The Service Contracts Coverage window appears.

4. Modify the coverage as described in Defining a Coverage Template, page 20-3
section of this guide.

Scheduling Preventive Maintenance Activities
This procedure is for scheduling periodic activities only. For scheduling activities based
on usage, for example, maintaining a printer based on the number of copies made, you
must use Oracle Complex Maintenance, Repair, and Overhaul.

If preventive maintenance activities are required as part of the service you have entered
in a contract line, then the application includes these along with the other coverage
details attached to the item.

The application administrator can set up the application to automatically schedule these
maintenance activities for you when you enter the contract line. The scheduled dates
are the planned start dates of any service requests the application generates to carry
out the work.

You can:

• Specify new dates when each of the activities is to start.

The dates you enter become the planned start dates in any service requests the
application generates for these activities.

• Specify a range of dates the maintenance activities are to start.
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The start date of each activity is the planned start date in the corresponding service
request.

Note: The application can automatically generate a schedule based
on start dates only. To specify a date range, then you must enter the
start and end dates into the contract manually.

Prerequisites

• Enter a service line.

• Confirm the setup of the preventive maintenance program and associated activities
in Oracle Complex Maintenance, Repair, and Overhaul.

To schedule preventive maintenance activities:
1. From the Service Contracts Authoring window, select the Lines tab and the

Effectivities subtab.

2. Select the service line you wish to modify.

3. Click Edit Coverage.

The Service Contracts Coverage window appears.

The preventive maintenance program associated with the service line by your
application administrator appears in the Program name field in the Preventive
Maintenance region of the window.

The preventive maintenance program encompasses the required maintenance
activities for the product. Both the program (also called a maintenance requirement)
and its activities are set up in Oracle Complex Maintenance, Repair, and Overhaul.

4. Click Schedule.

The Preventive Maintenance Schedule window appears showing the Program
Schedule tab. If the application administrator has set up a schedule for this
program, then the Schedule region is already populated with dates.

The maintenance activities you must schedule are listed on the Activity Schedule tab.

5. You can schedule the preventive maintenance activities in one of two ways. You can:

• Create a template schedule on the Program Schedule tab and use that schedule
to schedule multiple activities. See Scheduling Multiple Activities , page 4-35.

• Create a separate schedule for each activity. See Scheduling Individual
Activities, page 4-36.

6. Click OK when you are done.

Scheduling Multiple Activities at the Same Time
You can later modify the default schedule to create a unique schedule for each activity.

Prerequisites

• Enter a service line.

• Confirm the setup of the preventive maintenance program and associated activities
in Oracle Complex Maintenance, Repair, and Overhaul.

Entering Service Lines 4-35



• Associate a preventive maintenance program with a coverage template.

To create schedule multiple activities at the same time:
1. From the Service Contracts Authoring window, select the Lines tab and the

Effectivities subtab.

2. Select the service line you wish to modify.

3. Click Edit Coverage.

The Service Contracts Coverage window appears.

4. Click Schedule in the Preventive Maintenance region.

The Preventive Maintenance Schedule window appears.

5. Select the Program Schedule tab.

6. If the customer must approve scheduled tasks in the service request before they are
performed, then select the Confirmation Required check box.

7. Create a default schedule for the activities in the Stream Levels region. See
Scheduling Activities at Regular Intervals Using Schedule Streams, page 4-37.

8. To default this schedule to multiple activities, then:

1. Select the Activity Schedule tab

2. Make sure only the Select check boxes for the activities you want to set up are
selected.

3. Click OK.

The application asks you if you wish to copy the schedule to the activities.

4. Click Yes.

9. To default this schedule to a single activity, then:

1. Save.

2. Select the Activity Schedule tab.

3. Select the activity by placing your cursor in any field on the line.

4. Click Populate from Program.

The application copies the default dates or date ranges to the selected activity.

Scheduling Individual Activities
Prerequisites

• Enter a service line.

• Confirm the setup of the preventive maintenance program and associated activities
in Oracle Complex Maintenance, Repair, and Overhaul.

• Associate a preventive maintenance program with coverage template.
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To schedule an individual activity:
1. From the Service Contracts Authoring window, select the Lines tab and the

Effectivities subtab.

2. Select the service line you wish to modify.

3. Click Edit Coverage.

The Service Contracts Coverage window appears.

4. Click Schedule in the Preventive Maintenance region.

The Preventive Maintenance Schedule window appears.

5. Select the Activity Schedule tab.

6. Make sure only the activities you wish to set up are selected using the Select check
box to the right of the Activity region.

7. If you have created a default schedule you wish to use to schedule this activity, then
click Populate from Program.

The application defaults the schedule you have created on the Program Schedule tab.

8. To create a separate schedule for this activity, then create the schedule in the Stream
Levels region. See Scheduling Activities at Regular Intervals Using Schedule
Streams, page 4-37.

9. If the customer must approve the tasks in the service request before work starts, then
select the Confirmation Required check box located to the right of the activity.

10. Save.

Scheduling Activities at Regular Intervals Using Schedule Streams
You can schedule an inspection every month for a piece of equipment that requires
12 inspections during the year.

Each set of regular dates is called a schedule stream. You can set up any number of such
schedule streams using this procedure to handle complex requirements. For example, if
a piece of equipment requires two inspections in the first year and six for every year
thereafter, you can schedule the semiannual inspections for the first year using one
stream and use the second stream to create the schedules for the six inspections in the
second year.

You can use this procedure on both on the Program Schedule and the Activity Schedule
tabs, depending on whether you are creating a default schedule for all the activities in a
program or scheduling individual activities. See Scheduling Multiple Activities at the
Same Time, page 4-35 and Scheduling Individual Activities, page 4-36.

To schedule an activity at regular intervals using a scheduling stream:
1. From the Preventive Maintenance Schedule window, navigate to the Stream Levels

region:

2. If this is the first stream, then:

1. Enter 1 in the Seq Num field.

The application defaults the start date from the start date of the contract line.
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2. Enter the number of times you wish the activity to be performed in the Periods
field

3. Enter the length of each period in the UOM/Period and UOM fields. For
example, to schedule an inspection once a month, then enter a 1 in the
UOM/Period field and select Month from the UOM LOV.

The application supplies the end date.

3. If this is an additional stream, then:

1. In the Seq Num field, enter a number corresponding to the order in which the
periods are created.

The sequence numbers for scheduling streams must be in order of the dates in
the schedule. To schedule an activity earlier than an existing activity, reorder the
entire sequence.

The application defaults the start date from the end date of the previous stream.

2. Enter the length of each period in the UOM/Period and UOM fields. For
example, to schedule an inspection once a month, then enter a 1 in the
UOM/Period field and select Month from the UOM LOV.

The application supplies the end date.

4. To postpone the scheduled start of the first activity in the stream, then enter an offset
period by either of these two methods:

• Enter a different date in the First Date.

• Enter the number of periods in Offset Period and the length of the offset period
in Offset UOM.

5. To create a schedule based on individual suggested dates, then select the Auto
Schedule check box.

6. To create a schedule base on a date range, then leave the Auto Schedule check box
unselected.

7. Click Schedule to generate the schedule.

The application displays the generated schedule in the schedule region.

8. If you left the Auto Schedule check box unselected, then the application permits you
to enter a date or a date range to replace the automatically generated date.

Enter the date range for any of the scheduled dates in the From and To fields.

9. Save.

Viewing Maintenance Program and Activity Details
Both the program and activities are set up and maintained in Oracle Complex
Maintenance, Repair, and Overhaul. See Oracle Complex Maintenance, Repair, and Overhaul
User’s Guide for details.

Prerequisite

Enter a service line.
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To view maintenance program and activity details:
1. From the Service Contracts Authoring window, select the Lines tab and the

Effectivities subtab.

2. Select the service line you wish to modify.

3. Click Edit Coverage.

The Service Contracts Coverage window appears.

• To view details about the program, click View Program on either the Program
Schedule or the Activity Schedule tabs.

The application opens a new browser window displaying the details of the
maintenance requirements.

• To view details about individual activities:

1. On the Activity Schedule tab, select the activity in the Activity region.

2. Click View Activity.

The application opens a new browser window displaying the details of the
activity. See Oracle Complex Maintenance, Repair, and Overhaul User’s Guide for
details.

• To view the maintenance history of the product the customer owns:

1. On the Program Schedule tab, click History.

2. The application displays the Search Unit Maintenance Plan page in a separate
browser window. Search for the maintenance history for the product
according to procedures described in Oracle Complex Maintenance, Repair, and
Overhaul User’s Guide.

Ending Service Lines on a Day Specied by the Customer
You can define a cotermination date, which is a date that has been chosen by the
customer as the end date for all service lines:

• About Cotermination, page 4-39

• Applying the Cotermination Date to a Service, page 4-40

About Cotermination
To simplify renewals and accounting customers sometimes request all contracts to
terminate on the same date, such as the end of the calendar or fiscal year. This date
is called the cotermination date.

Your application administrator can set up a cotermination date for a customer
account. The customer account for the service line is the bill to account you enter on
the Lines tab, Accounts subtab.

You can tell a cotermination date exists for the service line, when the Coterminate and
Coterminate All buttons are enabled.

Note: You cannot apply the cotermination date for contracts with a
status of Active.
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If the cotermination date falls too close to the start of the service in your contract, the
application automatically extends the service until the same cotermination date the
following year. For example, if a customer purchases six months of service in December
1 and the cotermination date is December 31 then the application extends the service
until December 31 of the following year instead of selling just one month-worth of
service. Just what minimum service length triggers the extension is determined by the
values in system profiles OKS: Minimum Duration and OKS: Minimum Period.

Applying the Cotermination Date to a Service
Prerequisites

• Enter a service line.

• Confirm the contract is in Entered status.

To apply the cotermination date to a service:
1. From the Service Contracts Authoring window, select the Lines tab and the

Effectivities subtab.

2. Select the service line to end on the cotermination date.

3. Click Coterminate.

The new end date you have entered does not automatically apply to the items
already covered by the service. If you have already specified what the service
covers, then you must copy the new end date using the Cascade Attributes window.

Specifying Tax Status
You can:

• Enter tax exemption information

• Specify that the price includes tax

If you have already set up a default tax status for all lines, then the tax status fields
are already populated for you.

Prerequisite

Enter a service line.

To specify tax status:
1. From the Service Contracts Authoring window, select the Lines tab and

Exemption/Payment Options subtab.

2. In the Tax Exemption region, choose the customer’s tax status from the Status LOV.

3. If you entered Exempt, then enter the tax exemption number.

4. If the price already includes taxes, then select Tax Inclusive Flag.

5. Save.
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Applying Changes from a Service Line to the Covered Sublines
If you change the length of a service, for example by applying a cotermination date, you
must apply them to any existing sublines. You can also use this procedure to copy the
following line attributes to the sublines:

• Invoice text

• Renewal type

• Printing preferences (the setting of the Invoice Print Flag)

Prerequisite

Identify a contract with sublines (what the service covers) and modify the dates for
the service later.

To apply changes from a service line to the covered sublines:
1. From the Service Contracts Authoring window, choose Cascade Attributes from

the Actions menu.

The Cascade Attributes window appears.

2. Choose Lines to Sublines from the Cascade list.

3. Select the check boxes for the line attributes you wish to apply.

4. Select the sublines you wish to copy to on the right side of the window. You can use
the check boxes to the right to select individual sublines, or the Select All button.

5. Click Submit.

Assigning Sales Credits for a Contract Line
You can assign both revenue and non-revenue credits.

To assign sales credits for a contract line:
1. From the Service Contracts Authoring window, select the Lines tab and select the

service to enter sales credits for on any of the subtabs.

2. Choose Sales Credits from the Actions menu.

The Sales Credits window appears.
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3. Enter the sales agents and the revenue and non-revenue credit they are to
receive. Sales group entry is optional. Revenue credit must always add up to 100
percent.

4. Click OK.
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5
Entering Usage Lines

This chapter covers the following topics:

• Overview of Entering Usage Lines

• Charging a Customer for Usage

• Entering a Usage Line

• Specifying How the Customer is Charged

• Charging Based on a Fixed Quantity of Usage Regardless of the Actual Usage

• Charging a Flat Fee Regardless of the Actual Usage

• Charging for Reported or Estimated Usage Per Period

• Charging Based on Reported Usage

• Entering a Counter

• Entering the Starting Counter Reading

• Creating Special Price Breaks

• Point and Range Price Breaks

• Deleting Special Price Breaks

• Prorating Price Breaks to Apply to Multiple Periods

• How Price Breaks Are Prorated

• Specifying a Billing Schedule for a Usage Line

• Recording Usage by Updating a Counter Reading

Overview of Entering Usage Lines
This group of topics explains how to charge customers for usage.

Charging a Customer for Usage
To charge a customer for usage, you must enter:

• A usage item as a contract line, page 5-2. This is where the prices for usage are
defined.

• One or more counters as sublines, page 5-2. These track usage.
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About Usage Items
The usage item specifies the price list and the price breaks used to charge the customer.

The application administrator sets up the usage items themselves as items in Oracle
Inventory, and prices them using price lists in Oracle Advanced Pricing.

For example, a bank may create price breaks on the corporate price list that offers
customers 10 free support calls per month and then charges $1.50 for each call. A copier
distributor may set up a price list to charge customers based on the volume of copies
made, for example, charging $0.05 for the first 1000 copies, charging $0.03 for the next
thousand, and then $0.02 for copies above 2000.

You have the option of modifying the pricing and the price break ranges for each contract.

About Counters
Customer use is recorded in counters. These can represent real devices that measure
usage such as a counter in a copier, automobile odometers and electric meters. The
counters can also be purely logical constructs used to record the number of phone calls
to a call center, for example.

Counters are created automatically by the application each time you order a service or a
customer product is entered as an item instance in Oracle Install Base.

For example, if a bank’s application administrator has set up the Gold service to track
phone calls made to the call center, then each time you add the Gold service as a line
in your contract, the application automatically creates a counter where the number of
calls can be tracked. For physical objects, such as the copier, the application creates a
counter that is linked to the Oracle Install Base instance.

Although the counters are created automatically by the application for you, for each
usage line you must enter the counters you wish to use to charge the customer as
sublines. This may be just one counter, to track phone calls to a call center or to charge
for copies made on one printer, for example, or many counters to charge for the copies
made in a building, for example.

The actual usage is entered into the counters manually either by agents in Oracle
Service Contracts (See Entering the Starting Counter Reading, page 5-18), Oracle
TeleService, Oracle Field Service, and by customers themselves via a Web portal created
with Oracle iSupport.

How Usage Lines and Counters are Entered
Here are the basic steps you must follow to charge for usage:

1. If you are charging for usage as part of a service (for phone calls made to a call
center, for example), then you must enter the service as a line in your contract first.

2. Enter the usage item as a line in the contract.

3. Enter the counters as sublines.

• You identify counters attached to a service by the service name, the contract
number, and the line number where you entered the service.

• You identify physical counters by the inventory name of the product where the
counter is located and by that product’s serial number and/or Oracle Install
Base item instance number.
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Note: Because of the way counters are named, you can only
have one counter per service line in a contract and one counter
per item instance in Oracle Install Base.

You can specify various options on how to charge and bill the customer.

You can charge the customer for the actual usage recorded in the counter each month
and have the application estimate any missing counter readings, for example, or you can
choose to charge a flat rate no matter what the counter readings are.

You can also specify minimum amounts charged and the details of how customers
are credited for any overcharges.

Entering a Usage Line
Prerequisites

• Create the contract with the Service Agreement or Subscription Agreement
category.

• Enter required information in the contract header and Summary tab.

• If you are charging a customer for usage tied to a service you are selling, enter the
service line first.

• Identify the prices and price breaks for the items set up within your organization.

To enter a usage line:
1. From the Service Contracts Authoring window, select the Lines tab and Accounts

subtab.

2. Choose Usage from the Line Type LOV.

3. Choose the usage item from the Name LOV.

4. The party accounts you selected on the Summary tab and Parties subtab appear
as the Bill to and Ship to accounts. (The Account fields display the account
numbers. The Location fields display the city. The account parties and addresses
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for those accounts appear at the bottom of the window.) You can select different
accounts for this contract line using the LOVs provided.

5. Optionally, enter billing and shipping contacts specific to this contract line by
following the procedure described in Entering Billing and Shipping Contact for a
Contract Line, page 4-7. If a contact does not exist in the database, then you can
add one following the procedure described in Creating or Modifying a Contract ,
page 4-8.

The contacts you enter are different from the ones you entered in the contract header.

6. Select the Effectivities subtab.

7. The price list is defaulted from the entry made on the Summary tab. Make sure the
price list displayed in the Price List field matches the price list used by the usage item.

8. Specify the duration of the usage line.

By default, the start date, end date, and duration are copied from the contract header.

You can specify different values by entering either of the following:

• Start and end dates

• Duration and period

The application calculates the missing information. If you supply a duration and
period, then the start date is the start date of the contract.

Note: If the duration of the usage line starts earlier than the start
date or ends later than the end date of the contract, then you
must extend the start and end dates of the contract at the header
level before you can make the contract active.

9. If the contract can be renewed (you have not selected Do Not Renew on the
Summary tab and Renewals subtab), then specify how the line is to be renewed using
the Renewal Type LOV. The renewal options are the same for usage lines as they are
for service lines. See Specifying How a Contract Line is to Be Renewed, page 4-9.

10. Specify how the customer is to be charged and any counters required to capture the
usage. Different ways of charging the customer require different combinations of
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entries in the Effectivities and Pricing/Products subtabs. See Specifying How the
Customer is to be Charged, page 5-5.

11. Much of the rest of the information for a service line is defaulted from the
information you entered in the Summary tab. You can make modifications by
following these procedures:

• Specifying a Billing Schedule for a Usage Line, page 5-27

• Changing the Billing and Shipping Accounts and Locations, page 4-7

• Entering Billing and Shipping Contacts for a Contract Line, page 4-7

• Specifying a Payment Method for a Contract Line, page 4-32

• Specifying Tax Status, page 4-40

• Assigning Sales Credits for a Contract Line, page 4-41

12. Save.

Specifying How the Customer is Charged
You can charge customers in four different ways, depending on the selection you make
in the Usage Type region of the Lines tab, Effectivities subtab.

The following table lists the different methods and the selection you must make for each.

Method for Charging the Customer Usage Type

For a fixed quantity of usage every period,
regardless of the actual usage recorded

Fixed Per Period

A flat fee regardless of the actual usage recorded Negotiated Price

For reported or estimated usage in each billing
period

Actual Per Period

For usage whenever usage is reported Actual by Quantity
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Follow the procedure corresponding to the method you wish to use:

• Charging Based on a Fixed Quantity of Usage Regardless of the Actual Usage ,
page 5-6

• Charging a Flat Fee Regardless of the Actual Usage, page 5-8

• Charging for Reported or Estimated Usage Per Period, page 5-9

• Charging Based on Reported Usage, page 5-14

Charging Based on a Fixed Quantity of Usage Regardless of the Actual
Usage

You can charge a customer for making 100 phone calls to the call center, regardless of the
number of calls actually made. The price the customer pays for the 100 phone calls is
determined by the usage item’s price list and its price breaks.

Prerequisite

Enter a usage item.

To charge a customer based on a xed quantity of usage regardless of the actual usage:
1. From the Service Contracts Authoring window, select the Lines tab and Effectivities

subtab.

2. In the Usage Type Region, select Fixed Per Period.

3. From the Period LOV, choose the period you wish to use as the basis for the entries
you will make.

4. Save.

5. Select the Pricing/Products subtab.
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6. Using the Name field LOV on the Effectivity secondary tab, enter the counter used to
record the usage. See Entering Counters, page 5-17 for details.

7. Select the Counter Details secondary tab.

8. Enter the quantity on which you are going to be charging in the Fixed field. The
fixed quantity is based on the period you selected on the Effectivity subtab. The
period acts as a unit of measure for your entry.

Suppose you are billing the customer monthly.

If you chose a year as the period, then entering 1200 here means the customer is
charged for the usage of 100 each month.

If you chose a month as the period and enter 1200, then the customer is charged
1200 per month.

9. Save.

10. Repeat steps 6 through 8 for each additional counter you wish to use to calculate
usage.

11. Optionally, enter the counter reading to use to start calculating usage:

• If you have already captured previous readings with this counter, then choose
the start reading from the Reading LOV. This LOV includes all historical
readings for this counter.
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• If there is no historical reading available to select, the application assumes the
initial reading for the contract is 0. To enter another initial reading, then follow
the procedure described in Entering the Starting Counter Reading, page 5-18.

Charging a Flat Fee Regardless of the Actual Usage
You can charge a customer $100 for making phone calls to the call center, regardless of
the number of calls actually made. In this case, the customer is charged the price you
enter here rather than the price in the price list.

Prerequisite

Enter a usage item.

To charge a at fee regardless of the actual usage:
1. From the Service Contracts Authoring window, select the Lines tab and Effectivities

subtab.

2. In the Usage Type Region, select Negotiated Price.

3. Save.

4. Select the Pricing/Products subtab.

5. Using the Name field on the Effectivity secondary tab, enter the counter used to
record usage. See Entering a Counter, page 5-17 for details.

6. Optionally, enter any text you wish to display in the invoice regarding this
subline. As invoice formats are specific to each implementation, contact your
application administrator to determine if this text is used in the invoice.

7. Select the Pricing secondary tab.
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8. Enter the total currency amount on which you are going to be charging the customer
in the Subtotal field.

9. Save.

10. Repeat steps 5 through 9 for all counters you are using to track usage for this usage
item.

11. Optionally, enter the counter reading you wish to use to start calculating usage:

• If you have already captured previous readings with this counter, then choose
the start reading from the Reading LOV. This LOV includes all historical
readings for this counter.

• If there is no historical reading available to select, the application assumes the
initial reading for the contract is 0. To enter another initial reading, then follow
the procedure described in Entering the Starting Counter Reading, page 5-18.

Charging for Reported or Estimated Usage Per Period
You can charge the customer for actual or estimated usage within a period. This usage
type permits you to have the application create an estimate for any missing or partial
counter readings and bill the customer based on these estimates.

Prerequisites

• Enter a usage item.

• Confirm billing is set to arrears.

To charge for reported or estimated usage per period:
1. From the Service Contracts Authoring window, select the Lines tab and Effectivities

subtab.
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2. In the Usage Type region, select Actual Per Period.

3. From the Period LOV, choose the period to use as the basis for the entries you will
make on the Counter Details secondary tab..

4. To charge customers based on an average of usage in a particular number of
periods, then enter the number of periods in the Averaging Interval field.

Note: The entry you make here is based on the period you selected
on this tab rather than the period in the billing schedule.

Billing based on an average usage makes it possible to offer
customers with uneven usage a different set of price breaks from
that they would get if they are charged based on actual use.

To have usage averaged, the application administrator must
periodically run the Service Contracts Usage Averaging concurrent
program. See Running the Service Contracts Usage Averaging
Program , page 11-10.

5. Specify when the application settles any customer undercharges or overcharges
using the Settlement Interval LOV. The choices are:

• Billing Period: The application settles at the end of each period. The customer
receives a credit memo or is invoiced for the difference in the next billing
period. This action is performed automatically by Oracle Receivables.

• End of Usage: The application settles all undercharges and overcharges at the
end of the contract. The customer receives one credit memo or invoice for
the difference. The application administrator must regularly run the Service
Contracts Usage Settlement concurrent program which calculates the settlement.

6. From the Termination Method LOV, choose one of the two methods for charging the
customer for usage when the line is terminated:

• Amount Based Termination
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Charges the customer based on the amount of usage recorded when the contract
is terminated. The customer is charged based on the actual usage. This is the
default method for all usage types.

See About Crediting a Customer in Terminations, page 5-13 .

• Counter Based Termination

The application credits the unused portion of the service based on price the
customer would pay if they continued consumption at the same rate for the rest
of the period. This means that the customer receives any price break based
on the estimated usage.

7. Save.

8. Select the Pricing/Products subtab.

9. Using the Name field on the Effectivity secondary tab, enter the counter used to
record the usage. See Entering a Counter, page 5-17 for details.

10. Entry in the Line Ref field is for your information only. It is not used in by the
application.

11. Optionally, enter any text to display in the invoice regarding this line. As invoice
formats are specific to each implementation, contact your application administrator
to determine if this text is used in the invoice.

12. Select the Counter Details secondary tab.

13. In the Default field, enter the reading the application uses to charge a customer if
no counter reading is entered manually and there is no estimate. For example, the
application uses the default quantity to charge a customer at the beginning of a
contract when no historical data exists to calculate an estimate.

Note: The entries you make in the Default and Minimum fields are
based on the period you selected in the Effectivities tab.

The period acts as a unit of measure.

Suppose you are billing the customer monthly.

If you chose year as the period, and enter 1200 as the minimum, then
the customer is billed for a minimum of 1200 in any month.

If you chose month as the period, then entering 1200 as the minimum
bills the customer for a minimum of 100 units in any month.

14. Optionally, enter a minimum counter value in the Minimum field. A customer is
charged this minimum if a counter reading or estimate falls below this number in
any billing period.
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15. You can have the application estimate usage for a billing period when there is no
reading entered or the reading does not cover the whole period. To do so:

1. Choose an estimation method from the Estimation Method LOV:

• Average Monthly Counter Volume

Averages historical readings to calculate any missing values within a billing
period.

• Counter Estimation

Your application administrator can set up additional estimation methods
using the Counters module of Oracle Install Base.

For an explanation of the available methods see About Estimation Methods,
page 5-12.

2. If you chose Counter Estimation as your method, then enter a date you wish
to use as the start date for the estimation in the Start Date field. The counter
estimation bases the estimates on all readings since the start date.

Note: You must choose an estimation method before entering
any counter readings. The estimation method will not work if
you have already made an entry.

3. Set the Fill check box:

• When unselected, the application estimates usage only when there is no
reading during the period.

• Selecting the check box also estimates usage for any remaining days in a
billing schedule period since the reading was entered.

For example, if the you are billing the customer monthly, and a reading is
entered on 15 January, then selecting the Fill check box causes the application
to estimate usage for the remaining half of January.

16. If you are billing a customer based on the usage recorded in multiple counter
values, to average out all of the counter readings each period, select the Level check
box.

For example, a copier manufacturer charging a customer by the number of copies
made, may charge for all the copiers in a building at the same time and apply
minimums and discounts based on average volumes rather than per copier.

17. Enter the counter reading to use to start calculating usage:

• If you have already captured previous readings with this counter, then choose
the start reading from the Reading LOV. This LOV includes all historical
readings for this counter.

• If there is no historical reading available to select, the application assumes the
initial reading for the contract is 0. To enter another initial reading, then follow
the procedure described in Entering the Starting Counter Reading, page 5-18.

18. Save.

19. Repeat steps 8 through 18 to enter any additional counters.

About Estimation Methods
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You can have the application estimate the missing counter values for you and bill the
customer accordingly. If the customer is overcharged, you can generate a credit later.

You can use one of the following two methods for estimating usage for a given
billing period:

• Average Monthly Counter Volume

Oracle Service Contracts uses a simple averaging method, Average Monthly
Counter Volume (AMCV), to calculate missing readings within each scheduled
billing period.

Note: Although the name suggests otherwise, this estimation
method creates averages based on any billing schedule period
you are using be it month, quarter, week, or day.

The AMCV sums up all historical counter readings and averages
them by dividing them by the number of billing periods.

• Counter Estimation

Your application administrator can set up additional estimation methods using
the Counters module of Oracle Install Base. The module makes it possible to set
up additional methods for estimating usage, including:

• Fixed value estimation

• Estimation based on percent usage of the associated counter

Charging a Customer With No Estimation Method

The selection of an estimating method is optional. If you do not choose an
estimation method and no counter reading is available for the billing period, then
the application bills the amount entered in the Default field.

If any counter reading is entered within the billing period, the application bills
based on the reading. If the counter reading is lower than the amount entered in the
Minimum field, then the application bills based on the minimum instead.

Charging with Estimation

The application uses the estimation methods as follows:

• If no reading is available for the billing period and you chose the Average
Monthly Counter Volume estimation method, then the application uses the
historical average to estimate the usage. If you chose Counter Estimation, then
the application uses the method set up by the application administrator to
calculate missing readings from the date you entered in the Start Date field.

• If there are no readings to extrapolate from, for example, at the beginning of the
contract when no historical data exists to make an estimate, then the application
uses the number entered in the Default field.

• If the reading covers only a part of the period and you have selected the Fill
check box, then the application estimates the rest of the period and adds this
estimate to the partial counter reading.

• If the reported and estimated amount is less than the amount you entered in the
Minimum field, then the application bills for the minimum.

About Crediting a Customer in Terminations
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You can have the application credit a customer for any disputed amount of usage
that has already been billed when a customer terminates a usage line.

Suppose, for example, a customer is being billed based on monthly usage of a
copier. The customer calls after receiving the invoice for February to complain that
the copier has not been working properly since February 10. For this reason, the
customer does not wish to pay for all the copies made that month and wants to
terminate the contract for the copier.

You can have the application use the previous month’s reading to estimate the
amount the customer should be charged from February 1 until February 10 and
credit him for the rest.

How the application calculates the usage and credits the customer depends on the
termination method you select:

• Counter Based Termination

The application estimates how much the customer used based on the quantity
the customer used in the previous billing period.

• Amount Based Termination

The application estimates how much the customer used based on the currency
amount the customer used in the previous billing period.

Charging Based on Reported Usage
Here is an example of how this method applies to a copier customer being billed monthly
based on the number of copies made:
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Billing Period Counter Reading
Reported

Minimum Default Number of
Copies Charged
that Month

December No counter
reading in
December.

90 100 100
The customer
is charged the
default as there is
no recorded usage
for the month.

January 1,000 on January
10

90 100 1,000
The customer is
charged for usage
based on the
recorded usage.

February No counter
reading in
February.

90 100 100
The customer
is charged the
default as there is
no usage recorded
for the month.

March 50 on March 1 90 100 90
Because the
recorded usage
is less then
the minimum,
the customer
is charged the
minimum. If you
do not set a value
as the minimum,
then the customer
is charged based
on the recorded
usage.

Prerequisite

Enter a usage item.

To charge based on reported usage:
1. From the Service Contracts Authoring window, select the Lines tab and Effectivities

subtab.

2. In the Usage Type Region, select Actual by Quantity.
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3. Save.

4. Select the Pricing/Product subtab.

5. Using the Name field on the Effectivity secondary tab, enter the counter used to
record usage. See Entering a Counter, page 5-17 for details.

6. Optionally, enter any text to display in the invoice regarding this subline. As invoice
formats are specific to each implementation, contact your application administrator
to determine if this text is used in the invoice.

7. Select the Counter Details secondary tab.

8. In the Default field, enter the reading the application uses to charge a customer if no
counter reading is entered manually or the estimated reading is 0. The entry you
make here is based on the time period you selected in the Effectivities tab.

9. Optionally, enter a minimum counter value. A customer is charged this minimum if
a counter reading or estimate falls below this number in any billing period.

10. If you are billing a customer based on the usage recorded in multiple counter
values, to average out all of the counter readings each period, select the Level check
box.

For example, a copier manufacturer charging a customer by the number of copies
made, can charge for all the copiers the customer owns at the same time and apply
minimums and discounts based on average volumes rather than per copier.

11. Save.
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12. Repeat steps 5 through 11 to enter any additional counters for this usage item.

13. Enter the counter reading to use to start calculating usage:

• If you have already captured previous readings with this counter, then choose
the start reading from the Reading LOV. This LOV includes all historical
readings for this counter.

• If there is no historical reading available to select, the application assumes the
initial reading for the contract is 0. To enter another initial reading, then follow
the procedure described in Entering the Starting Counter Reading, page 5-18.

Entering a Counter
You can enter a counter used to track usage for either a physical item, such as a printer, or
the usage of a service, such as the number of telephone support calls.

Note: If you are entering multiple counters for a usage line, then each
counter must be associated with a different Oracle Install Base item
instance number or a different service line. The application cannot
distinguish between two counters attached to the same item. For
example, if your organization sets up copiers with two different counters
to register the number of copies, one for color copies and the other for
black and white, you cannot distinguish between these two counters.

Prerequisites

You must be in the process of entering a usage line.

Identify the item to which the counter will be attached.

To enter a counter:
1. From the Service Contracts Authoring window, select the Lines tab, Pricing/Products

subtab and Effectivities secondary tab, click on the LOV indicator in the Name field
in a new line.

The Counter window appears.

2. Enter a partial or complete inventory item name in the Find field. You can use the
% sign to represent missing characters.

3. Click Find.

The window displays the list of counters for the inventory item.

• For physical items, the References field includes a concatenation of the two
unique identifiers:

• Product serial number

• Oracle Install Base item instance number

• For service items, this field displays the concatenation of the contract number
and line number of the contract you are specifying the usage line for.

4. Enter the identifying information for the counter after the % sign and click Find again.

5. Select the counter to enter and click OK.
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The Name field displays the inventory item name of the product or service to which
the counter is attached. The Reference field shows the identifying information
including the product serial number and the counter number.

Entering the Starting Counter Reading
You must do this if the counter you are using does not start at 0.

Prerequisite

Enter a usage line.

To enter the starting counter reading:
1. From the Service Contracts Authoring window, select the Lines tab and Counters

subtab.

2. Select the usage line you wish to update.

3. Select the counter for the usage line in the Counters region.

4. From the Actions menu, choose Counter Setup.

The Setup Counters window appears.

5. Enter the initial counter reading in the Initial Reading field.

6. Click OK.

7. Save.

Creating Special Price Breaks
Each usage item is associated by the application administrator with a list of default price
breaks. You can modify these default price breaks and create special price breaks for
your customer. You can offer special price breaks at the usage line level, for all the items
covered by the usage line, or at the subline level, for individual counters.
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By modifying the price breaks, you are creating a locked copy of the price list attached
to the line or subline where you create it. This means that any future changes to the
price list are not be reflected in the copy.

Prerequisite

Enter a usage item.

To create special price breaks:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the usage item to set up.

3. To set up a price break for all of the items covered by the usage line, click Price
Break on the Pricing/Products subtab.

4. To set up a price break for a specific counter covered by a usage line, then:

1. Select the Pricing secondary tab.

2. Select the counter.

3. Click Price Break.

The Price Break window appears.

If the Locked check box is unselected, this means that the price breaks in effect
are the same as those set up by the application administrator.

Entering Usage Lines 5-19



A selected Locked check box indicates the price breaks have already been
modified. The prices are now determined by the locked price list.

Note: The appearance of this variation of the Price Break
window is different:

• The Update button replaces the Lock button.

• The Delete button restores the original price list.

5. Click Lock or Update.

The first time you modify the price breaks, the application creates a copy of the price
list where the price breaks are defined. This action locks the prices for usage to
their values at the time the copy is made.
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The Advanced Pricing - Price Lists window appears.

Note: Although the application displays a full copy of the price
list, you can only modify the price-break related information. Entries
effect only the copy. They have no effect on the price list itself.

6. To change the price break type from point to range or vice versa, then scroll to the
right in the List Lines tab and change the type using the Price Break Type LOV. See
Point and Range Price Breaks, page 5-22 for an explanation of the two price break
types.

7. To change the price break ranges themselves:

1. Click Price Breaks.

The Price Breaks window appears.
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2. You can modify the ranges as desired by:

• Entering different values in the Value From and Value to fields. You must
enter whole numbers and the ranges of values cannot overlap.

• Modifying the prices for each range in the Pricing field.

Note: You may have to scroll to the right or maximize the
window to see the Pricing field.

3. Save and close the window.

8. Save and close the Advanced Pricing Price Lists window.

Point and Range Price Breaks
You can have the application apply price break discounts based on one of the two
following methods:

• Point

• Range

The following example explains the difference between the two methods for a customer
reporting they made 3500 copies in the billing period.

The following table lists the price breaks:

Price Breaks

Break Price

0-1000 $.05

1001-3000 $.04

3001-5000 $.03

5001-10000 $.02

Point Method

The point method gives the customer the best price based on the total amount of copies
made:

Point Method

Point Calculation Amount

3500 Xs $.03 $105.00

Total Invoice: $105.00

Range Method

The range method charges based on all of the price break ranges up to the level
corresponding to the counter reading.
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Range Method

Range Calculation Amount

1000 Xs $.05 $50.00

2000 Xs $.04 $80.00

500 Xs $.03 $15.00

Total Invoice: $145.00

Deleting Special Price Breaks

To delete the special price breaks:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the usage item to modify.

3. To delete a special price break created for all of the items covered by the usage
line, then click Price Break on the Pricing/Products subtab.

4. To revert the special price break created for a specific counter covered by a usage
line, then:

1. Select the Pricing secondary tab.

2. Select the counter.

3. Click Price Break.

The Price Break window appears.

5. Click Delete.
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Prorating Price Breaks to Apply to Multiple Periods
Price breaks are set up in each price list based on one specific period. A customer is
offered a discount if they purchase so many units in each quarter, for example.

You may turn proration on to enable the price breaks to be prorated for other periods as
well. This way a customer receives the same price breaks for purchasing 1/3 the amount
within one month as the full amount in the quarter. When you turn proration on using
this procedure, it is available for all periods including one week and one day.

You can use this procedure to turn proration on or off. By default, proration is turned off.

See How Price Breaks Are Prorated, page 5-26 for an explanation of how the proration is
calculated and how it takes rounding errors into account.

Prorating price breaks is independent from price list locking.

Prerequisites

• Confirm the setup of price breaks or the price list.

• Confirm system profile QP: Break UOM Proration Allowed is set to Yes

To prorate price breaks to apply to multiple periods:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.

2. Select the usage item to set up.

3. To turn on or off proration for all of the items covered by the usage line, then click
Price Break on the Pricing/Products subtab.

Note: Turning price breaks on or off at the line level does not affect
any sublines where proration has been set.

4. To enable or disable price break proration for a specific counter covered by a usage
line, then:

1. Select the Pricing secondary tab.

2. Select the usage line.
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3. Click Price Break.

The Price Break window appears.

Note: The appearance of this window is different if the price
break ranges have already been modified. In this case, the
Locked check box is selected and the Update button replaces
the Lock button.

5. To turn price break proration on, then choose All from the Prorate LOV.

6. To turn price break proration off, then choose None from the Prorate LOV.

7. Save.

8. To modify the price break ranges, then click Lock or Update and follow the
procedure described in Creating Special Price Breaks for Your Customer, page 5-18.
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How Price Breaks Are Prorated
This topic explains how the application calculates prorated price breaks. This is
important for understanding how rounding errors can result in minor discrepancies in
how customers are charged using the prorated amounts.

Suppose, for example that the price breaks set up in the price list are based on quarterly
usage as shown in the following table:

Price Breaks

Units/Quarter Price per Unit

0-1000 $.05

1001-3000 $.04

3001-5000 $.03

5001-999999999 $.02

Now suppose, you extend the same price breaks to a customer billed based on monthly
usage by turning proration on.

Here is how the application calculates the monthly price breaks. It:

1. Divides the ranges by a third

2. Because the unit ranges must be whole numbers the application rounds off the
result. The following table shows the calculated ranges:

Calculated Ranges

Quarterly Ranges/3

0-333

333-1000

1000-1666

1666-333333333

3. Because the new ranges cannot overlap, the application adds 1 to the appropriate
lines to yield the final prorated price breaks listed in the following table:

Prorated Price Breaks

Units/Month Price per Unit

0-333 $.05

333-1000 $.04

1000-1666 $.03

1666-333333333 $.02
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Specifying a Billing Schedule for a Usage Line
You can bill a customer for usage at the usage line level.

If you have entered a billing schedule at the contract header level, then this schedule is
defaulted for you.

Prerequisite

Enter a usage line.

To specify a billing schedule for a usage line:
1. From the Service Contracts Authoring window, select the Lines tab and the

Pricing/Products subtab.

2. Select the service line to set up.

3. Click Billing.

The Billing window appears.

Top Level is selected as the Level.

4. Choose the appropriate accounting rule for invoicing from the Invoicing Rule
LOV. You must choose Arrears Invoice for the two usage types that charge
customers based on recorded counter values in a period: Actual Per Period and
Actual by Quantity.

5. Specify the billing schedule by entering one or more billing streams. This is the
same procedure as is used for creating schedules for service lines. See Entering a
Billing Stream, page 3-8 for details.

6. Click Schedule to generate the schedule.

7. Click OK.
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Recording Usage by Updating a Counter Reading
Counter values can also be captured in other Oracle E-Business Suite applications
including Oracle Depot Repair, Oracle Field Service, and Oracle TeleService.

To record customer usage by updating a counter reading:
1. From the Service Contracts Authoring window, select the Lines tab and Counters

subtab.

2. Select the usage line to update.

3. From the Actions menu, choose Counter Capture.

The Counter Capture Reading window appears.

4. Follow the Capturing Counter Reading procedure described in the Oracle Install
Base User Guide to enter your reading.

Note: If your application administrator has set the system profile
OKS: Counter Validate to Yes, then you must select the Valid Flag
check box if you wish the customer to be billed based on your
entry. If set to No, the application bills for the entry you make
whether or not you select this check box.
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6
Entering Subscription Lines

This chapter covers the following topics:

• Overview of Entering Subscription Lines

• About Subscriptions

• Entering a Subscription Line

• Specifying a Schedule of Product Shipments

• Adjusting the Subscription Price

• Viewing Pricing Details

• Specifying a Billing Schedule for Subscriptions

• Viewing the Shipment Status of a Subscription Order

Overview of Entering Subscription Lines
This group of topics explains how to enter subscriptions.

About Subscriptions
You can use Oracle Service Contracts to sell subscriptions for both tangible and
intangible items. Tangible items include magazines, collateral, or any other physical
item that can be shipped through Oracle Order Management. Intangible items can be
collateral sent via e-mail.

Note: While tangible items are fulfilled through Oracle Order
Management, the current release includes no fulfillment method
for intangible items. This must be set up individually by each
implementation.

Subscription lines differ from service and usage lines in the way they are entered:

• Service and usage lines require you to enter sublines, subscriptions do not.

To sell a service or usage, you enter the service or usage item as a contract line and
then enter sublines to specify what the service covers or the counters where the
usage is tracked. Subscriptions require you only enter the line.

• Subscriptions for tangible items require you set up a subscription schedule.
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A subscription schedule specifies when the application creates booked orders in
Oracle Order Management.

• The billing schedule invoices customers equal amounts in each billing period.

Just as for other contract lines, you must set up a billing schedule for invoicing
the customer, but you are restricted to billing the customer in equal amounts in
each period.

The application takes the total price and divides it equally among the invoices you
specify. It does not matter how many billing periods you set up, however. You can
invoice customers at the beginning of the subscription for the total amount, for
example, or have them pay in equal installments over the entire length of the
subscription.

How Subscription Items Are Set Up
The item you enter in a subscription line is an inventory item.

For tangible items, the inventory item is actually the product in inventory that is being
shipped out. For intangible subscriptions, the application administrator must set up a
new item in inventory representing the subscription itself.

What determines the inventory item is tangible or intangible is the attached subscription
template.

The item is tangible when fulfillment is done through Order Management. It is intangible
when fulfillment is done through a customized solution.

The subscription template also specifies the period for the subscription.

For a tangible item, the period is used for setting up the schedule for creating orders
in Oracle Order Management.

For an intangible item, the period is used as the unit of measure for the price for the
subscription. If the price of the subscription in the price list is $10 and the period in the
subscription template is a week. Then the subscription is priced at $10 per week.

Pricing and Credit for Tangible Subscriptions
When you enter a subscription line for a tangible item such as a magazine, you are
actually entering the very inventory item that is shipped to the customer. (The inventory
item becomes a subscription item with extra setup from the application administrator.)

The application calculates the price for the subscription period based on the price of the
item in the price list, not on the length of the subscription. Suppose, for example, that a
publisher of a monthly magazine publishes an issue every month except for December. A
customer purchasing a year’s subscription is charged not by the year but for purchasing
11 issues. If the magazine is priced at $3 per issue, then the customer pays 11 x $3
= $33. Customers that cancel the subscription before the year is over get credited on the
basis of any items they have not yet received. This means customers cancelling before
the November issue is shipped, get a credit of $3, customers who cancel after the issue is
shipped pay the full amount because they have received all of the issues for the year.

Your application administrator can set up price breaks based on the number of products
shipped, not on the length of the subscriptions or the quantity you enter in the line. For
example, if the application administrator at the monthly magazine publisher sets up
price breaks at 12 and 23 issues to give discounts to subscribers who purchase two- and
three-year subscriptions, then a customer who purchases two one-year subscriptions
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gets the same discount as the customer who purchases a one two-year subscription
because the number of items ordered by both is the same.

Pricing and Credit for Intangible Subscriptions
The price a customer pays for a contract line for an intangible subscription is based on
the subscription period length and quantity of subscriptions you enter.

The price of a subscription is based on the price for a specific period. (The price comes
from the price list and the period from the subscription template).

The period of a subscription becomes important for pricing partial periods and for
assigning credit for those partial periods when the customer terminates the subscription.

The price customers pay and the credit they receive for partial periods depends on the
period and the setting of the system profile OKS: Intangible Subscription Pricing Method.

The application administrator can set this profile to either Effectivity Based or
Subscription Pricing:

• Effectivity Based

The application charges and credits the customer for partial periods.

Suppose for example, that a customer subscribes to an online newsletter for a period
starting January 15, 2005 through February 1, 2006, a period that is 16 days longer
than one year.

If the service is priced at $30 per month, then the application charges the customer
$375.48: $360 for twelve months (12 x $30) and then $15.48 (16* $30/31) for the partial
last month in the contract, January 16 through February 1, 2006.

If the customer cancels on January 3, 2006, then the application issues a credit based
on the number of unused days, in this case: 29 days * $30/31 = $28.06.

• Subscription Pricing

The application charges the full amount for the period even if the subscription ends
in the middle of that period.

The same customer purchasing the subscription for one year and 16 days, is charged
$390 for 13 months ($360+$30).

If the customer cancels on January 3, 2006, the application issues a credit for one
month.

Billing Schedule Independent of Price Paid or Credit Given
The price the customer pays or the credit they receive is independent of the billing
schedule you set up for either tangible or intangible items. It does not matter if you set
up a billing schedule to invoice the customer for the full subscription duration at the
beginning of the subscription or invoice them monthly. The billing schedule just divides
the total price into however many billing periods you desire.

Selling Service on Subscription Lines
When you enter a subscription line, the application automatically creates an Oracle
Install Base item instance. This means that you can sell a service for the subscription by
entering a service line and covering the subscription at the covered product level. (You
must know its item instance number.)
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Each time Oracle Order Management ships one of the physical items, the application
also automatically creates a child item instance. This makes it possible for an agent to
identify a particular item for reorder, exchange, or credit.

To create the item instances, the application administrator must run the Service Contracts
Instance Relationship Program concurrent program after the order is fulfilled.

Entering a Subscription Line
Follow the references for details about any step.

Prerequisite

Create the contract with the Subscription Agreement category.

To enter a subscription line:
1. From the Service Contracts Authoring window, select the Lines tab and Accounts

subtab.

2. Choose Subscription from the Line Type LOV.

3. Choose the subscription item from the Name LOV.

The party accounts you selected on the Summary tab and Parties subtab appear as
the Bill to and Ship to accounts.

4. Optionally, enter billing and shipping contacts specific to this contract line by
following the procedure described in Entering Billing and Shipping Contacts for a
Contract Line, page 4-7. If a contact does not exist in the database, then you can add
one following the procedure described in Creating or Modifying a Contract, page 4-8.

The contacts you enter are different from the ones you entered in the contract header.

5. Select the Effectivities subtab.
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6. Specify the duration of the subscription.

By default, the start and end dates are copied from the start and end dates for the
contract.

You can specify different dates by entering either of the following:

• Start and end dates

• Duration and period

The application calculates the missing information. If you supply a duration and
period, then the start date is the start date of the contract.

Note: If the duration of the subscription starts earlier than the
start date or ends later than the end date of the contract, then
you must extend the start and end dates of the contract at the
header level before you can make the contract active.

7. Enter the number of subscriptions you are ordering in the Qty field.

8. If the contract can be renewed (you have not selected Do Not Renew on the
Summary tab and Renewals subtab), then specify how the line is to be renewed
using the Renewal Type LOV. The renewal options are the same for subscription
lines as they are for service, and usage lines. See Specifying How a Contract Line is
to Be Renewed, page 4-9.

9. If the subscription is for a physical item, then specify the schedule of orders placed
through Oracle Order Management by clicking Edit Schedule. See Specifying a
Schedule of Product Shipments, page 6-6.

10. The price of the subscription is calculated automatically by the application based on
the price list specified in the Price List field.

You can modify the price by choosing a different price list, by entering a new
price manually in the Pricing/Products subtab, or by using the price Adjustment
window. For details, see Adjusting the Subscription Price, page 6-9.
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11. Optionally, modify the text the customer sees on the invoice by editing the defaulted
text in the Invoice Text field.

12. Create a billing schedule. For details, see Specifying a Billing Schedule for
Subscriptions, page 6-10. Because the billing schedule for a subscription line is based
on the price of the line, you must recreate the billing schedule for a subscription
any time you modify the price.

13. Much of the rest of the information for the subscription line defaults from the
information you entered in the Summary tab. You can make modifications by
following these procedures:

• Changing the Billing and Shipping Accounts and Locations, page 4-7

• Entering Billing and Shipping Contacts for a Contract Line, page 4-7

• Specifying a Payment Method for a Contract Line, page 4-32

• Specifying Tax Status, page 4-40

• Assigning Sales Credits for a Contract Line, page 3-14

14. Save.

Specifying a Schedule of Product Shipments
You can specify a schedule of shipments for physical items in the subscription through
Oracle Order Management. The application books each order automatically on the date
you specify here. This is called the interface date. The order must still be picked and
shipped using Oracle Order Management, however.

Prerequisite

Enter a subscription line.

To specify a schedule of product shipments:
1. From the Service Contracts Authoring window, select the Line tab and the

Pricing/Products subtab.

2. Select the subscription line to set up.

3. Click Edit Schedule.

The subscription schedule window appears.
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4. By default, the application creates the order in Oracle Order Management on the
same date as the start date of each subscription period. This is called the interface
date.

To move the interface date, then enter a number in the Offset Days field. A negative
number creates the order before the start date. For example, entering -2 creates the
order 2 days before the start of each period.

5. Use the Schedule Pattern region to specify the shipping periods:

• To ship an item every period specified in the Frequency drop-down list, then
click OK. The application creates a shipping schedule automatically. If the
frequency specified is weekly, then the application schedules one item for
shipment ever week, if monthly, then every month and so on.

• If the subscription schedule is not regular, then you can specify the schedule you
want by entering multiple sets of regular periods.

1. Enter each set of regular periods on a separate line. For examples, see How to
Use Schedule Sets to Enter Complex Subscriptions, page 6-8.

Note: The fields available for entry are limited by the period
for the subscription. For example, if the period for the
subscription is a week, then you can only make entries in the
Week, Month, and Year fields.

You can use the following symbols for your entries:
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Symbol Meaning Examples

* All periods Entering a * in the Month
column means that an order
is created ever month.

- Indicates a range of periods Entering 1-3 in the Month
column means that an
order is created only in
January, February, and
March.

, Indicates a series of periods Entering 1,2,4 in the
Month column means that
an order is created only
in January, February, and
April.

2. When you are done, click Refresh Schedule to generate the schedule. If you are
not satisfied with the result, you can reenter the schedule and refresh again.

6. Click OK.

How to Use Schedule Sets to Enter Complex Subscriptions

The following two examples illustrate how you can use multiple schedule pattern
lines to handle complex subscription schedules.

In both cases the schedules are for a customer that purchases a one year subscription
for a tangible item from February 1, 2005 through January 31, 2006.

Example 1: A periodical that publishes every week except December when it
publishes only the first week

You can create this schedule by entering the following two lines:

Year Month Week

* 1-11 *

* 12 1

Example 2: A newsletter that publishes twice a month except in November and
December when it published only one issue at the beginning of the third week.

You can create this schedule by entering the following two lines:

Year Month Week

* 1-10 1,3

* 11-12 3

Note: For both of the above examples, the administrator must set up
the subscription template for the subscription item with a frequency
ofWeekly.
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Adjusting the Subscription Price
The application automatically prices a subscription based on the price list entered on
the Effectivities subtab.

You can modify the price either by changing the price list or entering a different price
manually on the Pricing/Products subtab.

Prerequisite

Enter a subscription line.

To adjust the subscription price:
1. From the Service Contracts Authoring window, select the subscription line.

2. Adjust the subscription price using any one of the three following methods:

• Changing the price list. To do so:

1. Select the Line tab and Effectivities subtab.

2. Select the subscription line you wish to reprice.

3. Choose a different price list form the Price LOV.

4. Select the Pricing/Products subtab.

5. Click Reprice.

The application recalculates the price based on the new price list.

• Entering a different price manually:

1. Select the Lines tab, Pricing/Products subtab.

2. Enter the modified price in the Subtotal field.

Note: Modifying the price manually may or may not be
permitted in your application implementation.

• Applying available discounts using the Adjustments window.

3. Save.

4. If you are repricing a line with an existing billing schedule, then you must recreate
the billing schedule for the new price. See Specifying a Billing Schedule , page 6-10.

Viewing Pricing Details
Prerequisite

Enter a subscription line for tangible items and create the subscription schedule.

To view the pricing details:
1. From the Service Contracts Authoring window, select the Line tab and the

Pricing/Products subtab.

2. Select the subscription line to view.

3. Click Price Calculation.
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The Price Calculation window appears.

It displays the quantity, list price, any adjustments made to the price, and the
extended price.

4. To view any price breaks the application administrator may have set up for this
item, then click Price Breaks.

Specifying a Billing Schedule for Subscriptions
You can specify a billing schedule for an individual subscription line in a contract or for
a multiple subscription lines in a contract at the same time.

Billing schedules for subscriptions are different from those you create for service or
usage lines:

• You must choose Equal Amount as the schedule level.

• You bill customers only at the line level. (There are no covered products as for
service lines and individual usage counters as for usage lines.)

• You can only bill the customer in equal amounts per period over the length of
a single billing stream.

If a market research company charges $1,200 for a one-year subscription to
a newsletter, for example, it can bill the customer the whole amount in one
invoice, invoice them $100 per month every month, invoice them $200 every other
month, or even invoice them at different intervals over the length of the subscription.

You can use multiple billing streams to invoice the customer at different intervals
over the length of the subscription with the amounts billed proportional to the
length of the billing interval. For example, the same market research company can
invoice the customer $100 every month for the first three months, and then send one
invoice for $300 every quarter (three months) for the remainder of the subscription
period. You can set up this scenario using the following two billing streams:

Stream Sequence
Number

Number of Periods Duration Period

1 3 1 Month

2 3 1 Quarter

Prerequisite

Enter a subscription line.

To specify a billing schedule for subscriptions:
1. To create the same schedule for multiple subscription lines within the same

contract, create a schedule at the header level.

From the Service Contracts Authoring window, select the Summary tab and the
Pricing/Products subtab.

2. To create a billing schedule for an individual subscription line:

1. From the Service Contracts Authoring window, select the Line tab and the
Pricing/Products subtab.
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2. Select the subscription line you wish to set up.

3. Click Billing.

The Billing window appears.

4. The invoicing and accounting rules are defaulted from those entered in the Summary
tab, Pricing/Billing subtab. If desired, you can choose different rules from the
Invoicing Rule and Accounting Rule LOVs.

5. For subscriptions, choose Equal Amount as the Billing Level.

6. Specify the billing schedule by entering one or more billing streams. This is the
same procedure as is used for creating schedules for service lines. See Entering a
Billing Stream, page 3-8 for details.

7. Click Schedule to generate the schedule.

8. If you are creating a schedule on the Summary tab, the application displays a
message warning you that you are about to replace any existing billing schedules at
the line level. Click OK.

The application divides the total price for the line equally for each billing period
within each billing stream.

Note: You can manually enter an amount in the Amount field before
clicking Schedule and have the application charge that amount each
period instead. In this case, the application automatically reconciles
any discrepancy with the total in the last billing period. The
customer is always billed for the same total amount.

9. Click OK to return to the authoring window.
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Viewing the Shipment Status of a Subscription Order
Use this procedure to view the Oracle Order Management shipment status for tangible
items ordered in a subscription line.

Prerequisite

Confirm the order has been created in Oracle Order Management.

To view the shipment status of a subscription order:
1. From the Service Contracts Authoring window, select the Lines tab and the

Effectivities subtab.

2. Click Edit Schedule.

The subscription schedule window appears. This window is named according to the
name of the subscription item.

The Interface Schedule region displays order numbers and status for any orders that
have been placed with Oracle Order Management.

3. To viewmore details about the order, including the date any shipment occurred, then
click the drill-down indicator on the left of the schedule line.

The Fulfillment History window displays details about the order.
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7
Ordering Service in Oracle Order

Management

This chapter covers the following topics:

• Overview of Ordering Service in Oracle Order Management

• About Ordering Service in Oracle Order Management

• Ordering Service in a Sales Order

• Adding Service Lines to an Existing Contract

• Specifying Renewal and Other Details for a New Contract Created for Your Order

• Running Concurrent Programs to Generate Contracts Automatically

• Reprocessing Orders that did not Create Contracts

• Viewing Created Contracts by Sales Order Number

• Viewing Contracts by Sales Order Number in Oracle Service Contracts

• Viewing Contracts by Sales Order in Oracle Install Base

• Modifying the Dates a Warranty Is Effective

• Changing Only the Dates a Warranty is Effective

• Changing Both the Warranty Dates and Installed Date

• Setting Up New Contract Defaults for Oracle Order Management

Overview of Ordering Service in Oracle Order Management
You can order service using Oracle Order Management and have the application create
the appropriate contracts automatically.

Your administrator can define the profile OKS: Category for Order Management
Originated Contracts, which determines the contract category for Order Management
originated contracts.

This group of topics covers both sales agent and application administrator procedures
for adding service agreements to a sales order, generating contracts automatically, and
troubleshooting any errors.

This group of topics covers only steps relating to service contracts. For detailed
information on how to create and manage orders, please see theOracle Order Management
User’s Guide.
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About Ordering Service in Oracle Order Management
This topic explains:

• Selling services in Oracle Order Management

• The contracts created from the order and when they are created

• Warranties that are created automatically when you order products

• The differences between creating service contracts from orders and from the Service
Contracts Authoring window

Selling Services in Oracle Order Management
You can sell service in an Oracle Order Management sales order just as you do any
physical product. However, there are a few differences.

Each service line must refer to either an item already in a customer’s installed base or
an item in an order (the item can be either in the same order or in a different order
altogether). For steps detailing how to add service lines, see Ordering Service in a Sales
Order, page 7-4.

For a service you must enter the service duration. If you are ordering service for an item
in an order, then you can have the application automatically calculate the start date of
that item based on the expiration of the warranty for that item. (You supply the duration
of the service but leave the start and end dates blank.)

The application does not supply a start date for an item a customer already
owns, however. If you are ordering service for an installed base item, you must enter the
start date manually, taking the length of any existing warranty into account.

What Contracts are Created from Your Order
By default, the application automatically creates a single contract for all the service lines
in your order. You can add renewal and contact information for the new contract using
the procedure outlined in Specifying Renewal and Other Details for a New Contract
Created for Your Order, page 7-8.

The contract becomes effective on the earliest start date and expires on the latest end date.

Suppose your order has the following three lines:

• Service 1: One year contract starting January 1, 2005

• Service 2: Two year contract starting February 1, 2005

• Service 3: Two year contract starting January 15, 2005

In this case the application creates a contract with a start date of January 1, 2005 and
an end date of January 31, 2007.

Alternately, by using the Contract Details window, you can instead choose to merge
the service lines in your order into an existing contract. See Adding Service Lines to
an Existing Contract, page 7-6.

When a Service Contract is Created
The application generates a new contract from the service lines in your order, or appends
the lines to an existing contract only when the item the service covers is entered into the
installed base. For tangible items this means the order must be booked, picked, and
shipped.

7-2 Oracle Service Contracts User Guide



To generate contracts from sales orders, your application administrator must also:

1. Run the Service Contracts Order Capture Integration, and Workflow Background
Process concurrent programs at regular intervals.

See Running Concurrent Programs to Generate Contracts Automatically, page 7-10.

2. Reprocess any contracts generated with errors. See Reprocessing Orders that did
not Create Contracts, page 7-11.

You can view the generated contracts by sales order number from within Oracle Service
Contracts or Oracle Install Base. See Viewing Created Contracts by Sales Order Number,
page 7-12.

Warranties
Warranties, which are offered to customers free of charge, are created by the application
automatically when the item is shipped to a customer based on an entry the application
administrator makes in the bill of materials (BOM).

Warranties go into effect on the shipment date. The administrator can add an automatic
delay to the warranty start date to account for the shipment or installation delay and
ensure the customer receives the full benefit of the warranty. You can specify a different
date for the warranty to become effective by following the procedure Modifying the
Dates a Warranty is Effective, page 7-13.

Selling Service Through Oracle Order Management vs. Oracle Service Contracts
If you have the application create a new contract from your order (rather than adding the
lines to an existing order), you should be aware of some key differences between the
contract created for you automatically and one you create in Oracle Service Contracts
application.

Contracts created in Oracle Order Management:

• Are restricted to service that covers products the customer owns (Oracle Install Base
item instances) or products the customer is in the process of buying (items in Oracle
Inventory). You cannot use them to sell service that covers larger sets of inventory
items, or to sell service at the system, site, or party levels.

• Are automatically created in the Active status.

• Do not have to pass the usual quality assurance check list and approval process as
contracts created in Oracle Service Contracts.

• Are billed through Oracle Order Management. This means that the customer is
billed in one invoice and you cannot take advantage of the flexible billing schedules
you set up in Oracle Service Contracts. (To add flexibility, you can instead set up
Payment Terms in Oracle Receivables to set up incremental billing over time.)

• Cannot have their coverage modified. Agents can only modify the coverage for
contracts created in Oracle Service Contracts.

For renewals, the contracts generated in Oracle Order Management become just like any
contract created in Oracle Service Contracts.

Ordering Service in Oracle Order Management 7-3



Ordering Service in a Sales Order
You can order service for an item a customer has on order or already owns. You can
use it to order service for:

• An item in the same order

• An item in a different order

• An item in the customer’s installed base

Prerequisites

• If you are ordering service for an item in a separate order, then you must know:

• That order’s number.

• The line number and shipment number for the item to cover.

• The date to start the service, taking into account any other existing service
agreements and warranties.

• If you are ordering service for an item the customer already owns, then the item
must be already entered in your customer’s installed base and you must know the
item instance number (referred to in Oracle Order Management as the Reference
Number) or its serial number.

The item instance number is automatically generated by the Oracle Install Base
application when the item is added to a customer’s installed base.

If the item does not exist in the customer’s installed base, you must create it using
procedures described in the Oracle Install Base User Guide.

To order service in a sales order:
1. Under the Order Management Super User responsibility, navigate to Orders, Returns

> Sales Orders.

The Sales Orders window appears.

Note: If you are tracking sales credits, and your organization is
using Oracle Service Contracts territories to assign sales agents to
service contracts, then the application does not use the sales agent
you enter in the Saleperson field on the Order tab, Main subtab to
the contract itself. If your organization is not using territories for
sales agent assignment, then the agent you enter is entered as a
vendor contact in the new contract.

2. If you are ordering a service agreement for an item in the same order, then enter
that item first.

3. In the Sales Order window, select the Line Items tab and the Main subtab.

4. Use the Ordered Item LOV to enter the inventory item number of the service you
are ordering.

5. Leave the Qty field blank. The application supplies the correct quantity
automatically:
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• If you are ordering service for a line in an order, then the application copies the
quantity from that line. For example, if you are ordering service for an order
line with 3 widgets, then the service quantity is 3.

• If you are ordering service for an item in the customer’s installed base.

Note: The quantity field specifies the number of services you
are ordering. It is not related to the length of the agreement
specified in the UOM (Unit of Measure) field. If you enter 5 as
the quantity and the UOM field shows YR (year), you are not
ordering one five-year contract.

6. Select the Services tab.

7. If the service is for an item either in this or another customer order, then:

1. Choose Order from the Service Reference Type LOV.

2. Use the Service Order Type LOV to enter the order type of the sales order. If
you are ordering service for an item in this order, then enter the same type you
entered in the Main tab of the Sales Order form.

3. In Service Ref Order Number, enter the number of the sales order. If you are
ordering service for an item in this order, then enter the sales order number that
appears in the title bar of the Sales Order window.

4. Use the Service Ref Line Number LOV to choose the line number and shipment
number. (The shipment number appears in the Service Ref Shipment Number
field).

Note: You must scroll to view all required fields.

8. If you are ordering service for an item the customer already owns, then:

1. Choose Customer Product from the Service Reference Type LOV.

2. Scroll to the Service Ref Cust Product field and use the LOV to enter the
customer product instance you wish to cover with the service. You can search
either by the Oracle Install Base instance number (labeled Reference Number in
this LOV) or, if the item is serialized, by the item’s serial number.

Note: The application automatically checks to see if the service
is valid for the item you have just entered. If the application
informs you that it is not, then you must go back and enter
another service.

9. To simplify renewals, a customer may end all contracts on a single day each year
(called the cotermination day). Selecting the Service Coterminate Flag check
box sets the end date to that day. If the application administrator has set up the
cotermination day for the customer, that entry overrides any end date you enter for
this agreement. See About Cotermination on page xx for more information.

10. Enter service dates and duration:

• If you are ordering service (an extended warranty) for an item in an order, you
can have the application automatically fill in the start and end dates by entering
the duration only. The application starts the service the day after any warranty
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for the product expires. The application fills in the dates only after the order is
fulfilled and the contracts are created.

• If you are ordering service for an installed base item, then enter either:

• The service start and end date: The application calculates the duration.

• The start date and duration: The application calculates the end date.

Note: If you selected the Service Coterminate Flag check
box, the application may override the end date you enter
here.

11. Save.

12. To add the services in the order to an existing contract or specify renewal information
for a new contract, click Actions and choose Service Contract Details from the
LOV. See Adding Service Lines to an Existing Contract, page 7-6 or Specifying
Renewal and Other Details for a New Contract Created for Your Order, page 7-8
for details.

13. Book the order.

14. If you have created a mixed order, then you must also pick and fulfill the order for a
new contract to be created or an existing contract to be modified.

15. You can view any new contracts created for the customer by following the procedure
described in Viewing Created Contracts by Sales Order Number, page 7-12.

Note: Contracts are created by concurrent processes set up by the
application administrator to run on a periodic basis, and so may not
be available for viewing immediately.

Adding Service Lines to an Existing Contract
By default, the application creates a new contract for the service lines in your order. You
can have an individual line, or all the lines in your order, added to an existing contract
instead. The destination contract must be:

• For the same customer.

• Active or signed.

• Be of the contract category specified by the application administrator in the profile
option OKS: Category for Order Management Originated Contracts.

Prerequisites

• Create your order first and open it in the Oracle Order Management Sales Order
window.

• Confirm the contract number.

To add service lines to an existing contract:
1. In the Sales Order window, select the service line to add to an existing contract. To

add all lines in the order to the same contract, then select the first service line in
the order.

Click Actions.
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2. Choose Service Contract Details.

The Contract Details window appears.

3. To apply all the rules selected in the Contract Details form to all the service lines, then
select the Apply All check box. Leaving this check box unselected, adds only the
current line.

If it is checked for one service line, you cannot check it for other service lines.

4. Use the Line Renewal Type list to specify how to renew the contract line:

• Do Not Renew: The line will not be renewed when the contract is renewed.

• Full Duration: The line will be renewed for the duration of the whole contract.

If your order includes multiple service lines, the contract duration begins on the
earliest start date and ends on the latest end date from all the lines.

• Keep Duration: The duration of this line will remain the same in a renewed
contract. Use this setting for intermittent or seasonal service lines. For example, a
mountain resort may wish to order special service for peak periods in winter
and summer. Using this setting you assure that the renewed contract retains the
same structure. See Seasonal or Peak Period Service.

5. Select the Existing radio button.

6. To restrict the choice of available contracts to those already entered in this order, then
select Order from the Type drop-down list.

7. Otherwise, select Contract. This displays all active (entered) contracts in the Contract
Number LOV.

8. Use the Contract Number LOV to enter the contract number.

Note: If a contract has been already renewed, then its number
appears more than once in the Contract Number column. In this
case, pay attention to entry in the Contract Number Modifier
column to choose the correct contract.
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9. To have all remaining service lines in the order added to the same contract, then
select the Apply All check box. This setting does not affect any service lines that
already have a contract specified for them.

Specifying Renewal and Other Details for a New Contract Created for Your
Order

You can choose to specify the information for a single service line or for all service
lines in the order. Your administrator can set up default renewal settings for different
customers or organizations within your enterprise. The entries you make here override
those defaults.

Prerequisite

Create your order and open it in the Oracle Order Management Sales Order window.

To specify renewal and other details for a new contract created for your order:
1. In the Sales Order window, select the service line for which you wish to create a

new contract. To have the information apply to the whole order, then select the
first service line.

Click Actions.

2. Choose Service Contract Details from the menu.

The Contract Details window appears.

3. If you plan to permit contract renewal, then use the Line Renewal Type list to specify
how to renew the current service line:

• Do Not Renew: The line will not be renewed when the contract is renewed.

• Full Duration: The line will be renewed for the whole duration of the contract.
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If your order includes multiple service lines, the contract duration is as long as
the length of the longest service line.

• Keep Duration: The duration of this line will remain the same in a renewed
contract. Use this setting for intermittent or seasonal service lines. For
example, a mountain resort may order special service for peak periods in winter
and summer. Using this setting you assure that the renewed contract retains
the same structure.

4. To add the information you enter here to all lines in the order, select the Apply
All check box.

5. Select the New radio button.

6. Select the Renewal type for the contract as a whole. The choices are:

• Active Contract: The application renews the contract automatically when it
expires and creates a new contract with the status set to Active.

• Do Not Renew: The contract does not renew. Choosing this setting supersedes
any setting you have made for the Line Renewal Type.

• Electronic Renewal: Automatically sends an e-mail asking the customer contact
you enter in the Quote To region of this window to renew the contract. The
e-mail includes a hyperlink the customer can use to access your organization’s
web site and renew the contract. Before choosing this option, verify that the
electronic renewal has been set up by your application administrator.

• Notify Salesrep: The application automatically sends a notification to the
Inbox of the sales representative associated with this contract. The application
determines the appropriate sales representative based either on sales territories
or, if the system profile OKS: Use Territories to Default Sales Person is set
to No, it notifies the sales representative specified in the system profile
OKS: Default Sales Person for Renewal.

• Submit For Approval: The application creates a renewed contract and the new
contract is submitted for approval to the person specified in the system profile
OKC: Contract Approver.

7. If a purchase order is required for the contract to be renewed, then select the PO
Required check box. This selection is available only for the Notify Salesrep and
Submit For Approval renewal options.

8. To specify a billing schedule for the renewed contract, then select a billing profile
using the Billing Profile LOV.

9. Specify how to price the renewed contract by making a selection from the Renewal
Pricing Type list in the Repricing Details region:

• Price List: Charges the customer based on the price list you enter in the Price
List field. The price charged is the current price listed in the price list at the
time the contract is renewed.

• Manual: The application charges the customer the same price for the renewed
contract as they paid for the original contract.

• Markup Percent: Automatically adjusts the price up or down by a percentage
you enter. Optionally, you can cap the maximum adjustment based on a price list.

10. If you have selected Markup Percent, then:
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1. Enter the percentage you wish the price to be adjusted. Entering a positive
number marks up the price. A negative number discounts the contract renewal.

2. If you are marking up the contract price and wish to put a limit on the maximum
price the customer will pay, then enter a price list in the Price List field. The price
of the renewed contract cannot go over the price listed in the price list.

For example, if you enter 20% as your markup and the current list price of the
service is $100, then the renewed contract is priced at $120. If you enter a price list
that lists the service at $110, however, then this price list caps the maximum price
for the service at $110. The customer pays a maximum of $110 for the renewal.

Note: The price cap works only for markups and not for
discounts.

11. If you have selected an electronic renewal, then, in the Quote to region, enter the
contact to be notified by e-mail:

Note: The contact must have an existing e-mail address. You cannot
add new addresses here.

1. Enter the contact using the Contact LOV.

2. If the contact has multiple e-mail addresses, then select the address where you
wish to send the notification.

Note: The application administrator must enter a return (From:)
e-mail address in the Global Contracts Defaults window as
described in Setting Up New Contract Defaults for Order , page
7-16.

12. Optionally, enter customer contacts for this contract in the Customer Contacts region.

13. Select the Apply All check box to have all of the remaining service lines in the order
added to the same contract. This setting does not affect any service lines that already
have a contract specified.

14. Save.

Running Concurrent Programs to Generate Contracts Automatically
You must run the following two concurrent programs to generate contracts from Oracle
Order Management sales orders:

• Service Contracts Order Capture Integration

• Workflow Background Process

For more information on running and troubleshooting concurrent programs see the
Oracle Applications User’s Guide.

To run concurrent programs to generate contracts automatically:
1. Under the Order Management Super User responsibility, choose Requests from the

View menu.

The Find Requests window appears.
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Click Submit a New Request.

The Submit a New Request window appears.

2. Select the Single Request radio button.

3. Click OK.

The Submit Request window appears.

4. In the Name field, enter Workflow Background Process and press the tab key.

The Parameters window appears.

5. Enter the following parameters:

Prompt Entry

Item Type OM Order Line

Process Deferred Yes

Process Timeout Yes

Process Stuck No

6. Click OK.

7. Click Submit.

8. Change responsibility to Service Contract Manager.

9. Submit the Service Contracts Order Capture Integration concurrent program
according to the steps outlined.

No parameters are required for this program.

Reprocessing Orders that did not Create Contracts
Prerequisite

Run the Workflow Background Process and Service Contracts Order Capture Integration
concurrent processes as described in Running Concurrent Programs to Generate
Contracts Automatically, page 7-10.

To reprocess orders that did not create contracts:
1. Navigate to Reprocess Order.

The Reprocess Order window appears.

2. Use the Query By Example in the View menu to query all errors:

1. From the View menu, select Query By Example > Enter.

2. Enter Error in the Status field.

3. From the View menu, select Query By Example > Run.

The window displays all errors.

3. Click Select All.
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4. Click Submit.

The application displays a note informing you of the process number.

Viewing Created Contracts by Sales Order Number
You can view the contracts generated by the application from your sales orders in either
Oracle Service Contracts or Oracle Install Base.

Viewing Contracts by Sales Order Number in Oracle Service Contracts

To view contracts by sales order number in Oracle Service Contracts:
1. Navigate to the Oracle Contracts navigator (Launch Contracts).

2. Click Search in the toolbar.

The Search Templates and Contracts window appears.

3. From the Category LOV, choose the contract category set in the profile OKS: Category
for Order Management Originated Contracts, for example Warranty and Extended
Warranty.

4. ClickMore.

The Service Module Search window appears.

5. Enter the order number using the Order Number field LOV.

6. Click OK to return to the Search Templates and Contracts window.

7. Click Search.

8. Select the warranty to display in the authoring window.

9. Right-click and choose Open from the pop-up menu.

Viewing Contracts by Sales Order in Oracle Install Base

To view contracts by sales order in Oracle Install Base:
1. Switch responsibility to Oracle Install Base User.

2. On the Navigator, double-click on Oracle Installed Base to launch Oracle Install Base
in a separate HTML window.

The Search Item Instances page appears in a separate browser window.

3. Select Sales Order Number from the Quick Find drop-down box.

4. Enter the Sales Order number.
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5. Click Go.

The application displays all of the instances included in the sales order.

6. Select an instance corresponding to the line in your order using the Select check box.

7. Select Contracts from the View Details drop-down list.

8. Click Go.

The application displays contracts that apply to that instance.

Modifying the Dates a Warranty Is Effective
Oracle Service Contracts calculates the start date of a warranty date by adding an
optional delay to the shipment date. The same date is also used by Oracle Install Base as
the installed date of the product.

The purpose of the delay, which the application administrator enters at the time the item
is created in Oracle Inventory, is to account for the time the item is in transit and being
installed. This ensures customers receive the full benefit of the warranty.

Your organization may instead specify the actual warranty start date to ensure that
customers are charged for all of the services they receive.

Note: Oracle Service Contracts does not allow a change in warranty
dates if a service request is opened during the period.

You can:

• Change the warranty start and end dates only, page 7-14
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Use this procedure for products, such as toasters or cameras, that do not require
installation or where the installed date is not important.

If a user changes the installed date in Oracle Install Base, the warranty does not get
updated automatically.

• Change the installed date and have the application adjust the warranty accordingly,
page 7-14.

Use this method if your organization records and tracks installed dates. When
you change the installed date in Oracle Install Base, Oracle Service Contracts
automatically adjusts the start date of the warranty for you. This method ensures
that installed date and warranty start date remain synchronized.

Note: For the installed date to automatically change the warranty
start date, the application administrator must check the Synchronize
Date Installed check box in the Warranty region of the Coverage
template. (You can check if this check box has been selected in any
warranty by clicking the Edit Coverage button on the Lines tab and
Effectivities subtab.)

Changing Only the Dates a Warranty is Effective
This procedure does not change the installed date for the item in Oracle Installed Base.

Prerequisites

• Confirm the order is processed and that a warranty is created by the concurrent
processes run by the administrator.

• Confirm the order number.

To change only the dates a warranty is effective:
1. Find the warranty by order number using the Search Templates and Contracts

window and display it in the Service Contracts Authoring window. See Viewing
Contracts by Sales Order Number in Oracle Service Contracts, page 7-12.

2. Choose Cascade Attribute from the Actions menu.

The Cascade Attributes window appears.

3. Enter the new dates for the warranty in the Effective Dates fields in the Header
Attributes region.

4. Select the Effective Dates check box.

5. Check to make sure Header to Lines is selected for Cascade.

6. Click Submit.

The Transaction Log appears.

7. Click Apply.

Changing Both the Warranty Dates and Installed Date
Prerequisite

• Confirm a warranty has been created before you modify the installed date.
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• Confirm the order number.

To both the warranty dates and installed date:
1. Switch responsibility to Oracle Install Base User.

2. On the Navigator, double-click on Oracle Installed Base to launch Oracle Install Base
in a separate HTML window.

The Search Item Instances page appears in a separate browser window.

3. Select Sales Order Number from the Quick Find drop-down box.

4. Enter the Sales Order number.

5. Click Go.

The application displays all of the instances created from the sales order.

6. Click on the description of the instance you wish to modify.

The Item Instance page appears.

7. Scroll down to the Installed At region and enter a date in the Installed Date field.
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8. Save.

Setting Up New Contract Defaults for Oracle Order Management
Application administrators must use this procedure to enter information required to
create new contracts from orders in Oracle Order Management. This information is
required for contracts to be created successfully and is not entered by the agent in the
order.

You can also default renewal information for these contracts, see Specifying How a
Contract Will Be Renewed, page 4-9.

To set up new contract defaults for Oracle Order Management:
1. Under the Service Contracts Manager responsibility, navigate to Setup > Contract >

Global Contracts Defaults.

The Global Contracts Default window appears.

2. In the Global region, the upper half of the window, make the following entries:

1. Use the Contract Group LOV to enter the contract group under which the new
contracts appear in the contracts navigator.

2. Use the QA Checklist LOV to choose the checklist used to test contract
completeness before the contract can become active.

3. Use the Approval Workflow LOV to choose the Oracle Workflow process used
to approve contracts.

4. Use the Help Desk LOV to choose the return e-mail address for electronic
renewals. This address appears on the From: field of the e-mail notification
sent to customers.

5. Use the Role LOV to enter Third Party. This entry is used to define the party
role when the sold-to party is not the same as the ship to party for contracts
created from Oracle Order Management.

6. Select the Interface Price Break check box if you want price break details to be
sent to Oracle Receivables during billing. This includes quantity, unit price, and
amount.

7. Use the Credit Amount LOV to choose what credit a customer receives if service
is terminated. The options are:

• Full: The customer receives full credit.

• Calculate: The credit is prorated based on the Date Terminated.

• None: The customer does not receive credit.

3. Save.
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8
Adjusting Prices

This chapter covers the following topics:

• Overview of Adjusting Prices

• Entering Price Adjustments

• Getting Help in Picking Adjustments

• Viewing Total Adjustment Amounts

• Viewing Adjustments for the Whole Contract

• Viewing The Total Adjustments for An Individual Line or Subline

• Reverting to the Original Price List Price

• Cascading Service Price

Overview of Adjusting Prices
This group of topics explains how you can adjust prices of service, subscription, and
usage lines in your contract by applying adjustments set up by the application
administrator.

Use the procedures in this group of topics to adjust prices for service lines that are
automatically priced by the application based on a price list you have entered. The
pricing of other lines are based on an agreement between the agent and a customer, so
they should already include any discounts.

Contract lines that the application prices based on the price list include:

• Usage lines of all types except Negotiated Price.

You manually enter a price for Negotiated Price lines, so you must change that price
directly to reflect any additional discounts.

• Service lines for Item and Product levels.

Service lines covering Customers, Sites, Parties, and Systems are also priced
manually.

• Subscription lines.

If your contract includes a mix of lines priced on the price list and priced manually, and
you decide to adjust the price at the contract level, then the adjustments you enter apply
only to those lines that are priced based on the price list.
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About Price Adjustments
Using Oracle Advanced Pricing application administrators can set up discounts or
surcharges (called price modifiers) for the services, usage contracts, and subscriptions
you sell in Oracle Service Contracts. The price modifiers provide adjustments either
in percentages or in currency amounts.

The modifiers can be of two types:

• Automatic price adjustments. The application automatically applies the discount
or surcharge if the customer qualifies. For example, a company may choose to give
an automatic 15% discount to all existing customers.

• Price adjustments you can select manually while authoring a contract. For
example, you can choose to offer a customer 10%, 15%, or 20% off the list price.

The administrator can set up either type of adjustment so that you can change the
amount of the discount manually. You can identify this type of modifier by the Y value
in the Update Allowed field. If you are applying an adjustment manually, this field
appears in the Modifier Number LOV.

If the administrator has set up such a modifier to apply to the line automatically, then
you are permitted to enter an entirely new price for the contract line. You can do so
either in the line itself or in the price Adjustment window itself.

Different Levels of Discounts

The administrator can set up different price adjustments to apply at the contract, line, and
subline levels. For example, a copier manufacturer may offer a 10% discount on a
particular service and a 15% sale for all customers purchasing service contracts worth
$1,000 or more (contract-level discount).

Price adjustments applied at different levels are cumulative and are applied against
the price list price.

Suppose a customer purchases a service contract with a list price of $1000 and receives
the following two levels of discounts:

• An automatic 10% preferred customer discount at the contract level

• A 15% discount at the line level because of a promotion on the specific service they
are purchasing

The resulting price is $750 ($1000 - $100 - $150).

The application deducts any currency adjustments after the percentage adjustments are
made. If an agent entered -$30 in the above example, then the final price the customer
pays is $750 - $30= $720.

Adjustment Methods
There are two ways you can adjust prices:

• Change the price list and reprice the line or contract. (This method is discussed in
the chapters describing how you enter contract lines).

• Choose price adjustments using the Adjustments window.

• Directly override the price.

Optionally, you can enter any information that may help a customer qualify for an
adjustment and let the application suggest valid adjustments for you.
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For example, you can use this method to find out what discounts are available for a
customer who calls Support. Or perhaps the customer wants the same discounts
as a colleague from another company.

Entering Price Adjustments
You can enter price adjustments (discounts or surcharges). You can only adjust prices on
lines that have been priced using the price list.

You can have the application suggest appropriate adjustments for contract lines by first
entering qualifying information. See Getting Help in Picking Adjustments, page 8-4.

To enter price adjustments:
1. Indicate the level where you wish to apply or review adjustments:

• Header: Select the Summary tab.

• Line: Select the Lines tab, the Effectivities subtab, and the line you want to adjust.

• Subline: Select the Lines tab, the Pricing/Products subtab, the line, and the
subline you want to adjust.

2. Choose Pricing Adjustment from the Tools menu.

The Adjustment window appears listing any discounts that have been applied at
this level.

Note: Remember that, although adjustments are cumulative,
adjustments at one level do not show up in the windows at other
levels.

The heading at the top of the window indicates whether you are
adjusting the price at the header or line level.

Note: The Adjustment window interface does not distinguish
between line and sublines adjustments. It views them all as lines. If

Adjusting Prices 8-3



you are adjusting prices at the subline level, then the Line Number
field actually refers to the subline number and the Level field lists
Line as your adjustment level although you are adjusting the subline.

3. Choose any additional price adjustments using the Modifier Number LOV. A DLT in
the Modifier Type field indicates a discount; SLT indicates a surcharge.

4. If the modifier you selected can be updated manually (Y appears in the Manual
Override field in the LOV), then you can enter either:

• Percentage adjustment in the Rate field.

• Currency amount adjustment in the Price Reduction field.

Whether the modifier permits you to enter an amount or percentage adjustment
depends on the way it has been set up by the administrator.

For a discount, entering a positive number reduces the price. Entering a negative
number applies a surcharge.

5. Enter any reasons for the adjustment on the Reason tab.

6. To apply the adjustments you have chosen, click Save and Reprice. Save saves
your choice but does not reprice.

The billing schedule automatically reflects the new prices.

Getting Help in Picking Adjustments
You can enter qualifying information that permits the application to suggest appropriate
adjustments for your customer. This feature is available only at the line level.

Prerequisite

Confirm the qualifying information used in your application. You can contact your
application administrator for more information.

To get help in picking adjustments:
1. Select the Lines tab, the Effectivities subtab, and the line you want to adjust.

2. Choose Pricing Qualifier from the Tools menu.

The Qualifiers window appears listing any qualifiers entered previously.
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3. Enter the qualifying information.

For example, to see if a customer with orders between $1000 and $2000 qualifies for
discounts, you might choose Volume as the context, Order Amount as the attribute
and enter a range of 1000 and 2000 in the value fields.

4. Save and close the window.

The qualifying information you have entered is now used by the application to:

• Apply any automatic price adjustments the customer is entitled to based on the
information you entered. The information is sent whenever the pricing call
occurs, for example, when you save the line or reprice.

• Filter the price adjustments (modifiers) listed in the Modifier Number LOV.

You are now ready to choose any manual price adjustments using the procedure
describe in Entering Price Adjustments, page 8-3.

Viewing Total Adjustment Amounts
You can view the total adjustment amounts for:

• The whole contract

• An individual line or subline

Viewing the totals does not tell you what specific adjustments were applied or at what
level. To view the sources of adjustments you must open the Adjustment window at all
the different levels. See Entering Price Adjustments, page 8-3 for details.

Viewing Adjustments for the Whole Contract
For the contract as a whole, by selecting the Summary tab and Pricing/Billing subtab. The
total adjustments appear in the Adjustments region:
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Viewing The Total Adjustments for An Individual Line or Subline
You can view the total price adjustment for a line and subline.

To view the total adjustments for an individual line or subline:
1. Select the Lines tab and Pricing Products subtab.

2. Select the line (and optionally the subline) you wish to view.

The Pricing Calculation button is only active for lines that have no sublines such
as subscriptions.

3. Select the Pricing secondary tab.

4. Click Pricing Calculation.

The total adjustments for the line and subline display in the Pricing Calculation
window.

You can review the details related to the Covered Level:

• List price

• Quantity

• UOM

• Extended Amount

In addition, you can review the details related to the Top Line level:

• List price

• Operator: represents how the service is priced (amount based or percentage
based).

• Quantity

• UOM

• Adjusted Price: reflects the adjusted price if modifiers have been applied.

• Extended amount

• Status Text: represents the status of the pricing, such as Success.

Reverting to the Original Price List Price
You can remove any adjustments you have made and revert an adjusted price of a line or
subline to the price listed on the price list. This removes the adjustments you have added
manually, by calling the pricing application for the most up-to-date price on the price
list, along with any automatic modifiers.

To revert to the original list price:
1. Remove price adjustments at any of the three levels:

• For a line (This removes all subline adjustments.):

1. Select the Lines tab and Pricing/Products subtab.

2. Select the line you wish to change.
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3. Click Reprice on the Pricing/Products subtab.

• For a single subline:

1. Select the Lines tab and Pricing/Products subtab.

2. Select the line and subline you wish to change.

3. Click Reprice on the Pricing secondary tab.

1. The entire contract:

1. Select the Summary tab and Pricing/Billing subtab

2. Click Reprice.

The reprice Decision dialog box appears.

• Choose one of the two repricing methods:

• To remove the adjustments for the entire contract and return the prices to those
listed in the price list attached to each contract line, then click Reprice Only.

• To remove the adjustments for the entire contract and reprice the entire contract
based on the price list entered in the Price List field of the Pricing/Billing
subtab, then click Cascade and Reprice.

The Repricing results window appears.

2. If all lines are repriced successfully, then click Apply to make the changes. If some
lines fail and show a severity of Error or Unexpected Error, the Apply button is
disabled. In this case, you must correct the error before attempting to reprice.

Cascading Service Price
You can access the Cascade Service Price window from the Actions menu and use it to
cascade the service line price to the covered level prices at the same proportions. For
example in the following table, the current service line price is $2,000 and in this
case, the percentage of the service price applied to lines L1 and L2 is 75% and 25%
respectively. The same proportions are cascaded to the lines if $4,000 is applied.

Current New

S1 $2000 $4000

L1 $1500 $3000

L2 $500 $1000

To cascade the service price:
1. Select the contract line to which you want to make a price change.

2. From the Authoring window navigate to Actions > Cascade Service Price.

3. Review Service, Start Date, End Date, and Current Price fields. These are
display-only fields.

4. Enter the New Price that is to be allocated across the sublines.

5. Click Apply to save. The new price is cascaded in the appropriate proportions to the
final price of each covered level.
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Refresh the billing schedule to reflect the new values.
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9
Running Quality Assurance Results and

Troubleshooting

This chapter covers the following topics:

• About the Quality Assurance Check (QA Check)

• Running the Quality Assurance Check from the Actions Menu

• Submitting the Contract for Approval from the Actions Menu

• Running the Quality Assurance Check from the (Summary) Administration Subtab

• Running the Contracts QA Program

• Troubleshooting Errors

About the Quality Assurance Check (QA Check)
This group of topics explains how to use quality assurance results to troubleshoot issues
within your contract.

The QA Check is an automated process that verifies the validity of a contract.

A default QA checklist is seeded in the application. However, if required, the default QA
checklist may be modified to include other checks. The default is set with the profile
option OKS: Default QA Checklist. You can override the default checklist from the
Summary Administration tab of the Service Contracts Authoring form.

A QA checklist consists of one or more processes that are defined in the Process
Definitions form prior to selecting them for the QA checklist.

A process within the QA checklist can be defined with two severity levels, error and
warning. Errors must be corrected before submitting the contract for approval.

You can launch the QA checklist as follows:

• Actions menu: Launching the QA checklist from the Actions menu shows the
results for an individual contract immediately in the Quality Assurance Results
window, but does not submit the contract to the Approval workflow. See Running
the Quality Assurance Check from the Actions Menu, page 9-2.

• Actions menu: Submitting the contract for approval runs the QA check and shows
the results immediately in the Quality Assurance Results window, and allows you
to submit the contract to the Approval workflow. See Submitting the for Approval
from the Actions Menu, page 9-3.
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• Summary Administration subtab: Launching the QA checklist from the Summary
Administration subtab shows the results for an individual contract immediately in
the Quality Assurance Results window, and allows you to submit the contract to the
Approval workflow. See Running the Quality Assurance Check from the (Summary)
Administration Subtab, page 9-4.

• Contracts QA Report concurrent program: Launching the QA checklist from the
Contracts QA Report allows you to run a QA check on multiple contracts. The
process produces a report listing the results of each contract. This process can
optionally launch the approval workflow after the QA is complete. See Running
the Contracts QA Program, page 9-5.

Note: After the QA Results appear you must fix the errors. For
a listing of errors and the corrective actions see Troubleshooting
Errors, page 9-6.

Running the Quality Assurance Check from the Actions Menu

To run the Quality Assurance Check from the Actions menu:
1. From the Service Contracts Authoring window, choose the Actions menu and select

Check QA.

The Quality Assurance Results window appears.

Note: The Continue Approval box is not active. If you would like
to continue with the approval process from the QA check, then you
will need to submit the contract for approval from the Summary
Administration tab.

2. Verify the following:

• Contract Number

• Default QA Checklist

• Results
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For information on fixing errors, see Troubleshooting Errors, page 9-6.

Note: You can change the default QA checklist by selecting a
different checklist from the Default QA Checklist LOV within
the Summary tab and Administration subtab tab. After making
the change, you must select the Check QA action again.

Submitting the Contract for Approval from the Actions Menu

To submit the contract for approval from the Actions menu:
1. From the Service Contracts Authoring window, choose the Actions menu and select

Submit for Approval.

The Quality Assurance Results window appears.

Note: If errors appear in the results, the Continue Approval box is
not active. If you would like to continue with the approval process
you must fix the errors and resubmit the contract.

2. Verify the following:

• Contract Number

• Default QA Checklist

• Results

For information on fixing errors, see Troubleshooting Errors, page 9-6.

3. If all results indicate Success, select Continue Approval to submit the contract to
the approval workflow.

If there are warning messages, you can review the messages and determine if the
issues should be fixed. If you determine that they do not need to be fixed, you can
choose to ignore them.
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Note: You can change the default QA checklist by selecting a
different checklist from the Default QA Checklist LOV within the
Summary Administration tab. After making the change, you must
select the Submit for Approval action again.

Running the Quality Assurance Check from the (Summary) Administration
Subtab

To run the Quality Assurance Check from the (Summary) Administration subtab:
1. From the Service Contracts Authoring window, select the Summary tab and the

Administration subtab. Select Submit.

The Quality Assurance Results window appears.

Note: If errors appear in the results, the Continue Approval box is
not active. If you would like to continue with the approval process
you must fix the errors and resubmit the contract.
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2. Verify the following:

• Contract Number

• Default QA Checklist

• Results

For information on fixing errors, see Troubleshooting Errors, page 9-6.

3. If all results indicate Success, select Continue Approval to submit the contract to
the approval workflow.

If there are warning messages, you can review the messages and determine if the
issues should be fixed. If you determine that they do not need to be fixed, you can
choose to ignore them.

Note: You can change the default QA checklist by selecting a
different checklist from the Default QA Checklist LOV within the
Summary Administration tab. After making the change, you must
select Submit again.

Running the Contracts QA Program
This report allows you to run a QA check on multiple contracts. This is particularly
useful when run immediately before the billing process to help identify issues on
contracts before they are submitted to Accounts Receivable.

Use this option for very large contracts, when you do not wish to wait for the entire
QA process to complete.

To run the contracts QA program:
1. From the View menu, select Requests.

The Find Request window appears.

2. Select Submit a New Request.
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The Submit a New Request window appears.

3. Select the Single Request radio button and click OK.

The Submit Request window appears.

4. From the Name LOV, select Contracts QA Report and click OK.

The parameters window appears.

5. Set the following parameters as required:

• From Contract Number (required)

• To Contract Number

• From Start Date (required)

Note: When running the report, the From Start Date and To
Start Date will both default to the current date. If your contracts
start prior to this date, you will not see a report. Be sure to
check your start dates.

• To Start Date

• Contract Status

• Level of Details (required)

You can choose a report that details all contracts selected, all contracts that pass
the QA check, or all contracts that fail the QA check.

• Submit for Approval: If this parameter is set to Yes, the contract is automatically
submitted for approval if it passes QA.

• Ignore QAWarning: If this parameter is set to Yes, QA warnings are ignored

6. Click OK.

The Submit Request window appears with a concatenated listing of the parameters.

7. Select Submit.

A Decision window appears with the request id. You should make a note of this id.

8. Click No.

The Find Request window appears. You can use this window to track your request.

9. Verify the View All My Request radio button is selected, and click Find.

The Request window appears.

10. After your request is completed, you can view the details by selecting View Output.

Troubleshooting Errors
After you run the QA Check, you must review the Quality Assurance Results
window. The results show any errors or warnings associated with the contract.

Following is a list of errors and a list of warnings that may appear in the Quality
Assurance Results window.
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Error Messages
You must correct all errors listed in the Quality Assurance Results. Error messages will
prevent you from passing the QA check and submitting the contract for approval.

Error Messages Summary

Process Name Error Message What does this error
message mean and how
can I x it?

Check Address Bill to address is required on
top line number Line 1.

This message validates the
following: a bill to address
exists for service, usage and
extended warranty lines.
It occurs when: the bill
to address is missing on
service, usage or extended
warranty lines.
To fix the error: add a bill
to account that has a billing
address on the reported line.

Check Address Bill to address is invalid on top
line number 1

This message validates the
following: if bill to address is
active for service, usage and
extended warranty lines.
It occurs when: bill to address
is not active on service, usage
or extended warranty lines.
To fix the error: change the bill
to address on the reported line.

Check Address Bill to address is invalid at
header level

This message validates the
following: if bill to address is
active at the header.
It occurs when: bill to address
is not active on header.
To fix the error: change the bill
to address at the header level.

Check Address Subscription line 1 should
have a ship to address.

This message validates the
following: if ship to address
exists for subscription line.
It occurswhen: ship to address
is missing on subscription line.
To fix the error: add a ship to
account that has a shipping
address on the reported line.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Address Ship to address is invalid on
top line number Line 1.

This message validates the
following: if ship to address
is active for service, usage and
extended warranty lines.
It occurswhen: ship to address
is not active on service, usage
or extended warranty lines.
To fix the error: change the
ship to address on the reported
line.

Check Address Ship to address is invalid at
header level

This message validates the
following: checks if ship to
address is active at the header.
It occurswhen: ship to address
is not active on header.
To fix the error: change the
ship to address at the header
level.

Check Billing Schedule Top line Line 1 Stream Level
should be entered.

This message validates the
following: checks the Stream
Level Line of the top line
billing schedule.
It occurs when: top line
Stream Level Line has not been
entered.
To fix the error: enter the
Stream Level Line of the top
line billing schedule.

Check Billing Schedule Line 1 billing schedule should
be entered.

This message validates the
following: the top line level
elements.
It occurs when: the level
elements are missing.
To fix the error: enter the level
elements for the reported line.

Check Billing Schedule Sub line SLL period not same
as bill schedule period.

This message validates the
following: reports an error
if for Equal Amount and
Covered level billing type the
top line period is not the same
as the sum of level elements.
It occurs when: the top line
period is not the same as the
sum of level elements for Equal
Amount and Covered level
billing type.
To fix the error: change the
Stream Level Line period on
the reported line.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Billing Schedule For Line 1 there is a mismatch
between line amount and total
billing schedule amount (sum
of level elements).

This message validates the
following: for Equal Amount
billing type there should not
be a mismatch between line
amount and billing schedule
amount.
It occurs when: the billing
type is Equal Amount and the
line amount is different than
the billing schedule amount.
To fix the error: change the
billing schedule amount on the
reported line.

Check Billing Schedule Line 1 Stream level effectivities
should be within line
effectivities

This message validates the
following: reports an error if
billing cycle end date is less
than top line end date or billing
cycle start date is not equal to
top line start date.
It occurs when: billing cycle
end date is less than top line
end date or when billing cycle
start date is not equal to top
line start date.
To fix the error: change the
billing cycle end date if it is
less than top line end date or
change the billing cycle start
date if it is not the same as top
line start date.

Check Billing Schedule Line 1 Stream level effectivities
should be within line
effectivities.

This message validates the
following: if billing type is
Equal Amount or Covered
Level then billing cycle end
date should not be greater than
top line end date.
It occurs when: billing type
is Equal Amount or Covered
Level and billing cycle end
date is greater than top line
end date.
To fix the error: Make the
billing cycle end date equal to
top line end date or change the
billing type to Top Level.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Billing Schedule Subscription line 1 with final
price can not be less than billed
amount.

This message validates the
following: reports an error for
subscription line if negotiated
price is less than billed amount.
It occurs when: negotiated
price is less than billed amount
in a subscription line.
To fix the error: change
the negotiated price on the
reported line.

Check Billing Schedule Sub line billing flag should be
same as top line billing flag.

This message validates the
following: subline billing type
should be the same as top line
billing type.
It occurs when: subline billing
type is different from top line
billing type.
To fix the error: make both
subline and top line billing
type the same.

Check Billing Schedule Start date and end date of sub
line should be same as top line
in equal amount.

This message validates the
following: start date and end
date of sub line should be same
as top line in Equal Amount.
It occurs when: start date or
end date of the sub line is not
the same as the top line for
Equal Amount billing type.
To fix the error: change the
start date and/or end date of
the reported subline or top
line.

Check Billing Schedule Sub line 1 Stream Level Line
should be entered.

This message validates the
following: reports an error if
subline stream level line is not
found.
It occurs when: sub line
stream level line is not found.
To fix the error: enter the
stream level line on the
reported subline billing
schedule.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Billing Schedule Line 1 billing schedule should
be entered.

This message validates the
following: reports an error if
level element (billing schedule)
is not found in the sub line.
It occurs when: level element
is not found in the subline.
To fix the error: enter the
level element on the reported
subline.

Check Billing Schedule Sub line 1 SLL period 1 not
same as bill schedule period 1.

This message validates the
following: reports an error
if for Equal Amount and
Covered level billing type the
sub line billing period is not
the same as the sum of level
elements.
It occurs when: billing type
is Equal Amount or Covered
level and the sub line billing
period is not the same as the
sum of level elements.
To fix the error: fix the stream
level line period for the
reported sub line.

Check Billing Schedule Sub line 1 Product final price
not same as total bill schedule
amount.

This message validates the
following: subline level
element total should be equal
to sub line price negotiated.
It occurs when: covered line’s
billing schedule amount is not
equal to the covered line’s price
negotiated.
To fix the error: change the
covered line’s billing schedule
amount.

Check Billing Schedule Sub line 1 Product final price
can not less than billed amount.

This message validates the
following: subline final price
cannot be less than billed
amount.
It occurs when: subline final
price is less than billed amount.
To fix the error: make the final
price equal or greater than the
billed amount.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Billing Schedule Subline 1 SLL effectivities
should be within sub line
effectivities.

This message validates the
following: checks for Product
billing cycle end date equal
to lines end date for Equal
Amount and Covered Level
billing type
This check is not done for Top
level billing type because the
stream level line end date in
that case might go beyond the
line end date.
It occurs when: billing type is
Equal Amount and Covered
Level and product billing cycle
end date is not equal to lines
end date.
To fix the error: change the
billing cycle end date.

Check Billing Schedule Subline 1 SLL effectivities
should be within sub line
effectivities.

This message validates the
following: For Top Level
billing type the billing cycle
start date and subline start
date should be the same.
It occurs when: billing type is
Top Level and subline billing
cycle start date is not equal to
sub line start date.
To fix the error: change the sub
line billing cycle start date to
the subline start date.

Check Covered Levels OKS Please enter a value for
Covered Level Name in
contract line 1.

This message validates the
following: if a covered level is
entered.
It occurs when: covered level
is missing.
To fix the error: enter the
covered level.

Check Covered Levels OKS Please enter a value for Final
Price in contract line 1.

This message validates the
following: negotiated amount
at covered levels is required.
It occurs when: negotiated
amount is missing from
covered levels.
To fix the error: enter a
negotiated amount at covered
levels.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Covered Levels OKS Please enter a value for Sales
Quota in contract line 1.

This message validates the
following: sales credits must
be is defined for the line.
It occurs when: sales credits
have not been defined for the
line.
To fix the error: enter sales
credits for the lines.

Check Covered Product
Quantity

Item instance item 1 for line 1
is not found in installedbase.

This message validates the
following: checks if the item
instance is in installed base.
It occurs when: the item is not
found in installed base.
To fix the error: select a new
product.

Check Covered Product
Quantity

Covered product quantity and
unit of measure on line 1 does
notmatch the quantity and unit
of measure in installedbase.

This message validates the
following: checks the covered
product quantity and unit of
measure against the quantity
and unit ofmeasure in installed
base.
It occurs when: the covered
product quantity and unit of
measure is different than the
quantity and unit of measure
in installed base.
To fix the error: select a
different product from the
installed base or update the
product quantity.

Check Covered Product
Quantity

Covered product quantity on
line 1 does not match quantity
in installedbase.

This message validates the
following: checks the covered
product quantity against the
quantity in installed base.
It occurs when: the covered
product quantity is different
than the quantity in installed
base.
To fix the error: select a
different product from the
installed base or update the
product quantity.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Covered Product
Quantity

Covered product unit of
measure on line 1 does not
match the value stored in
installedbase.

This message validates the
following: checks the covered
product unit of measure
against the unit of measure in
the installed base.
It occurs when: the covered
product unit of measure is
different than the unit of
measure in installed base.
To fix the error: select a
different product from the
installed base or update the
unit of measure

Check Customer Availability Bill to customer account is
inactive on line number 1.

This message validates the
following: checks if bill to
customer account is active.
It occurs when: bill to
customer account is not active.
To fix the error: change the bill
to customer on the reported
line.

Check Customer Availability There is no customer in the
contract. Please define a party
with the role of customer for
the contract.

This message validates the
following: checks if the
contract header has a customer
or third party.
It occurs when: the contract
header has no customer or
third party.
Tofix the error: add a customer
or subscriber or third party to
the contract.

Check Customer Availability At least one bill to account
on the contract lines belongs
to Account 1. The Customer/
Third party on the contract
header is not related to this
account.

This message validates the
following: checks if the
customer account stored in
the contract lines belongs to
the customer, third party or
related customer.
It occurs when: customer
account stored on the contract
top line does not belong to
the customer, third party or
related customer.
To fix the error: change the
customer account on the
reported line.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Item Instance Is Valid Service line 1 is covering an
invalid subscription product.

This message validates
the following: checks if
the subscription item being
covered belongs to an active/
signed contract.
It occurs when: a subscription
item being covered as a
covered product in contract
A belongs to contract B but
contract B is not active or
signed.
To fix the error: select another
subscription item or make
contract B active.

Check Product Availability Service 1 is not available for
product 1.

This message validates the
following: if line status is
Entered then it checks if
service is available for the
covered product or item.
It occurs when: line status
is Entered and service is not
available for the covered
product or item.
To fix the error: select another
covered product or item.

Check Required Values QA Check list is required for
contract header 1.

This message validates the
following: the contract has a
QA check list.
It occurs when: a QA check
list has not been selected for a
contract.
To fix the error: select a
QA check list from the
Administration subtab.

Check Required Values Only one party role, may be
attached to the contract.

This message validates
the following: Only one
CUSTOMER/SUBSCRIBER
may be attached to a contract.
It occurs when: the contract
has more than one party of role
type customer/subscriber.
To fix the error: verify that
you have only one customer/
subscriber.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Required Values Only one party role, may be
attached to the contract.

This message validates
the following: Only one
VENDOR/MERCHANT may
be attached to a contract.
It occurs when: the contract
has more than one party of role
type vendor/merchant.
To fix the error: verify that
you have only one vendor/
merchant.

Check Required Values Short description is required
for contract header 1.

This message validates the
following: a short description
is in contract header.
It occurs when: you do not
have a short description on the
contract header.
To fix the error: add a short
description.

Check Required Values Either the price list is inactive
or the price list is invalid for
the contract currency. Select a
valid price list for the contract
currency.

This message validates the
following: checks that price
list is active or valid for the
contract currency.
It occurs when: the price list is
inactive, missing, or is invalid
for the contract currency.
To fix the error: select a valid
price list.

Check Required Values Price list Id is required for
contract header 1.

This message validates the
following: a price list Id is in
contract header.
It occurs when: you do
not have a price list under
Pricing/Billing subtab.
To fix the error: add a price
list under the Pricing/Billing
subtab.

Check Required Values Contract group must be
entered for contract header 1

This message validates the
following: a contract group is
entered in the contract header.
It occurs when: contract group
is not entered on the contract
header.
To fix the error: add a
contract group under the
Administration sub tab.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Required Values An approval workflow must
be selected for the contract.

This message validates the
following: an approval
workflow is selected for the
contract.
It occurs when: an approval
workflow is missing.
To fix the error: Should add an
approval workflow under the
Administration subtab.

Check Required Values Line 1 UOM code and values
should be entered.

This message validates the
following: if profile option
OKS: Use Advanced Pricing
for Manual Adjustment is set
to Yes, then a value should be
entered on the subline for unit
price or uom.
It occurs when: profile option
OKS: Use Advanced Pricing
for Manual Adjustment is set
to Yes, and unit price or uom
code is missing from subline.
To fix the error: add a unit
price or uom code to the
reported subline.

Check Required Values Line 1 UOM code and values
should be entered.

This message validates the
following: If profile option
OKS: Use Advanced Pricing
uom is set, UOM becomes a
required field on the subline.
It occurs when: profile option
OKS: Use Advanced Pricing
for Manual Adjustment is set
toNo and uom code is missing
from subline.
To fix the error: add a uom
code to the reported subline.

Check Required Values Please enter the PO number for
billing.

This message validates the
following: the PO flag and
number under the billing
section. If Purchase Order
Required check box is checked
then PO number is required.
It occurs when: the PO
check box is checked but PO
number is missing under
the billing section under the
Pricing/Billing subtab.
To fix the error: add a PO
number under the billing
section under the Pricing/
Billing subtab or uncheck the
PO check box.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Required Values Service PO number is missing. This message validates the
following: the PO flag and
number under the Service
Charges section. If Purchase
Order Required check box is
checked then PO number is
required.
It occurs when: the PO flag
is checked under the Service
Charges section under the
Pricing/Billing subtab but the
PO number is not entered.
To fix the error: add the PO
number under the Service
Charges section under the
Pricing/Billing subtab or
uncheck the PO check box.

Check Required Values Conversion information is
required for this contract.

This message validates the
following: the currency
conversion type is entered if
the From Currency and the To
Currency are different.
It occurs when: the to and
from currencies are different
and the currency conversion
type is missing.
To fix the error: add a currency
conversion type under the
Pricing/Billing subtab.

Check Required Values Price list currency, does not
match header currency.

This message validates the
following: compares price list
currency with contract header
currency.
It occurs when: the price list
currency is not the same as the
header currency.
To fix the error: change the
price list under the Pricing/
Billing subtab

Check Service Effectivity Please enter a value for
Inventory item status not
active in contract line 1.

This message validates the
following: whether the
inventory item status is active.
It occurs when: When
inventory item is no longer
valid.
To fix the error: change the
inventory item on the reported
line.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Service Effectivity Item: line 1 Not a valid Service This message validates the
following: whether service or
extended warranty is a valid
item in the inventory table.
It occurs when: the service
or extended warranty is not a
valid item.
To fix the error: select another
service or extended warranty
line on the Accounts subtab or
delete the line.

Check Service Effectivity Item: line 1 Not a valid Usage This message validates the
following: if the usage item is
valid.
It occurs when: the usage is
not a valid item.
To fix the error: select another
usage on the Accounts subtab
or delete the line.

Check Service Effectivity The Product Item is not a
Serviceable Product.

This message validates the
following: if covered product
is serviceable.
It occurs when: a covered
product is not serviceable.
To fix the error: select another
covered product from the
Effectivities secondary tab
(Products/Pricing subtab).

Check Service Effectivity Please enter a value for
Covered item status not active
in contract line 1.

This message validates the
following: the covered item
status is active.
It occurs when: covered item
status is not active.
To fix the error: select
another covered item from
the Effectivities secondary tab
(Products/Pricing subtab).

Check Service Effectivity Please enter a value for
Covered party status not active
in contract line 1.

This message validates the
following: if covered party
status is active.
It occurs when: covered party
status is not active.
To fix the error: select another
covered party.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Service Effectivity Please enter a value for
Covered product status not
active in contract line 1.

This message validates the
following: reports an error if
covered product status is not
active and contract status is
not QA hold. Reports an error
if covered product status is not
active and the covered product
has a future termination date
and the contract status is QA
hold.
It occurs when: the covered
product status is not active
and contract status is not QA
hold or when the covered
product status is not active
and the covered product has
a future termination date and
the contract status is QA hold.
To fix the error: select another
covered product.

Check Service Effectivity Please enter a value for
Covered system status not
active in contract line 1.

This message validates the
following: reports an error if
Covered System status is not
active.
It occurs when: covered
system status is not active.
To fix the error: select another
covered system.

Check Service Effectivity Please enter a value for
Covered site status not active
in contract line 1.

This message validates the
following: Reports an error
if Covered Site status is not
active.
It occurs when: covered site
status is not active.
To fix the error: select another
covered site.

Check Subscription Element
Exist

Subscription line 1 should
have at least one subscription
element.

This message validates the
following: for tangible items
there is a delivery schedule.
If the subscription line has a
tangible item then it should
have at least one subscription
element (delivery schedule).
It occurs when: delivery
schedule is missing for a
tangible subscription.
To fix the error: enter a
delivery schedule.
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Process Name Error Message What does this error
message mean and how
can I x it?

Check Subscription is
Shippable

Subscription line 1 should
have a ship to rule.

This message validates the
following: if subscription item
is shippable then ship to rule is
required for that subscription
line.
It occurs when: subscription
item is shippable but ship
to rule is missing from the
subscription line.
To fix the error: enter a ship to
rule for the subscription line

Check Subscription is
Shippable

Subscription line 1 should
have a ship to address.

This message validates the
following: if subscription
item is shippable then ship to
address is required for that
subscription line.
It occurs when: subscription
item is shippable but ship to
address is missing from the
subscription line.
To fix the error: enter a
shipping address for the
subscription line.

Check Sum of Credit Card
Numbers

Credit Card Number is invalid This message validates the
following: checks if the credit
card numbers are valid based
on sum calculations.
It occurs when: credit card
numbers are invalid.
To fix the error: change the
credit card number.

Check Tax Exemption Tax Exemption 1 on Line 1
is not effective for all billing
periods in the billing schedule.
The Tax Exemption will not be
applicable after invoice date.

This message validates the
following: reports an error if
tax exemption is invalid.
It occurs when: tax exemption
is invalid.
To fix the error: select another
tax exemption under the
Exemption/Payment Options
subtab.

Warning Messages
You should review all warning messages before submitting the contract for
approval. However, warning messages will not prevent you from passing the QA check
and submitting the contract for approval.

Warning Messages Summary
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Process Name Warning Message What does this warning
message mean and how can
I x it?

Check Covered Level Overlap Line 1 is also in Contract 1 This message validates the
following: if the current
contract has covered lines
whose dates over lap with the
covered lines of an existing
contract that is not cancelled,
terminated or expired.
It occurs when: the current
contract has lines that overlap
with an existing contract that
is not cancelled, terminated or
expired.
If the warning should be
fixed: delete the lines that are
overlapping.

Check Email Address This Contract is missing at
least one party contact with
email address.

This message validates the
following: party contact has
an e-mail address.
It occurs when: the party
contact is missing an e-mail
address.
If the warning should be
fixed: add an e-mail address to
the party contact.

Check Preventive Maintenance Contract line 1; The definition
of Preventive Maintenance
Program or Activities is no
longer valid.

This message validates the
following: checks if preventive
maintenance program or
activities have been terminated
in AHL.
It occurs when: preventive
maintenance program or
activities have been terminated
in AHL.
If the warning should be
fixed: choose a different
program name in coverage
that is not terminated.

Check Preventive Maintenance Contract line 1; No Preventive
Maintenance Schedule is
defined for any activity

This message validates the
following: checks if there
are any schedules defined in
Contracts for the Preventive
Maintenance Program or
Activities.
It occurs when: there are no
schedules defined in contracts
for the PreventiveMaintenance
Program or Activities
If the warning should be
fixed: navigate to the Program
Schedule or Activity Schedule
tab as appropriate and define
stream levels and schedules.
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Process Name Warning Message What does this warning
message mean and how can
I x it?

Check Preventive Maintenance Contract line 1; The definition
of Preventive Maintenance
Program has been modified.

This message validates the
following: new activities
have been associated to the
preventive maintenance
program in AHL.
It occurs when: new activities
have been associated to the
preventive maintenance
program in AHL.
If the warning should be
fixed: choose the same
Program Name from the LOV.

Check Price Lock Price locks are removed during
contract renewal or copy. To
re-lock the price list for contract
line 1, refer to contract 1 line 1
for the previous locked price.

This message validates the
following: checks if price
lock is present on the original
contract lines and not on the
copied/renewed lines.
It occurs when: price lock
is present on the original
contract lines and not on the
copied/renewed lines.
If the warning should be
fixed: review the prior prices
if necessary and relock prices
on the current contract on the
reported line.

Check Required Values for
Preventive Maintenance

Contract line 1; The effective
start date of the Preventive
Maintenance Program /
Activities should be less than
or equal to the line start date.

This message validates the
following: the effective
start date of the Preventive
Maintenance Program or
Activities should be after the
contract line start date.
It occurs when: the effective
start date of the Preventive
Maintenance Program or
Activities is after the contract
line start date.
If the warning should be
fixed: choose a different
Program Name in Coverage
that is effective.
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10
Approving Contracts

This chapter covers the following topics:

• Approving Contracts

• Submitting Contracts for Approval

• Tracking Contracts During the Approval

• Approving Contracts

• Signing Contracts

Approving Contracts
This group of topics explains the contract approval process.

Oracle Service Contracts leverages Oracle Workflow to automate the contract approval
process. After you author a contract you must:

• Submit the contract for approval.

• Secure approval on the contract.

• Obtain a signature on the contract.

The Submit for Approval function launches the quality assurance (QA) check. If the QA
check is successful you can continue the approval process, which submits the contract to
the approval workflow. See About the Quality Assurance Check, page 9-1.

Following the contract approval and signing, the system updates the contract status to
Signed or Active, depending on whether or not the start date has passed.

Submitting Contracts for Approval

To submit contracts for approval:
1. From the Service Contracts Authoring window, select the Summary tab and the

Administration subtab.
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2. Click the Submit.

The Quality Assurance Results window appears. You must confirm there are no
errors on the report. See About the Quality Assurance Check, page 9-1.

3. From the Quality Assurance Results window, click Continue Approval.

The Contract Authoring page returns with the Summary Administration subtab
selected. You have submitted the contract to the approval workflow that is selected
in the Approval Workflow region.

Review the following procedures:

• Tracking Contracts During the Approval, page 10-3.
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• Approving Contracts, page 10-4.

• Signing Contracts, page 10-6.

Alternatively, you can submit the contract by selecting Submit for Approval from
the Actions menu.

Note: Contracts that have been submitted to the approval workflow
are locked for further authoring. However, communications and
attachments can still be added to the contract after it has been
submitted for approval.

Tracking Contracts During the Approval

To track contracts during the approval:
1. From the Service Contracts Authoring window, select the Summary tab and the

Administration subtab.

2. SelectMonitor.
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The Monitor Diagram page appears in a new browser window.

Beneath the Current Status heading, you can view the current status and a visual
diagram of the workflow approval process.

3. Follow the green arrow within the diagram to determine where the contract is in the
approval process.

For example, if the contract requires approval the green arrow leads to the Contract
Approval Required process.

4. To view details for a given process step, select the process icon within the diagram.

The tabs beneath the diagram show status information for the selected process. Tabs
include Definition, Status, Usage, and Notification.

For more information on monitoring workflows, refer to the Oracle Workflow User’s
Guide.

Note: You can stop the approval process by selecting the Stop
button within the Administration subtab.

Approving Contracts

To approve a contract:
1. Navigate to the Launchpad.

10-4 Oracle Service Contracts User Guide



2. In the Inbox region, click Find.

The Inbox Find window appears.

3. From the Select Notification Type list, select Contract Approvals.

4. Select Find.

The Inbox is refreshed with contracts that require approval.

5. Highlight the contract you would like to approve.
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6. Select Respond.

A worklist page appears within a new browser window. You can either
approve, reject, reassign the approval to someone else, or request information.

You may add a note to the Response region.

7. Select Approve.

The Worklist summary appears. The message indicates, Contract requires your
signature. You can select the Contract requires your signature link and sign the
contract.

Signing Contracts

To sign a contract:
1. Navigate to the Launchpad.

2. In the Inbox region, click Find.

The Inbox Find window appears.

3. From the Select Notification Type list, select Contract Requiring Signature.
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4. Select Find.

The Inbox is refreshed with contracts that require a signature.

5. Highlight the contract you would like to sign.

6. Select Respond.
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A worklist page appears within a new browser window. You can either sign, not
sign, reassign, or request additional information.

You may add a note to the Response region.

7. Select Yes.

The Worklist summary appears. The message indicates, Contract has been Signed.
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11
Billing

This chapter covers the following topics:

• Overview of Billing

• Understanding Billing Levels

• Creating Billing Profiles

• Billing Customers Based on Usage

• Billing Using Credit Cards or Commitments

• Specifying Multiple General Ledger Accounts for Contract Revenue Streams

• Executing Billing Through Concurrent Programs

• Running the Service Contracts Main Billing Program

• Running the AutoInvoice Import Program

• Running the Service Contracts Fetch Receivables Info for Billing Program

• Running the Service Contracts Usage Averaging Program

• Running the Service Contracts Usage Settlement Program

• Viewing Invoice Details

• Viewing Invoice History

• Reviewing Invoice Transactions in Oracle Receivables

• Understanding Bill Presentment Architecture

Overview of Billing
This group of topics explains how billing works.

A billing schedule determines when the customer is billed for the services they
receive. You must specify billing schedules for each contract that you author in Oracle
Service Contracts.

Note: Contracts can be indirectly created from Oracle Order
Management. You do not need to create billing schedules for such
contracts.

Billing schedules can be defined at the contract header, the contract line, or the subline
level.
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For information on setting up billing schedules at the contract header level, see Creating
Default Billing Schedules, page 3-6.

For information on setting up billing schedules at the line level, see:

• Specifying a Billing Schedule, page 4-27 (for a service line)

• Specifying a Billing Schedule for a Usage Line, page 5-27

• Specifying a Billing Schedule for Subscriptions, page 6-10

Understanding Billing Levels
From the Billing window, you can define a billing level for the billing schedule. There are
three levels, but not all levels are available to each line type, nor are all levels available
at the header level.

The following information provides general information on the billing levels, however, to
understand which of these levels can be used by the header and line types refer to the
topics noted at the end of each description.

The three billing levels are:

• Equal Amount: allows you to bill for equal amounts over the billing period and
have control over the amount to be billed as well as the billing periods. You can also
use the Prorate button to spread the amount across billing periods. The start and
end dates of all top lines and their sublines must be the same. You cannot modify
the schedule form after it in generated.

Equal Amount can be set at the header, service line, or subscription line level:

• header, see Creating a Default Billing Schedules, page 3-6

• service lines, see Specifying a Billing Schedule, page 4-27

• subscription lines, see Specifying a Billing Schedule for Subscriptions, page 6-10
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• Top Level: allows you to define the billing periods. The billing engine calculates
the bill amounts, so the amount fields and Prorate button are disabled. With Top
Level, line level start and end dates can differ from the sublines. When creating
billing schedules at this level, the total stream level amounts from the sublines
roll-up to the line levels. Also, once a line level billing schedule exists, all new
sublines added will automatically update the billing amount per period without
needing to revisit the line level and click Schedule again.

Whenever the duration of the line is increased, an additional billing stream is
created. If the contract has a later end date, the unit of measure of the billing stream
is taken from the previous stream. If the duration is reduced, billing streams may
be automatically removed, as long as those streams are entirely outside of the
new contract duration. If these changes are cascaded to the sublines, those billing
schedules will be updated when the cascade is initiated. If the changes are not
cascaded, only the line level billing schedule will be automatically updated.

Top Level can be set at the header, service line, or usage line level:

• header, see Creating a Default Billing Schedules, page 3-6

• service lines, see Specifying a Billing Schedule, page 4-27

• usage lines, see Specifying a Billing Schedule for a Usage Line, page 5-27

• Covered Level: when the covered level effective dates are not the same as the service
line effective dates, you have the option to create a covered level specific billing
schedule. As a prerequisite, the service line billing schedule level must first be set
to the Covered Level. By default, all the covered level lines inherit the service line
billing schedule. If required, the billing schedule can be modified and updated for
a given covered level. Amounts can be entered for every period and the Prorate
button may be used.

Covered Level can be set at the service line level:

• service lines, see Specifying a Billing Schedule, page 4-27

Note: You can select a billing level default by setting the
profile OKS: Billing Schedule Level. If the level you select is
not available to the header or the line, the defined value will
not default.

For example, if the default is set to Top Level and you create
a subscription line, the defaulted value will not be Top
Level, despite the setting. This is because subscription lines
must be Equal Amounts not Top Level.

Creating Billing Proles
All customer account information is set up in Oracle Receivables, which includes a
single billing profile that is applicable when invoicing all customers. You can set
up multiple, ad hoc billing profiles in Oracle Service Contracts. Billing profiles
include information about accounting and invoicing rules, type of billing, and its
frequency. Invoices are generated according to the billing profile attributes. The billing
engine accesses the billing profile and bills accordingly.

For example, you could set up a billing profile, called Monthly Interval, which defaults
a monthly billing schedule with specific accounting and invoicing rules. You could
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use this profile to default information and also when renewing contracts if the billing
durations are not the same between the original and renewed contracts.

You can use the billing profile to overwrite any existing line level billing schedule
information on the contract authoring form by selecting it in the Cascade Attributes form.

You can also default billing profile information onto the contract by associate a billing
profile template to a customer in the Global Contract Defaults form.

Prerequisites

The following options must be defined:

• Accounting Rules

• Invoicing Rules

• Billing Levels

• Recurring Intervals

To create billing proles:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > Billing

Profile.

The Billing Profile window appears.

2. Enter an alphanumeric profile number.

3. Enter the profile description.

4. Optionally select a party, such as Business World.

When a billing schedule is assigned to a party, the profile is limited to that party. If
you are creating a contract for another party, you will not see this billing profile in
the LOV when you cascade attributes.
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5. Select an Accounting Rule from the LOV.

6. Select an Invoicing Rule from the LOV.

7. Select a Billing Level from the LOV.

8. Select One Time or Recurring as the Billing Type option.

For the Recurring billing, select a billing Interval from the LOV, for example, Month.

9. In the Invoice Offset field, enter the number of days to move forward or push
back the invoice date.

10. In the Interface Offset field, enter the number of days to move forward or push back
the date that the billing period will interface to Oracle Receivables.

11. Save.

Note: A billing profile should be defined according to the billing
requirements. If multiple customer accounts have different billing
requirements, the number of billing profiles should be defined
accordingly.

There are no restrictions on the number of billing profiles.

Billing Customers Based on Usage
For usage lines you can bill customers using different methods. Some of these methods
are fixed, others are based on counter readings or estimation values.

To understand how a customer can be charged for usage lines, see Specifying How
Customer is Charged, page 5-5.
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Billing Using Credit Cards or Commitments
Oracle Service Contracts integrates with Oracle Receivables to support multiple billing
methods.

When you enter billing terms for a contract, you can select a method of payment from a
LOV. These methods include Credit Card and Commitment (prepayment). This is done
from the Pricing/Billing subtab of the Summary tab.

If you select the Credit Card method, you must enter also credit card information such
as credit card number, and credit card expiration date.

If you select the Commitment method, then the Authoring process requires the entry of
a commitment number. Customer commitments must be set up in Oracle Receivables
prior to use as a method of payment in Oracle Service Contracts. See:

• (header)Specifying Payment by Credit Card or Commitment Number, page 3-12.

• (lines) Specifying Payment by Credit Card or Commitment Number, page 4-32.

Specifying Multiple General Ledger Accounts for Contract Revenue
Streams

There may be situations where you wish to distribute revenue for a contract line to
one or more general ledger accounts other than the default account specified during
the implementation.

You can change the default revenue distribution for an Entered contract. You can also
open an Active contract for update, or create a change request. If you are changing the
revenue distribution for a contract after a line has been billed, you will only change
the revenue distribution for future billing.

If the contract is copied, renewed or used as a template these distributions will also
be copied to the new agreement.

To specify multiple general ledger accounts for contract revenue streams:
1. From the Service Contract Authoring window, select a line to specify multiple

general ledger accounts.

2. From the Tools menu, select Revenue Distribution.

The Revenue Distribution window appears for the line.
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3. Review the account defaulted in the GL Account field.

4. Select the LOV for the Override Account field.

The Operations Accounting Flex window appears.

5. Select the LOV for the Account Alias field.

The Account Alias window appears.

6. Select an Account Alias.

The account number for the account alias appears in the Override Account field.

Note: For some accounts, the Operations Accounting Flex window
appears. You can choose the overriding account by selecting the
segment values, or by choosing from the list of combinations.

For more information refer to the Oracle General Ledger User Guide.

7. Enter the percentage to be allocated to the account in the Percent field.
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After you have entered all the override accounts, the Total % field must equal 100%.

8. To add additional override accounts, repeat steps three through seven.

9. Click OK.

Executing Billing Through Concurrent Programs
In order to initiate and complete the billing process, you must run the following
concurrent programs:

• Service Contracts Main Billing

• AutoInvoice Import Program

• Service Contracts Fetch Receivables Info for Billing

Note: You should run contracts through the quality assurance check
prior to submitting them for billing. This helps to ensure the billing
process is successful. See .

Running the Service Contracts Main Billing Program
This program is owned by Oracle Service Contracts. It generates a log file of the total
value processed, total value successful, and total value rejected for billing. For a
description, see About Concurrent Programs, page 18-7.
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For usage lines, the Service Contracts Main Billing program calculates billing amounts
based upon the usage type. See Specifying How the Customer is Charged, page 5-5.

To run the Service Contracts Main Billing program:
1. From the Navigator, navigate to Control > Requests > Run.

The Submit New Request window appears.

2. Choose Single Request and click OK. The Submit Request window appears.

3. In the Request region, select Service Contracts Main Billing.

4. In the Parameters window, specify one or more of the following:

• Contract Number: Enter the numbers of the contracts to be billed.

• Default Date: Enter the date you want as the default. (The default offered is
the system date on your computer.)

• Organization: Enter the organization id for which all the contracts are to be
billed.

• Customer Name: Enter the name of the customer for which all the contracts are
to be billed.

• Category: Enter the category for which all the contracts are to be billed.

• Group: Enter the name of the group for which all the contracts are to be billed.

• Preview: Change this option to yes to send these transactions to special preview
tables to enable you to review the invoice details before you submit them to
Oracle Receivables. Leave it at no if you want the transactions interfaced to
Oracle Receivables.

5. Click OK.

6. In the Submit Request window, click Submit Request.

The billing program sends the invoice amount to Oracle Receivables, which then
generates the invoice. The process also populates some billing transaction history
information in the History tab of the Billing Schedule. Since the invoice number
is assigned and tax calculated by Oracle Receivables neither of these pieces of
information could be populated until after the Service Contracts Fetch Receivables
Info for Billing program is run. The tax amount will be left blank and the invoice
number will be populated with -99.

Running the AutoInvoice Import Program
This program is owned by Oracle Receivables. It imports the billing transactions from
the Service Contracts Main Billing Program into Oracle Receivables and generates the
invoice details.

To run the AutoInvoice Import Program:
After you run the Service Contracts Main Billing Program, you must run the Autoinvoice
Import Program to import the billing transactions into Oracle Receivables for processing.

For more information on how to run this program, see the Oracle Receivables User Guide.
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Running the Service Contracts Fetch Receivables Info for Billing Program
This program is owned by Oracle Service Contracts. For a description, see About
Concurrent Programs, page 18-7.

To run the Service Contracts Fetch Receivables Info for Billing
1. From the Navigator, navigate to Control > Requests > Run.

The Submit a New Request window appears.

2. Choose Single Request and click OK.

The Submit Request window appears.

3. In the Name field, select Service Contracts Fetch Receivables Info for Billing.

4. Click OK.

5. In the Submit Request window, click Submit Request.

This updates the invoicing information in the customer’s contract. The invoice
number and tax appear in the billing details.

Running the Service Contracts Usage Averaging Program
Usage averaging is used to give price benefits to the user for higher consumption in a
period. This feature allows the user to distribute consumption evenly in multiple billing
periods. After distributing the consumptions evenly, price breaks are applied to these
consumptions to get new billing amount for the period.

This program is owned by Oracle Service Contracts. For a description, see About
Concurrent Programs, page 18-7.

For information on usage lines, see Entering Usage Lines, page 5-1.

To run the Service Contracts Usage Averaging program:
1. In the Navigator, navigate to Control > Requests > Run.

The Submit New Request window appears.

2. Choose Single Request and click OK.

The Submit Request window appears.

3. In the Name field, select Service Contracts Usage Averaging.

4. In the Parameters window, enter the number of the contract.

If you leave this field blank, all contracts will be used.

5. Click OK. In the Submit Request window, click Submit Request.

Running the Service Contracts Usage Settlement Program
Usage billing supports settlement features for Actual Per Period. This feature is used to
settle the discrepancies between actual consumption and actual billed amount. This type
of situation may arise when consumption for billing period is captured after running the
main billing for that billing period. Currently there is a separate settlement program
to do settlements of usage lines.
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Settlement can also be done by billing program at the time of invoice generation.

This program is owned by Oracle Service Contracts. For a description, see About
Concurrent Programs, page 18-7.

For information on usage lines, see Entering Usage Lines, page 5-1.

To run the Service Contracts Usage Settlement program:
1. In the Navigator, navigate to Control > Requests > Run.

The Submit New Request window appears.

2. Choose Single Request and click OK.

The Submit Request window appears.

3. In the Name field, select Service Contracts Usage Settlement.

4. In the Parameters window, enter the number of the contract.

If you leave this field blank, all contracts will be used.

5. Click OK. In the Submit Request window, click Submit Request.

Viewing Invoice Details
You can use the Invoice Details function to review payment, credit, and adjustment
information applicable to the contract, lines, and sublines.

Prerequisite

Run the necessary concurrent programs to generate billing transactions. See Executing
Billing Through Concurrent Programs, page 11-8.

To view invoice details:
1. From the Service Contracts Authoring window, choose the Tools menu and select

Invoice Details.

The Invoice Details window appears with the Invoice Number, Date, Source,
Transaction Type, and Amount.
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2. Select the Payment Details button.

The Payment Details window appears with the Payment Amount and Payment Date.

Click OK when finished viewing Payment Details.

3. From the Invoice Details window, select the Line Details button.

The Line Details window appears with Item Names and Descriptions, Unit of
measure, Unit Price, Billed Amount, Tax Rate for the lines.

Click OK when finished viewing the Line Details.

4. Click OK to return to the Service Contract Authoring window.

Viewing Invoice History
You can use the History tab of the Billing window to review billing history. This tab is
populated after you run the billing execution programs. See Executing Billing Through
Concurrent Programs, page 11-8.

You should understand the following about the details associated with the History
tab of the Billing window:

• Line level billing schedule histories are populated with the actuals.

• Header level billing schedules will not show any billing history.

Prerequisite

Run the necessary concurrent programs to generate billing transactions. See Executing
Billing Through Concurrent Programs, page 11-8.

To view invoice history:
1. From the Service Contracts Authoring window, select the Lines tab and

Pricing/Products subtab.
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2. Select a line.

3. Click on the Billing button

The Billing window appears.

4. Select the History tab.

You can view the billing history from this tab, including invoice information and
billing dates.

Note: If summary transactions are selected with either a profile
option or the contract check box, the history contains one transaction
line per billing period. However, if detail transactions are being sent
to Oracle Receivables, the billing history will show the details for
each subline per billing period. You can view the details of that
billing transaction by right clicking on any line in the billing history.

Reviewing Invoice Transactions in Oracle Receivables
For detailed information on using Oracle Receivables, see the Oracle Receivables User
Guide.

To review invoice transactions in Oracle Receivables:
1. From the Navigator, select the Receivables, Vision Operations (USA) responsibility.

2. Navigate to Transactions > Transactions.

The Transactions window appears.

3. From the toolbar, select the Flashlight icon.

The Find Transactions window appears.

4. In the Sales Order Number field, enter the contract number.
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5. Click Find

The Transactions Summary window appears with the invoice information.

6. Click Open to view the invoice transaction details.
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Understanding Bill Presentment Architecture
Bill Presentment Architecture (BPA) allows you to customize the content and formatting
of billing data that your customers view online or print. Oracle Service Contracts is one
of the data sources that can be used by the BPA framework.

There are a number of setups required to enable this functionality. For more
information, see the Oracle Receivables User Guide.
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Managing the Contract Lifecycle

This chapter covers the following topics:

• Overview of Managing the Contract Lifecycle

• Modifying Multiple Contracts at the Same Time (Mass Change)

• Handling Change Requests

• Entering Contract Changes

• Reviewing and Approving Changes

• Updating Contracts Online

• Creating Different Contract Versions for Your Customer

• Viewing Contract History

• Handling Returns and Granting Credit

• Changing Contract Status

Overview of Managing the Contract Lifecycle
This group of topics explains how you can manage the contract lifecycle.

After the contract authoring process is complete, you must manage your contracts on
an ongoing basis. You may need to change coverages, durations, versions, and other
aspects your contracts.

You can streamline and control administrative processes, by leveraging functionality
that manages updates and changes.

For information on contract extensions and renewals, see Approving Contracts, page
10-1.

Modifying Multiple Contracts at the Same Time (Mass Change)
You can change one attribute of multiple contracts with a single request using mass
change functionality. Mass change is allowed for contracts that are in appropriate
status, where the operation update online is permitted.

Mass Change supports changes to a particular instance selected in the update level. For
example, if changes are to be made at the Organization, it will update records pertaining
to that Organization.
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The Mass change window allows you to enter the scope of the mass change request and
selection criteria. It determines which contracts are to undergo a mass change. The
update level is seeded, but may also be restricted by use of the OKS: Mass Change
Security Level profile option. If the security of the profile option is turned on, the list
may contain only the Contract and Contract Group levels; otherwise, the following is
the list of update levels available:

• Category

• Contracts Group

• Organization

• Party

• Contract

Mass change permits the following attributes to be changed. Making change on a
contract has a subsequent cascading effect and therefore needs to be carefully considered
before allowing such a change. Following attributes are permitted for mass change that
can be selected from the Attribute’s LOV in the Mass Change header:

• Accounting Rule

• Agreement

• Business Process Price List

• Contract End Date

• Contract Group

• Contract Line Ref

• Contract Start Date

• Contract Renewal Type

• Coverage End Time

• Coverage Start Time

• Coverage Timezone

• Coverage Type

• Header Bill to Address

• Header Ship to Address

• Invoicing Rules

• Known As

• Party Billing Contact

• Party Shipping Contact

• Payment Term

• PO Numbering for Billing

• PO Required for Renewal

• Preferred Engineer

• Preferred Resource Group
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• Price List

• Product Line Ref

• Reaction Time

• Resolution Time

• Revenue Account

• Salesperson

• Summary Print

Note: if the billing schedule is defined with Equal Amount or
Covered Level, you cannot use Mass Change to modify either the
contract start date or the contract end date, since the billing schedule
has to be adjusted for each individual contract.

To modify multiple contracts at the same time:
1. Navigate to Mass Change from the Navigator.

The Mass Change Operation window appears.

2. Enter the Name of mass change.

3. FromMass Change Details select the value Update Level from the LOV, such as Party.

4. Select Value from the LOV, such as Business World.

5. Select an appropriate Attribute from the LOV, such as Price List

Attributes supported by mass change are listed in this list.

6. Select an Old Value, such as Corporate.

7. Select a New Value, such as Business World.
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8. Click Search or click Cancel and start over.

If Search button is clicked, all the contracts that meet the criteria are displayed in the
Result region. By default all the records are selected.

9. To deselect a contract, check the Select check box.

Note: You can deselect all contracts by clicking Deselect All or you
can select all contracts by clicking Select All.
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10. To run the QA check first, select the Check QA check box.

11. To preview the request without submitting it, click Preview.

The Mass Change Submission window appears.

Because the Mass Change is a powerful process, you may preview a report. This
ensures that you do not update any contracts that you did not mean to update. To do
so, you can run a preview, review the report, then submit it when you are confident
the changes are correct.

1. Select either As soon as possible or On Specific Day.

2. Click OK.

A note appears, indicating the Mass Change request was successfully
submitted. You should make a note of the request id.

You are returned to the Mass Change window. The Operation Status field
provides the status for the mass change.

The Request region is populated with details of the request.

12. To submit the request, click Submit the Request.

The Mass Change Submission window appears.

1. Select either As soon as possible or On Specific Day.

2. Click OK.

A note appears, indicating the Mass Change request was successfully submitted.

You are returned to the Mass Change window. The Operation Status field
provides the status for the mass change.

The Request region is populated with details of the request.

Note: While submitting the mass change request, if one of the
requests has an error it will display an error message. In this
case you can resubmit the request after making the changes to
that request. This can be done until all the contracts in the mass
change request are successfully processed.
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13. To view the details for the request, select View Request.

The Requests window appears.

14. After the request is completed, requery the Mass Change request window to
view the updated Operation Status and Request information in the Mass Change
Operation window.

Handling Change Requests
Your administrator can set a contract to a status that does not allow changes to be
made online through the authoring form, but does allow changes through a change
request. This provides more control over tracking the changes made to a contract
through its lifecycle.

If the Active status does not allow online updates, then any changes to the contract
would have to go through the change request process. After a change request has been
approved, a notification is sent to the Contract Administrator. From the Inbox, you can
open the contract for update. In this situation the Open for Update button is not visible
in the contract itself.

After you complete the contract updates, you can run the contract through the QA Check
and if everything passes, the contract status is set back to Active.

Entering Contract Changes
Prerequisite

Confirm the status and operations setup allows changes for the category and status.

To enter contract changes:
1. From the Navigator, choose Launch Contracts.
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2. Select the Contract Navigator tab.

3. Highlight the contract you want to change.

4. Right-click the contract and choose the Create Change Request option.

The Create Change Requests window appears.

5. Enter the request name and a description.

6. Confirm the requester’s name in the Request By field.

This person receives a workflow notification when changes are approved and can be
applied to the contract.

7. Enter the request date.

8. Enter the effective dates.

9. To version the changed contract, select the Version check box.

10. To require signature, select the Signature Required check box.

11. Record the lines where you are requesting a change and the exact nature of the
change, for example, apply an extra 10% discount.
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12. Select the Admin tab.

13. In the Workflow Name field, select the approval workflow.

14. Select an Administrator.

15. Select Party Approvals (optional).

16. Save.
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17. Click Submit for Approval.

A Note message appears, indicating Submitted for approval

18. Click OK.

Reviewing and Approving Changes
The change request must first be approved before you can change the contract. After the
change request has been approved, you can open the contract and apply the changes as
described in the change request notification. After you start editing the contract, you
automatically lock the contract for other users with an approved change request.

Prerequisite

Open the change request notification in your Inbox and confirm no other change
requests are in process.

To review and approve changes:
1. From the Navigator, choose Launch Contracts.

2. From the Launchpad, click Find.

The Inbox Find window appears.

3. From Select Notification Type, select Change Request Approvals.

4. Click Find.

The contracts with open change requests appear.
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5. Highlight the contract from the Inbox and click Respond.

The Notification Details window appears.

6. Click Approve.

The worklist window shows the change request has been approved.

Close the worklist.

7. From the Launchpad Inbox select Find:

• From the Select Notification Type list, select Change Requests Approved.

• Click Find.

The approved change requests appear.
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• Highlight the change request and select Open.

The contract opens in status of QA Hold (or Open for Update).

After you make changes you must submit the contract for a QA check.

8. From the Actions menu select Check QA.

The Quality Assurance Results window appears. If the contract passes QA, select
OK.

The status changes to Active.

A new version of the contract will be created if that option was selected in the
change request.

Updating Contracts Online
After the contract has gone through the approval process, you can update a contract
through the Update Online operation, as long as the status and operations definition
allows it.

Prerequisites

• Set the OKC: Global Update Privileges profile option to Yes.

• Grant the Update Online function to the user responsibility

• Confirm other users do not have the Change Request lock on the contract.

To update contracts online:
1. From the Service Contracts Authoring window, select the Summary tab and select

Open for Update .

The Contract Status should change from Active to QA Hold. This locks the contract.
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2. Make changes to the contract.

3. Save.

4. From the Actions menu, select QA Check.

5. Review the quality assurance results.

6. If the QA results are clean, click OK.

7. The Contract Status changes from QA Hold to Active.

Creating Different Contract Versions for Your Customer
The contract version consists of a major version and a minor version. The major and
minor versions are separated by a period. When a contract is created, the version is set to
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0.0. The minor version increases incrementally each time the contract is changed. When
you create a new version, the major version number of a contract is changed from its
most recent value to the next increment. The minor version changes each time the
contract is changed, but the major version will not change again unless you create
another contract version.

For example:

Contract Changes Version

Initial creation 0.0

First save with changes 0.1

Second save with changes 0.2

Create new version 1.0

First save after new version 1.1

Second save after new version 1.2

To create different contract versions for your customer:
1. From the Service Contracts Authoring window, choose the Tools menu and select

Create New Version.

A caution window appears indicating a new version will be created.

2. Click OK.

A note appears, indicating that a new version has been created successfully.

3. Click OK.

In the Version field, the digit in front of the period or the major version
number, increases by one. The minor version is reset to zero.
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Viewing Contract History

To view contract history:
1. In the Contract Navigator tab of the Oracle Contracts window, select a contract.

2. Double-click the contract.

The Contract Execution window appears.

3. Select the History tab.
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4. From the Select list choose an option:

• Status Change

• Contract Versions

• Change Requests

• Change Requests and Contract Versions

5. To open a contract version or change request, highlight the version and select Open.

Depending on what you select, the Service Contracts Authoring window or the
Create Change Request window appears.

Handling Returns and Granting Credit
Credits are determined by the RMA line type in Oracle Order Management. When a
product is returned from Oracle Order Management, Oracle Install Base makes a call to
Oracle Service Contracts with the parameter raise_credit, which determines if a full, a
partial, or no credit is to be issued.

• Full: Product line in Oracle Service Contracts is terminated as of the start date of the
product line and a full credit is issued.
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• Calculated (Partial): Product line in Oracle Service Contracts is terminated as of the
return date of the product. A partial prorated credit is issued based on the return
date.

• None: Product line in Oracle Service Contracts is terminated as of return date and
no credit is issued.

If there is a null value and nothing is passed in the parameter raise_credit, then Oracle
Service Contracts uses the credit option rule set in the Credit Amount field of the
Global Contracts Defaults window. You can set the credit option to Full, Calculated, or
None. For more information on the Global Contracts Default window, see Setting Up
Defaults for Contract Renewal, page 2-15.

If the credit option rule is not defined in Global Contracts Defaults, then Oracle Service
Contracts uses the value set in the profile option, OKS: Raise Credit Memo for IB Instance
Termination, and prorates the credit based on the return date.

Changing Contract Status

To change a contract status:
1. In the Contract Navigator, right click a contract and choose Change Status.

The Contract Status window appears.

2. Select the New Status from the LOV.

3. Select a Reason from the LOV.

If you need to add more reasons for the status change, your system administrator
can add more options in the Lookup Codes.

4. Use the Comments field to enter any additional information.

12-16 Oracle Service Contracts User Guide



5. Click OK.

6. A Status window appears, indicating the status change was successful.

7. Click OK.

8. In the Contract Navigator tab, right click the contract and select Refresh.

The contract shows the new status.

Note: Certain status transitions are made based upon the start
date or end date on a contract or on a contract line. There are two
concurrent programs used to automatically change the status of
a contract:

• Contract Status Change by Range

• Contract Status Change by Contract

These programs are used when the status transitions are not manual.

For example, a contract:

• expires when an end date is reached.

• becomes active from the signed status at the start date.
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Using Notes

This chapter covers the following topics:

• Communicating Using Notes

• How Notes are Used in Oracle Service Contracts

• Adding Service Contract Notes

• Adding Service Coverage Notes to a Coverage Template

• Adding Service Coverage Notes to a Service Coverage (Instantiated Coverage)

• Viewing Notes

Communicating Using Notes
This group of topics explains how you can use notes to add additional information
to a contract.

For detailed information on using Notes refer to the Oracle Common Application
Components User Guide.

You can use notes to communicate with other contract administrators, service agents, and
sales representatives regarding the details of a contract. For example, you can include
notes for contract administrators regarding the management of the contract, or to service
agents regarding the services provided under the contract.

A note can contain any free format text and can be attached to either a:

• service contract, see Adding Service Contract Notes, page 13-3.

• coverage template, see Adding Service Coverage Notes to a Coverage Template,
page 13-5.

• service coverage (which is the instantiated coverage of a particular service line), see
Adding Service Coverage Notes to a Service Coverage (Instantiated Coverage),
page 13-8.

Note: Because Notes is a context based menu, Service Contract notes
or Service Coverage notes are invoked based on where you place
your cursor within the application.

You can define a note status so that:

• all users can view it.

• you and other users can read and write to it.
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• only you can view it.

Note Types Used in Oracle Service Contracts
There are two seeded note types used by Oracle Service Contracts:

Note: Although there are two seeded note types, note types are user
extensible. You can always add your own note type to the contract note
source.

For detailed information on using Notes refer to the Oracle Common
Application Components User Guide.

1. Contracts Admin: allows you to add further information to the contract at the
contract header level, to the coverage template, or at the service level.

Contracts Admin notes indicate how to manage the contract itself and are more
useful for the sales representative or contract administrator.

Contracts Admin notes can be seen at the header level and at the line level

2. Contract Coverage: allows you to add further information to the coverage template
or the service coverage.

Contract Coverage notes generally relate to a specific service and explain any
relevant details of how the service is to be carried out. These notes are most useful
to the users who review entitlements.

You can also add Contract Coverage notes to a coverage template, which will be
copied over to the actual instantiated coverage that is tied to the contract line. These
notes can be viewed from the service coverage on the contract.

Contract Coverage notes can only be seen at the line level.

How Notes are Used in Oracle Service Contracts
The following provides examples of how notes are used within Oracle Service Contracts:

Contracts Admin Notes Added to a Service Contract

Include Jane Smith in renewal discussions on this contract, as well as other designated resources.

Spoke to Harry Jones 24 June 2004, confirmed that products A, B and C require upgraded
coverage next year.

See Adding Service Contract Notes, page 13-3.

Contracts Coverage Note Added to a Coverage Template

Perform inspection 3 times per month for this particular service on these products.

See Adding Service Coverage Notes to a Coverage Template, page 13-5.

Contracts Coverage Notes Added to a Service Coverage

Every time service is performed at site A, the engineer must contact the Security Patrol to obtain
a key.

Ensure that John Doe signs the work orders when performing any work against under this service.

See Adding Service Coverage Notes to a Service Coverage (Instantiated Coverage),
page 13-8.
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Note: Notes are part of the Oracle Common Application Components
that are leveraged by applications across the Oracle E-Business Suite. For
more information on Notes, refer to the Oracle Common Application
Components User Guide.

Adding Service Contract Notes

To add a service contract note:
1. From the Service Contracts Authoring window, select the Summary tab. From the

Tools menu select Notes.

The Notes window appears. The application populates the note with the following:

• Source: Service Contract Header

• Number: The contract number

• Entered By: The user entering the note

• Date: A time stamp of when the note was created

Note: If there is an existing note you will need to click New
to add a new note.

2. Enter the note text in the Notes field.

3. Select Contracts Admin from the Type LOV.

4. Select a Status:

• Publish: All users can view it.

• Public: The creator and other users can read and write to it.
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• Private: Only the creator can view it.

5. Save.

The note appears in the Notes tab.

The Related To field is populated with the Service Contract Header value from the
Source field.

The Value field is populated with the contract number.

6. To enter additional information, clickMore.

The Detailed Note window appears.

7. Enter the text in the Detailed Note field.
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8. Click OK.

The additional information is attached to the note.

Note: You can view a summary listing of all notes by selecting the
Summary tab.

Note: Only Oracle Service Contracts users can view notes of
Contracts Admin type.

Adding Service Coverage Notes to a Coverage Template

To add service coverage notes to a coverage template:
1. From the Service Contracts Coverage Template window, select Notes.

The Notes window appears.
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The Notes window appears. The application populates the note with the following:

• Source: Coverage Template

• Number: The coverage name, such as Gold

• Entered By: The user entering the note

• Date: A time stamp of when the note was created

Note: If there is an existing note you will need to click New
to add a new note.

2. Enter the note text in the Notes field.
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3. Select Contracts Coverage from the Type LOV.

4. Select a Status:

• Publish: All users can view it.

• Public: The creator and other users can read and write to it.

• Private: Only the creator can view it.

5. Save.

The note appears in the Notes tab.

The Related To field is automatically populated with the Coverage Template value
and the Value field indicates the coverage template.
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6. To enter additional information, clickMore.

The Detailed Note window appears.

7. Enter the text in the Detailed Note field.

8. Click OK.

The additional information is attached to the note.

Note: With the exception of Private notes, if you add a service
coverage note to the coverage template the note appears whenever
the coverage template is instantiated to a service line.

Note: Service coverage notes added to a service coverage template
can be viewed by Service Contracts application users as well as
Service application users

Adding Service Coverage Notes to a Service Coverage (Instantiated
Coverage)

To add a service coverage note to a service coverage:
1. From the Service Contracts Authoring window, select the Lines tab. From the Tools

menu select Notes.
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The Notes window appears. The application populates the note with the following:

• Source: Service Coverage

• Number: The coverage name, such as Gold

• Entered By: The user entering the note

• Date: A time stamp of when the note was created

Note: If there is an existing note you will need to click New
to add a new note.

2. Enter the note text in the Notes field.

3. Select Contracts Coverage from the Type LOV.

4. Select a Status:

• Publish: All users can view it.

• Public: The creator and other users can read and write to it.

• Private: Only the creator can view it.

5. Save.
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The note appears in the Notes tab.

The Related To field is automatically populated with the Service Coverage value and
the Value field indicates the coverage template.

6. To enter additional information, clickMore.

The Detailed Note window appears.

7. Enter the text in the Detailed Note field.

8. Click OK.

The additional information is attached to the note.

Note: If you enter a service coverage note for an instantiated
coverage of a service line, the note is attached to that specific
coverage.

If you have more than one service line in your contract, remember
that the note is added only to the instantiated coverage for the
selected service line and not to all service lines.

Note: Service coverage notes added to a service line can be viewed
by Service Contracts application users as well as Service application
users

Viewing Notes
Prerequisites

Notes for the contract and coverage notes for a service line are managed and viewed
separately. You will access these notes from different points within the application.

• Prerequisite for viewing notes for a contract: Select the Summary tab.
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• Prerequisite for viewing notes for a service coverage: Select the Lines tab and
choose a service line.

To view notes:
1. From the Service Contracts Authoring window, choose the Tools menu and select

Notes.

The Notes window appears. Within the Notes tab you will see a listing of the
available notes.

2. Highlight the note you wish to view.

The note details appear in the right-hand side of the window.

3. To verify if additional details are included on the note, selectMore.

Note: To view the notes that are attached to coverage template, you
must navigate to the Service Contracts Coverage Template form, and
select the Notes button.
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Extending and Renewing Contracts

This chapter covers the following topics:

• About Contract Extensions and Renewals

• Extending a Contract without Repricing

• Repricing an Extended Contract

• Extending a Contract Line

• How Billing Schedules Are Updated for Extended Contracts

• Understanding Contract Renewals

• Explaining the Pricing of Renewed Contracts

• Renewing Contracts Manually

• Managing the Automatic Renewal Process

• Understanding Billing Schedules on Renewed Contracts

• Consolidating Multiple Contracts for Renewal

• Sending Quote Letters by E-mail

About Contract Extensions and Renewals
This group of topics explains how you can extend and renew contracts.

Contract Extensions
Oracle Service Contracts allows you to extend the duration of a contract or a contract line
without having to submit the contract to the approval workflow.

A contract must be in a status of Active, Signed, or Expired to be extended. Contracts
in a status of Entered, Canceled, or Terminated are examples of contracts that cannot
be extended.

When you extend the duration of a contract, the contract lines are automatically
extended, as long as the end date of the line is the same as the end date of the contract. If
the end date for the line is different than the end date for the contract, the line will not
change if the contract is extended. This ensures that a service with a duration, which is
deliberately different than the contract duration, retains its intended duration.

You can either extend the contract without repricing it, or you can choose to reprice
it. For example, you may:
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• Provide a customer with an additional six months of coverage, because they are a
good customer and you would like to show your appreciation. In this scenario you
choose not to reprice the contract. See Extending a Contract without Repricing,
page 14-3.

• Extend a contract by three months because of a customer request. Although you
have agreed to extend the contract, you have advised the customer that they will
be charged for the extension. In this scenario you would choose to reprice the
contract. See Repricing an Extended Contract, page 14-4.

You can also manually extend the duration of a contract line. See Extending a Contract
Line, page 14-7.

After you have extended a contract, you should review any changes to the billing
schedules. See How Billing Schedules Are Updated for Extended Contracts, page 14-9

Note: You cannot extend the original contract if it has already been
renewed. However, you can extend the renewed contract, as long as
another contract does not follow it.

Contract Renewals
The process of renewing a contract involves making a copy of an existing, active contract
at a point in time. The dates are changed to reflect a period of time similar to the existing
contract; beginning on the first day after the existing contract expires. Other attributes of
the new contract may also be changed such as pricing.

Contracts can be renewed either manually or automatically. You can manually renew a
contract from the Contract Navigator, or your administrator can set up the application to
automatically submit a contract for renewal. Regardless of whether you plan to renew
contracts manually or automatically, you can define renewal rules within the contract
and you can also define global defaults for renewals:

• Define renewal rules within a contract. See Specifying How a Contract Will Be
Renewed, page 2-7.

• Create global defaults. See Setting Up Defaults for Contract Renewal, page 2-15.

After a contract has been renewed, changes to the existing contract will not update
the renewal contract. For example, if a contract is renewed 90 days prior to expiration
and the customer requests changes to their existing contract 15 days after the renewal
process has begun, the changes made to the existing contract will not be reflected on the
renewed agreement. If changes have not been made on the renewal contracts and it is
still in an Entered state, you can:

• delete the renewal contract.

• make changes to the original contract.

• renew it again, so that the latest changes are incorporated on the renewal contract.

Note: When renewing a Subscription contract:

• A new instance is not created in Oracle Install Base and the new
contract continues to reference the same parent item. However, if
you use the Copy function to create a new Subscription contract, a
new instance is created in Oracle Install Base.

• The Fulfillment schedule is copied to the new contract.
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To upsell a contract by adding additional services or covered goods, you may do so at
renewal. To upsell a contract, you must work with a sales representative when there is
an opportunity to open and update the contract.

For information on creating and enabling templates for e-mails to customers, see About
Templates for E-Mails to Customers, page 15-1.

Extending a Contract without Repricing

To extend a contract without repricing:
1. From the Contract Navigator, highlight a contract and right mouse click.

2. Select Extend.

The Extend Contracts window appears.

3. Select a Duration and Period.

The End Date Field is populated based on the duration and period.

4. Select Extend.

5. A decision message indicating that the contract was successfully extended
appears. Click Yes to save changes.

6. To verify if that the contract has been extended, highlight the contract and right click.

7. Select Open.

The contract authoring window appears.

8. Check the duration of the header to verify whether the contract has been extended.
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9. Select the Lines tab and Effectivities subtab to verify whether the lines have been
extended.

Repricing an Extended Contract

To reprice an extended contract:
1. From the Service Contracts Authoring window, select the Summary tab and Parties

subtab, select Open for Update.
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Note: If you do not see the Open for Update button, your
administrator may not have set the status and operations to allow
online updates.

The status of the contract changes to QA hold.

2. To reprice the contract line by line, navigate to the Lines tab and Pricing/Products
subtab.
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3. Select Reprice.

The Repricing Results window appears.

4. Click Apply.

Verify the pricing has been updated. You may also wish to review the billing
streams. The application adds an additional stream level sequence to cover the
extended duration.

Note: Anytime the dates of a contract header, line, or subline are
changed, remember to verify that amounts and billing schedules are
updated or retained as appropriate for the situation.

5. From the Actions menu, select Check QA to run the QA check.

The Quality Assurance Results window appears.

6. Click Continue.
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7. The contract status updates to the original status.

Note: You can also reprice the entire contract, by navigating to the
Summary tab and Pricing/Billing subtab and selecting Reprice.

Extending a Contract Line

To extend a contract line:
1. From the Contract Navigator, select the contract that contains the line to extend.

2. Double click the contract to open the Contract Execution window.

3. Select the Overview tab. The lines of the contract are displayed in the lower portion
of this tab.

4. Highlight the line you wish to extend, right mouse click and select Extend Line.

The Extend Contracts Line window appears.

5. Enter a duration and period.
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6. Click Extend.

7. A decision box appears, indicating the line has been successfully extended.

8. Select Yes from the decision box.

9. Close the Contract Execution window and return to the Contract Navigator.

10. To verify if that the contract line has been extended, return to the Contract Execution
window.

11. Select the line, right click and select refresh.
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How Billing Schedules Are Updated for Extended Contracts
After the contract is extended an additional billing stream sequence appears in the billing
schedule, which covers the extended duration. Depending on the billing schedule, the
total amounts for any unbilled periods are updated to reflect the remaining duration
of the contract.

Billing Schedules for Extended Contracts without Repricing
If you do not reprice the contract, the total amount of the contract remains
unchanged. However for each line, a new billing stream sequence is added with the
same billing period as the preceding stream sequence. The number of periods for the
new billing stream sequence reflects the duration of the extension.

Although the total amount of the contract has not changed, the billing stream sequences
for any unbilled total amounts are also updated to reflect the remaining duration of the
contract. The billing schedule is also updated.

For example, if you have a one year contract with a service line that is priced at $100 and
is scheduled to be billed one time during the one-year duration, and you extend that
contract without repricing it; a second billing stream sequence is added with the same
billing period as the previous billing stream sequence. Because the contract has not
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been billed, the amount for each billing stream sequence is now $50. However, the total
amount of the service line remains $100.

Billing Stream Before Contract Extension

Seq Number
of
Periods

Start
Date

End Date Duration Period Amount Total
Amount

1 1 01-MAR-
2005

28-FEB-
2006

1 Year 100

Billing Stream After Contract Extension

Seq Number
of
Periods

Start
Date

End Date Duration Period Amount Total
Amount

1 1 01-MAR-
2005

28-FEB-
2006

1 Year 50

2 1 01-MAR-
2006

28-FEB-
2007

1 Year 50

Billing Schedules for Extended Contracts with Repricing
If you reprice the contract, the total amount of the contract is updated to reflect the new
pricing. For each line a new billing stream sequence is added with the same billing
period as the previous stream. The number of periods for the new billing stream reflects
the duration of the extension. Because the total amount of the contract has changed, the
billing streams for any unbilled amounts are updated to reflect the new amount and the
new billing stream. The billing schedule is also updated.

For example, if you have a one year contract with a service line that is priced at $100, and
is scheduled to be billed one time during the one-year duration, and you then extend
the contract and reprice the service line to $200; a second billing stream sequence is
added with the same billing period as the previous billing stream sequence. Because
the contract has not been billed, the amount for each billing stream is now $100 and the
total amount of the service line is $200.

Billing Stream Before Contract Extension

Seq Number
of
Periods

Start
Date

End Date Duration Period Amount Total
Amount

1 1 01-MAR-
2005

28-FEB-
2006

1 Year 100

Billing Stream After Contract Extension
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Seq Number
of
Periods

Start
Date

End Date Duration Period Amount Total
Amount

1 1 01-MAR-
2005

28-FEB-
2006

1 Year 100

2 1 01-MAR-
2006

28-FEB-
2007

1 Year 100

Understanding Contract Renewals
Contracts can be renewed either manually or automatically.

You can set up renewal rules that apply to both the manual renewals and the automatic
renewals. See Specifying How a Contract Will Be Renewed, page 2-7.

Renewal types include the following:

• Active Contract, see Understanding How Active Contract Renewals Work, page
14-11.

• Electronic Renewals, see Understanding How Electronic Renewals Work, page
14-12.

• Notify Salesrep, see Understanding How Notify Salesrep Renewals Work, page
14-13.

• Submit for Approval, see Understanding How Submit for Approval Renewals
Work, page 14-13.

• Do Not Renew, see Understanding How Do Not Renew Works, page 14-14.

Regardless of which renewal type you define on a contract, you can either manually
renew the contract or have the contract renew automatically.

The following table provides an overview of how the renewals for each renewal type are
typically initiated:

Renewal Type How is renewal
typically initiated?

Can it be Used
in Automatic
Renewals?

Can it be Used in
Manual Renewals?

Active Contract Automatic renewal Yes Yes

Electronic Renewals Automatic renewal Yes Yes

Notify Salesrep Automatic renewal Yes Yes

Submit for Approval Manual renewal Yes Yes

Understanding How Active Contract Renewals Work
By setting the renewal type of a contract to Active Contract, the contract is renewed in
a status of Active.

Following is a description of how the process works:

• Contract is renewed in Active status.
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With this renewal type, no approval or human intervention is required. It is also
referred to as Evergreen.

This renewal type is mostly used in automatic renewals, but it also can be used for
manual renewals.

See Automatically Renewing a Contract on Expiration, page 2-8.

See Renewing Contracts Manually, page 14-16.

Understanding How Electronic Renewals Work
By setting the renewal type of a contract to Electronic Renewals, an e-mail notification is
sent to the customer to renew the contract over the Web.

The following describes how the process works:

• The contract is renewed with a status of Entered.

• A QA Check is run against the contract.

• If the QA Check fails, a notification is sent. The hierarchy for the notification is as
follows:

• Sales representative, if defined on contract;

• Helpdesk, set up in Global Contract Defaults;

• Contract Administrator, defined in the system profile option OKS: Notify
Contract Administrator;

• Contract Approver, defined in the system profile option OKC: Contract
Approver

• After the contract has been corrected, the contracts administrator can resubmit it, so
it will be picked up by the Autorenew workflow.

• An e-mail notification is sent to the customer. This is the Quote To contact on the
contract. The e-mail contains the following:

• A cover letter, which is defined in OKC Print Contracts Setup

• A URL for customer to view Quote Letter, which is defined in OKC Print
Contracts setup.

• An account and password that are required to log into the web page and view
quote. Account and Password are stored in FND USERS and associated with
the Quote To contact.

Note: The first e-mail sent to the Quote To user, contains a
password in a readable format. For security, the password will
be encrypted in the subsequent e-mails sent to the same user.

• Upon receipt of the e-mail, the customer may log into the web page to review the
quote and accept, reject, or request changes to the contract renewal.

There are two ways for the customer to accept the quote:

• Payment by Credit Card - the customer provides credit card information.

• Payment by PO - the customer provides a PO Number.

The following occurs:
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• The renewal status is updated to Quote Accepted.

• The contract is updated with the credit card or PO number.

• A notification is sent depending on hierarchy.

• An interaction is logged.

• The contract administrator must initiate the approval process by manually
submitting the contract for approval.

• A notification is sent to the contract approver. If the QA Check fails, a notification
is sent to the help desk e-mail account.

• If the quote is rejected a notification is sent and the contract is placed in Canceled
status. The hierarchy for the notification is as follows:

• Sales representative, if defined on contract;

• Helpdesk setup in Global Contract Defaults;

• Contract Administrator;

• Contract Approver

• Changes to the quote may be requested by sending an e-mail to the help desk e-mail
account.

This renewal type is mostly used in automatic renewals, but it also can be used for
manual renewals.

See Automatically Sending a Renewal Notice by E-Mail, page 2-8.

See Renewing Contracts Manually, page 14-16.

Understanding How Notify Salesrep Renewals Work
By setting the renewal type of a contract to Notify Salesrep, a notification is sent to the
Inbox of the sales representative associated with your contract.

The following describes how the process works:

• Contract is renewed in Entered status.

• A notification is sent to the Inbox of the sales representative.

• The sales representative reviews the contract and makes any necessary changes.

• The sales representative submits the contract for approval.

This renewal type is mostly used in automatic renewals, but it can also be used in
manual renewals.

See Notifying the Sales Representative to Renew the Contract Manually, page 2-9.

See Renewing Contracts Manually, page 14-16.

Understanding How Submit for Approval Renewals Work
By setting the renewal type of a contract to Submit for Approval, you can have the
application create a renewed contract and submit it for approval to the person specified
in the system profile OKC: Contract Approver.

The following describes how the process works:

• Contract is renewed in Entered status.
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• The contract is automatically submitted for approval.

• A notification is sent to the person specified in the system profile OKC: Contract
Approver.

This renewal type is mostly used in manual renewals, but it also can be used for
automatic renewals.

Note: If you do not see the Submit button, your administrator may not
have set the status and operations to allow online updates.

See Having the Automatically Renewed Contract Submitted for Approval, page 2-9.

See Renewing Contracts Manually, page 14-16.

Understanding How Do Not Renew Works
By setting the renewal type of a contract to Do Not Renew, you can prevent a contract
from being renewed.

Explaining the Pricing of Renewed Contracts
You can set up renewal rules that apply to both manual renewals and automatic
renewals. Pricing methods specify how the contract will be priced at renewal. There are
three pricing methods:

• Price List: Charges the customer based on the price list you enter in the Price List
field. The price charged is the current price listed in the price list at the time the
contract is renewed.

• Manual: The application retains the price of the original contract for the renewed
contract.

• Markup Percent: Automatically adjusts the price up or down by a percentage you
enter. (A positive number marks up the price; a negative number discounts it.)
Optionally, you can cap the maximum adjustment based on a price list.

For more information on defining pricing methods for renewals, see:

• Specifying How the Renewed Contract will Be Priced, page 2-10.

• Setting Up Defaults for Contract Renewal, page 2-15.

Understanding the Price List Pricing Method
The following is intended to help you understand how the Price List pricing method
works.

A contract using the Price List pricing method has the Corporate price list assigned. For
the original contract the list price of item X is $150. Before the contract is renewed, item X
on the corporate price list is changed to $200. Item X on the renewed contract will be $200.

Understanding the Manual Pricing Method
The following is intended to help you understand how the Manual pricing method
works.

A contract using the Manual pricing method contains item X. For the original contract
the list price of item X is $150. Before the contract is renewed, item X on the price list is
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changed to $200. When the contract is renewed, item X will be $150, not the increased
price of $200.

Understanding Renewal Markup Pricing
The following is intended to provide some scenarios to help you understand how
renewal markup pricing works.

In calculating the amount of a contract for a renewal agreement using Renewal Markup
Pricing, begin with the original year contract Con03. This agreement has a final price
that is comprised of the year 2003 price list plus any discounts or surcharges that are
applied (modifiers).

The contract contains a renewal markup that indicates that the final price of the
contract should be increased or decreased by a certain percentage when that contract is
renewed. Also identified is a renewal price list Cap04. This price list is generally used
to assure that renewal customers are not being asked to pay more for their renewal
agreements after markups than new customers are paying for their original service
contracts.

When renewing the contract, any modifiers carried over from Con03 to the renewal
agreement are applied to the Cap04 list price to calculate the final price. Service
Contracts compares this amount to value of Con03 plus the renewal markup
percentage. The renewal markup value is used unless it exceeds the cap pricing
value. The application, effectively, selects the lower of the two values and that amount
becomes the new contract final price for the renewal agreement.

Example 1: Markup pricing does not exceed cap (using surcharges)

Con03

List price of item X $1,000

Modifier: 10% surcharge

Contract Final price: $1,100

Renewal markup: 5%

Con03R04

Cap List price of item X $1,500

Modifier: 10% surcharge

• Comparison:

Markup Pricing: $1,155

Cap Pricing: $1,650

New Contract Final Price $1,155

Example 2: Markup up pricing exceeds cap (using surcharges)

Con03

List price of item X $1,000

Modifier: 10% surcharge

Contract Final price: $1,100

Renewal markup: 5%
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Con03R04

Cap List price of item X $1,000

Modifier: 10% surcharge

• Comparison:

Markup Pricing: $1,155

Cap Pricing: $1,100

New Contract Final Price $1,100

Example 3: Markup pricing does not exceed cap (using discounts)

Con03

List price of item X $1,000

Modifier: 10% discount

Contract Final price: $900

Renewal markup: 5%

Con03R04

Cap List price of item X $1,200

Modifier: 10% discount

• Comparison:

Markup Pricing: $945

Cap Pricing: $1,080

New Contract Final Price $945

Renewing Contracts Manually

To renew contracts manually:
1. From the Contract Navigator, highlight an active contract.

2. Right mouse click to select Renew.

The Renew Contract window appears with the following fields are populated:

• New Number: new contract number.

• NewModifier: a modifier to differentiate the old and renewed contract.

• New Start date: new start date.
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3. Enter the Duration and Period.

The New End date field populates after you enter the duration and period.

Note: If your contract is a large contract, you may wish to process
the contract in the background. You can do this by selecting the
Submit Request check box.

4. Click Renew.

5. A decision message appears indicating that the contract successfully renewed. Click
Yes to save changes.

The Contract Navigator appears.

6. On the right hand side of the form, right mouse click to select Refresh.

You should be able to identify the contract with the new modifier.

7. On the right hand side of the form, highlight the contract with the New Modifier
from above and right mouse click to select Open.
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Managing the Automatic Renewal Process
There are a number of implementation setups that are required to define and trigger
the renewal process.

Understanding Billing Schedules on Renewed Contracts
If the renewed contract has the same duration as the original contract, a copy is made of
the original contract, which also includes a copy of the billing schedule.

If the renewed contract has a duration that is different than the original contract, then the
billing schedule does not appear on the renewed contract. The renewed contract fails the
QA check because the billing schedule does not adjust itself to the new duration. This
also happens when you renew a one year contract for six months. Even if the renewal
type is Active Contract, the renewed contract stays in Entered status because it fails
the QA check.

If you are considering using the Active Contract renewal type, you should also consider
using billing profiles. When a billing profile is defined in the global defaults, the billing
schedule for the renewed contract is created according to that billing profile.

Consolidating Multiple Contracts for Renewal
Renewing service contracts can be complicated because some organizations will always
sell a full duration service contract the first time, resulting in a single customer having
numerous contracts expiring at different times over the course of a year. This requires
the customer be contacted multiple times per year for renewal confirmation and perhaps
renegotiation, which increases the workload for renewal.

Renewal Consolidation addresses the problem of multiple contracts expiring during a
year (or other given period) causing multiple renewals. With Renewal Consolidation, all
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the contracts to be renewed over a given period are consolidated into a single renewal
contract.

Renewal Consolidation has several benefits:

• The number of renewal contracts is decreased, reducing workload and the difficulties
imposed by large numbers of contracts.

• Customer relationship is improved. All the customer’s services may be included
in a single contract, or several consolidated contracts based on how the contracts
are to be billed.

• It reduces the number of invoices sent to the customer.

The renewal consolidation process is initiated after a contract has been renewed, which
may have been the result of the renewal event where contracts are renewed in mass or
manually renewed from the Contract Navigator using the right mouse click. In both
cases the contract is in the Entered status and is considered the Target contract.

If a contract is not valid for consolidation, you will see the error message Target contract
is invalid. If the target contract is eligible for renewal consolidation, the Renewal
Consolidation window is displayed and is used to facilitate the selection of all the source
contracts for consolidation. The upper half of the window displays all the details of the
target contract. The lower half displays all the eligible source contracts in a tree structure.

The following lines are displayed:

• Service lines

• Sublines or covered levels, for example, Party, Customer, Site, Product, Item, and
System

A contract is eligible as a source contract if the following are true:

• Customer account is the same as the target

• End date plus one day of the potential source contract must be prior to the
new, renewed target contract’s end date

• Potential source contract must be in Active or Expired status

When submitting the renewal consolidation, a concurrent request consolidates all of the
selected source lines into the target contract. If the services are the same on the source
and target contracts, the covered levels of those services can be merged into one contract
line on the target contract.

Merging occurs if the following conditions are met:

• Target and source lines have the same:

• Service Item

• Organization ID

• Renewal Type

• Bill-To site

• Start and End Dates

In addition, setting the profile option OKS: Check Coverage Match to Yes, forces the
renewal consolidation process to preserve differences in coverage.
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The Check Coverage API compares each attribute of the coverage and stops as soon as
one difference is found. It returns the result to the renewal consolidation process. If the
coverage is the same, the sublines of the source contract are merged under the service of
the same name on the target contract. If the coverages are different, a new contract line is
created on the target contract for the service on the source contract.

The Check Coverage API checks the following attributes:

• Coverage Name

• Coverage Type

• Business Processes

• Preferred Resources

The start dates of the consolidated lines begin one day after the expiration of the
original source line and all the end dates coterminate with the target contract. When the
operation instance is reviewed at a later date, that is, after the concurrent request has
processed normally, all the consolidated source lines are identified with ##.

When the renewal consolidation or operation instance is created, a source line is eligible
for consolidation at that point in time. However, between the time it is created and
the time it is submitted, a given source line may have been renewed, whether it be by
consolidation in another operation instance or renewed manually. Therefore, at the time
of submission, the system verifies that the source is still eligible for consolidation. If not
eligible, Oracle Service Contracts excludes the source line from the consolidation.

After consolidation has taken place, the target may be opened to verify that all the
source contracts have been consolidated successfully. The new terms and conditions
may then be reviewed with the customer. Once the customer agrees with its terms
and conditions, the contract may be submitted for approval and billed at the intervals
designated in the contract.

Note: An Extended Warranty line can be consolidated into a
Service line. However, a Service line cannot be consolidated
into an Extended Warranty line. This is because an Extended
Warranty line supports only a product while a Service line supports
party, customer, site, product, item, and system.

To consolidate multiple contracts for renewals:
1. From the Contract Navigator, select a target contract, right mouse click to select

Renewal Consolidation.

The Renewal Consolidation window appears.

Note: The Renewal Rules region references the rules that will be
applied to all lines, which are consolidated into the target contract.
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2. Click Query Source.

If there are no contracts eligible as source contracts for the target contract, the lower
half of the window will remain empty.
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3. To select a line, highlight the branch and click Select Line.

If selected the source line is identified with **.

4. To deselect a line, highlight the branch and click Deselect Line.

If a branch with child branches is deselected, all the child branches are also
deselected.

A single child branch may be deselected, as required. If deselected, the source line(s)
are no longer identified with a **.

You can reselect the Source lines by highlighting the line and clicking the Select
Line button.

Note: If a source contract is deselected and the operation instance
is submitted for renewal consolidation, it may be selected at a later
time for consolidation in the same target contract as long as the
target is still in Entered status. If the target contract has already
been approved and activated, the contract may be consolidated as a
source in another target contract.

5. Verify source lines are valid for consolidation.

6. To save and retrieve the consolidation at a later review, click Save. You can leave this
window and when your changes are reflected in the Renewal Consolidation window.

7. To submit the Renewal Consolidation, click Submit.

A Note window with a concurrent request id appears.

8. Save.
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You can refresh the window by clicking Refresh Source to monitor the
processing. After the line has been consolidated the ## appears next to the
line, which indicates Processed.

9. Open the target contract and verify all source contracts have been consolidated
successfully.

10. Submit contract for approval.

Sending Quote Letters by E-mail
You can generate quote letters and e-mail them to a customer as part of the renewal
process. The person who receives this e-mail quote is specifically identified on the
Summary Renewals tab.

Prerequisites

The following profile options must be set up in order to use the e-mail Quote
functionality:

• OKS: Wallet Path

• OKS SMTP Host

• OKS: SMTP Port

To send quote letters by e-mail:
1. From the Service Contracts Authoring window, choose the Tools menu and select

Email Quote.

The Email Quote window appears.

The To field defaults from the Quote To field in the Summary Renewals tab. Enter a
Reply To/Copy e-mail address of the sales representative or other individual who
should be copied or replied to about this e-mail. This field is free-format text.

You can use different From and Reply To e-mail addresses depending on which
address the e-mail should come from, and which address you wish to route the
e-mail replies.
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2. In the addresses region, add additional recipients as desired.

3. In the message region, enter any text that you wish to appear in the body of the
e-mail.

4. In the Attachments region, select the quote printing report.

The reports are specific to the environment.

This report summarizes the contents of the renewal contracts.

5. Click Send.

A Note window indicating a concurrent request has been submitted appears.

See also Creating and Enabling Templates for E-Mails to Customers, page 15-3.
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15
Creating and Enabling Templates for E-Mails

to Customers

This chapter covers the following topics:

• About Templates for E-Mails to Customers

• Overview of Templates for E-Mails to Customers

• Creating and Enabling Templates for E-mail Attachments Sent by Agents

• Creating and Enabling Templates for Communications Generated by Electronic
Renewals

• Contract-Specific Data Available for Inclusion in Template Documents

• Viewing the Data Definition Structure

• Uploading and Registering a Template in Oracle XML Publisher

• Creating the Set of Templates Used for a Specific Renewal Flow

• Specifying How the Template Sets Are to Be Used

• Viewing PDF Attachments

• Viewing Sample Marked-Up Documents Provided with the Application

About Templates for E-Mails to Customers
This group of topics explains how application administrators can take advantage of the
Oracle Service Contracts integration with Oracle XML Publisher to create and enable
templates for personalized e-mail communications with customers.

Overview of Templates for E-Mails to Customers, page 15-1 describes the two types
of e-mail communications you can create. The topics that follow provide the general
steps for creating each:

• Creating and Enabling Templates for E-mail Attachments Sent by Agents, page 15-3

• Creating and Enabling Templates for Communications Generated by Electronic ,
page 15-3

Overview of Templates for E-Mails to Customers
Using the procedures in this section, you can create templates for e-mail communications
with customers that can be used:
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• By agents to send quotes and other communications as e-mail attachments

• For e-mail renewal notices generated automatically during electronic renewals

About E-mail Attachments Sent by Agents to Customers
Agents can send e-mails to contacts from the Service Contracts Authoring window by
choosing E-Mail Quote from the Tools menu. The agent types the e-mail address, the
subject, and the body, and can attach a PDF communication that is automatically
generated from the template you create using the procedures in this section.

This PDF can be either a report about the current contract, or any other communication
such as a general announcement.

About E-mails Generated by Electronic Renewals
You can also have the automatic renewal process use the template for one or more of the
e-mail communications generated by the automatic renewal process. These are:

• An initial renewal notification (called a Cover Letter in this application) (HTML)

• One or more reminder notices (HTML)

• One or more cancellation notices (HTML)

• The PDF attachment sent with all of the above e-mails (called a Quote Letter in
this application)

For each e-mail communication, the application generates an HTML e-mail body from
the template and attaches the PDF attachment.

The subject line for each e-mail type is preset and cannot be modified. The following
table lists the subject lines for the three types of e-mail communications:

E-mail Communication Type Automatically-generated Subject Line Text

Cover letters Contract <contract number and modifier>
requires your approval.

Reminder notices Reminder notice for contract <contract number
and modifier>.

Cancellation notices Cancellation notice for contract <contract
number and modifier>.

The application sends all communications to the e-mail address the agent enters into the
contract authoring window (the Quote To region of the Summary tab, Renewals subtab).

You can create multiple sets of templates for use on different dates, by different internal
organizations, or targeted to different customers.

Process Overview
You must complete the following two steps to create both e-mail attachments and
electronic renewal communications:

1. Create the template documents, using Microsoft Word (or another application
capable of saving files in the RTF format), following the procedures described in
the Oracle XML Publisher User’s Guide.
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In the document you can embed codes (XML data elements) which the application
uses to supply contract-specific information including:

• Details about the contract

• The URL the customer can use to log into an application-generated Web
page. There they can review the quote, indicate their acceptance, or request
changes.

• The user name and password for the login.

For a complete list of contract data you can include see Contract-Specific Data
Available for Inclusion in Template Documents, page 15-4. You can view
sample documents provided with this application by following the instructions
described in Viewing Sample Marked-Up Documents Provided with the
Application, page 15-20.

2. Upload the document and register it as a template in Oracle XML Publisher. See
Uploading and Registering a Template in Oracle XML Publisher, page 15-15 for
details.

To create templates for e-mails sent automatically by the electronic renewals feature of
this application you must also complete these two additional steps:

1. Specify the set of templates that are going to be used for a specific renewal flow. See
Creating the Set of Templates Used for a Specific Renewal Flow, page 15-17.

2. Specify how the template set is to be used. See Specifying How the Template Sets
Are to Be Used, page 15-18.

Creating and Enabling Templates for E-mail Attachments Sent by Agents
Prerequisite

Confirm system profile OKS: Layout Template Source is set to XML Publisher at the
Site level.

To create and enable templates for e-mail attachments sent by agents:
1. Create the RTF document according to the procedures in the Oracle XML Publisher

User’s Guide.

2. Change responsibility to XML Publisher Administrator.

3. Upload and register the document as a template in Oracle XML Publisher. See
Uploading and Registering a Template in Oracle XML Publisher, page 15-15.

The document is now available for agents to send as a PDF attachment when they
send out an e-mail from the Oracle Service Contracts Authoring window.

Creating and Enabling Templates for Communications Generated by
Electronic Renewals

You can create and enable the templates the electronic renewal process uses to generate
e-mail communications with the customer.

Note: Electronic renewals are available only for contracts of categories
Service and Warranty and Extended Warranty.
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To create and enable templates for communications generated by electronic renewals:
1. Create the RTF document according to the procedures in the Oracle XML Publisher

User’s Guide.

2. Change responsibility to XML Publisher Administrator.

3. Upload and register the document as a template in Oracle XML Publisher. See
Uploading and Registering a Template in Oracle XML Publisher, page 15-15.

4. Change responsibility back to Service Contracts Manger.

5. Group the templates into sets and specify when renewal and cancellation notices are
to be sent. Creating the Set of Templates Used for a Specific Renewal , page 15-17.

6. Specify how you wish to use the template sets. See Specifying How the Template
Sets Are to Be Used, page 15-18.

7. Optionally, you can preview the communications generated by the template set for a
specific contract, for a party, or for an entire internal organization by running the
Generate Quotes concurrent program. See Viewing PDF Attachments, page 15-19.

Contract-Specic Data Available for Inclusion in Template Documents
The data definition supplied by Oracle, OKSCONDATA, makes it possible for you to
include information about the following aspects of the contract in the e-mail body or
PDF quote attachment:

• Basic contract information from the contract header

• Recipient of e-mails generated by the electronic renewal process

• Sales agent on the contract

• Customer name and number

• Default contract billing schedule

• Contract billing address

• Contract shipping address

• Contract taxes

• Contract line information

• Contract line taxes

• Contract line billing schedule

• Contract line billing contact

• Contract sublines (what the line covers)

• Login information for the URL for customer renewals

• Current date

• Contract payment terms

Note: For this release, you are restricted to the data definition
provided by Oracle. You can view the structure of the data
definition by following the procedure described in Viewing the Data
Definition Structure, page 15-14.
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Contract Header
The following table lists XML data elements you can use to insert information from
the contract header (basic information about the contract the agent enters at the top of
the Service Contract Authoring window).

You must preface any of the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/

For example, to insert the contract number into your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/ContractNumber

Contract Header Field XML Data Element

Contract Number ContractNumber

Contract Modifier ContractModifier

Start Date StartDate

End Date EndDate

Status Status

Short Description ShortDescription

Currency Currency

Contract Amount ContractAmount

Electronic Renewal Recipient Information
The following table lists the XML data elements for inserting information about the
recipient of electronic renewals communications.

Agents enter this information in the Quote To region of the contract. This region is found
either on the Summary tab, Renewals subtab of the Service Contracts Authoring window
or, if you are generating contracts automatically from Oracle Order Management, in the
Contract Details window.

Note: Some of the XML data elements are derived from information
entered by agents in applications other than Oracle Service
Contracts. For example, address details are entered in Oracle
TeleService, Oracle Receivables, Oracle TeleSales and other applications.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/QuoteToContDtlsVO/QuoteToCo
ntDtlsVORow/

For example, to insert the full name of the recipient into your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/QuoteToContDtlsVO/QuoteToCo
ntDtlsVORow/FirstLast
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Quote to Contact Attributes XML Data Element

First Name FirstName

Middle Name MiddleName

Last Name LastName

Full Name FirstLast

Job Title JobTitle

Phone Area Code PhoneAreaCode

Phone Number PhoneNumber

Email EmailAddress

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

Postal Code PostalCode

State State

Sales Agent Information
The following table lists the XML data elements for information you can insert in your
documents regarding the sales agent on the contract.

This sales agent can be:

• The vendor contact of role Salesperson entered on the Summary tab, Parties subtab
of the Service Contracts Authoring window.

• If you are using Oracle Order Management to create contracts, the sales agent in
the Sales Order window.

• Assigned by the application automatically if your organization has implemented
territories.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/SalesRepVO/SalesRepVORow/

For example, to insert the full name of the sales agent into your document youmust enter:

/ContractDetails/HeaderVO/HeaderVORow/SalesRepVO/SalesRepVORow/Fu
llName
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Sales Representative Attributes XML Data Element

First Name FirstName

Middle Name MiddleName

Last Name LastName

Full Name FullName

Phone Area Code PhoneAreaCode

Phone Number PhoneNumber

Email EmailAddress

Job Title JobTitle

Manager Name ManagerName

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

Postal Code PostalCode

State State

Customer Name and Number
The following table lists the XML data elements for the customer name and number you
can insert in your documents. The customer for the contract is the party of role customer.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/CustomerVO/CustomerVORow/

For example, to insert the customer name into your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/CustomerVO/CustomerVORow/Pa
rtyName

Customer Attributes XML Data Element

Party Number PartyNumber

Party Name PartyName

Default Contract Billing Schedule Information
The following table lists the XML data elements you can use to insert information on the
default billing schedule.
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Agents set up the default billing schedule on the Summary tab, Pricing/Billing subtab of
the Service Contracts Authoring window. Agents use this contract-level billing schedule
to default schedules to contract lines, so entry is optional.

If you have only one billing period in the schedule, preface the XML data elements
with the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillSchdVO/HdrBillSchdVO
Row/

For example, to insert the date of start date of the billing period in your document you
must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillSchdVO/HdrBillSchdVO
Row/StartDate

If your billing schedule has multiple billing periods, follow the instructions described
in the Oracle XML Publisher User’s Guide.

Header Billing Schedule Attributes XML Data Element

Start Date StartDate

End Date EndDate

Invoice Date TransactionDate

Interface Date DateToInterface

Amount Amount

Contract Billing Address
The following table lists the XML data elements for contract billing address
information. Agents select the billing address in the Bill To region of the Summary
tab, Parties subtab. The address itself must be entered in other applications.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToAddrVO/HdrBillToAd
drVORow/

For example, to insert the city in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToAddrVO/HdrBillToAd
drVORow/City
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Header Bill To Address Attributes XML Data Element

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

Postal Code PostalCode

State State

Province Province

County County

Contract Billing Contact Information
The following table lists the XML data elements you can use to insert information about
the contract’s billing contact. Agents enter the billing contact by entering a customer
or a third party contact with the role of Billing in the Contact region of the Summary
tab, Parties subtab.

You must preface the XML data elements with the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToContDtlsVO/HdrBill
ToContDtlsVORow/

For example, to insert the last name of the contact in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrBillToContDtlsVO/HdrBill
ToContDtlsVORow/LastName

Header Billing Contact Attributes XML Data Element

First Name FirstName

Last Name LastName

Phone BillToPhone

Fax BillToFax

Email BillToEmail

Contract Shipping Address
The following table lists the XML data elements for the contract shipping address
information. Agents select the shipping address in the Ship To region of the Summary
tab, Parties subtab. The address itself must be entered in other applications.

You must preface the XML data elements with the following string:
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/ContractDetails/HeaderVO/HeaderVORow/HdrShipToAddrVO/HdrShipToAd
drVORow/

For example, to insert the city in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/HdrShipToAddrVO/HdrShipToAd
drVORow/City

Header Ship to Address Attributes XML Data Element

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

State State

Province Province

County County

Postal Code PostalCode

Contract Taxes
To enter the amount of taxes for the contract as a whole into your document, then enter
the following string:

/ContractDetails/HeaderVO/HeaderVORow/HdrTaxAmountVO/HdrTaxAmount
VORow/TaxAmount

The contract tax amount is calculated by the application and appears in the Tax field on
the Service Contracts Authoring window header.

Contract Line Information
The following table lists the XML data elements you can use to insert information about
the lines in your contract.

If you have only one contract line, preface the XML data elements with the following
string:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/

For example, to insert the name of the service, usage, or subscription in your document
you must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/Name
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To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.

Contract Line Attributes XML Data Element

Line Number LineNumber

Line Name Name

Start Date StartDate

End Date EndDate

Line Amount LineAmount

Contract Line Taxes
If you have only one line in your contract, you can display the tax for that line in your
document, by entering the following string and the XML data element:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineTaxA
mountVO/LineTaxAmountVORow/TaxAmount

To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.

Contract Line Billing Schedule
The following table lists the XML data elements you can use to enter information about
billing schedules for individual contract lines into your document.

If you have only one line in your contract, preface the XML data elements with the
following string:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
SchdVO/LineBillSchdVORow/

For example, to insert the date of the invoice in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
SchdVO/LineBillSchdVORow/TransactionDate

To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.

Line Billing Schedule Attributes XML Data Element

Start Date StartDate

End Date EndDate

Invoice Date TransactionDate

Date To Interface DateToInterface

Amount Amount
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Line Billing Contact
The following table lists the XML data elements you can use to enter into your document
billing contact information for individual contract lines. Agents enter the billing contact
by entering a customer contact of role Billing Contact on the Lines Tab, Accounts subtab
of the Service Contracts Authoring window.

If you have only one contract line, then preface the XML data elements with the
following string:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
ToContDtlsVO/LineBillToContDtlsVORow/

For example, to insert the name of the contact in your document you must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/LineBill
ToContDtlsVO/LineBillToContDtlsVORow/Name

To insert information from multiple lines, follow the instructions described in the Oracle
XML Publisher User’s Guide.

Line Billing Contact Attributes XML Data Element

Name (first and last name) Name

Email Email

Address1 Address1

Address2 Address2

Address3 Address3

Address4 Address4

City City

State State

Province Province

County County

Postal Code PostalCode

Sublines
The following table lists the XML data elements you can use to enter information about
sublines. For service lines, this is what the service covers (for example, a product, or a
customer site). For usage lines, this is the individual counter used to track usage.

If you have only one subline in your contract, then preface the XML data elements with
the following string:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/SubLines
VO/SubLinesVORow/
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For example, to insert the level of coverage for a service line in your document you
must enter:

/ContractDetails/HeaderVO/HeaderVORow/LinesVO/LinesVORow/SubLines
VO/SubLinesVORow/CoveredLevel

To insert information from multiple sublines, follow the instructions described in the
Oracle XML Publisher User’s Guide.

SubLine Attributes XML Data Element

SubLine Number SubLineNumber

Name Name

Covered Level CoveredLevel

Start Date StartDate

End Date EndDate

Quantity Quantity

UOM Uom

SubLine Amount SubLineAmount

Login Information for Electronic Renewals
The following table lists the XML data elements you can use to include in your document
information users can use to log into an automatically generated HTML page where
they can review and renew their contract.

The URL for that page must be entered by the application administrator in the system
profile OKS: Electronic Renewals URL.

The application automatically creates a user name and password which you can insert
in the renewal e-mail by including the XML names tags listed below. If you include
the password tag name, the application sends the automatically generated password
with the first communication to the customer and encrypts the password as a series of
stars in all subsequent e-mails.

You must preface the XML data elements with the following string:

/ContractDetails/

For example, to insert the user name into your document you must enter:

/ContractDetails/UserName

Web UI Login Attributes XML Data Element

User Name UserName

Password Password

Web UI Login URL WebUILoginURL
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Current Date
To insert the current date (sysdate) into your document, then enter the following string
as the XML tag name:

/ContractDetails/HeaderVO/HeaderVORow/ReportGeneratedDate

Contract Payment Terms
To insert the contract payment terms into your document, then enter the following
string as the XML tag name:

/ContractDetails/HeaderVO/HeaderVORow/PayTermVO/PayTermVORow/Paym
entTerms

Viewing the Data Denition Structure
You can display a sample document with all of the available data elements.

To view the data denition structure:
1. Log into Oracle Applications under the XML Publisher Administrator responsibility.

2. Click Data Definitions in the Navigator.

The Data Definitions search page appears in a new browser window.

3. Enter Service Contracts in the Application field.

4. Click Go.

5. Select the Service Contract Data link.

The View Data Definition page appears.
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6. Click the OKSCONDATA.xml link in the Preview Data field to view or save the file.

Uploading and Registering a Template in Oracle XML Publisher
This step is required to use your document for electronic renewals.

Prerequisite

Create the template as an RTF document.

To upload and register a template in Oracle XML Publisher:
1. Log into Oracle Applications under the XML Publisher Administrator responsibility.

2. Click Templates in the Navigator.

The Templates search page appears in a new browser window.

3. Click Create Template.

The Create Template page appears.
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4. In the Name field, enter a user-friendly name for your template.

5. In the Code field, enter a code (no longer than 10 characters) for the
template. start with this product’s short code (OKS) and a descriptive ending. For
example: OKS_cover.

6. Choose Service Contracts from the Application LOV.

7. Choose OKSCONDATA from the Data Definition LOV. This is the data definition
supplied by Oracle. In this release, you are restricted to using this data definition
only.

8. Choose RTF from the Type LOV.

9. In Start Date, enter the date from which the template will be active.

10. In the End Date, enter the date when this template becomes inactive. This is optional.

11. Sub-templates are not supported in this release.

12. Optionally, enter a description in the Description field.

13. Click Browse and select the RTF template file.

14. Choose the language of the template you have uploaded from the Language LOV.

15. Language territories are not supported in this release, so you can leave the Territory
field blank.

16. Click Apply.

17. You can preview a PDF of your template to validate your work by navigating to the
View Template page and selecting the Preview icon. See the Viewing and Updating
section of the Oracle XML Publisher User’s Guide for details.
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Creating the Set of Templates Used for a Specic Renewal Flow
In the template set, you specify which RTF template is used for which
communication. For reminder and cancellation notices, you also specify when they will
be sent. For example, you may wish to send one renewal reminder 30 days before the
contract expires and, if the customer does not respond, send out another 15 days before
expiration. If the customer has not responded two weeks after the expiration date, you
may wish to send a reminder that the contract is being cancelled.

You can set up just one template set to be used for communications for all renewals. Or
you can set up different sets to go to different customers or to be used by different
organizations within your company.

This step is required to use your document for electronic renewals.

Prerequisites

Create and upload into Oracle XML Publisher RTF templates for:

• The cover letter (the HTML body of the initial renewal e-mail)

• The quote letter (the PDF attachment)

Reminder and cancellation notices are optional.

To create the set of templates used for a specic renewal ow:
1. Navigate to Setup > Define Electronic Renewal Template.

The Template Set window appears.

2. Enter a name for the template set in the Name field.

3. Optionally, enter a start and end date to restrict the availability of this template set.

4. Using the Quote Letter LOV, choose the Oracle XML Publisher template the
application will use to generate the PDF attachment sent with every e-mail to the
customer.

5. Using the Cover Letter LOV, choose the Oracle XML Publisher template the
application will use to generate the HTML body for the initial renewal e-mail.

6. To send one or more reminder notices if the contact does not reply to the initial
e-mail. Then for each reminder notice:

1. Choose Reminder Notice from the Report Type LOV.

2. From the Report Name LOV, choose the template the application will use to
generate the HTML body of the reminder.

3. To restrict the use of this reminder to a specific time period, then enter a start
date, an end date, or both.

4. Specify when you wish the reminder to be sent in relationship to the start date
of the renewed contract. This is done by entering a negative number in the
Duration field and choosing the time unit of measure from the Period LOV. For
example, to send the reminder two weeks before the start date of the renewed
contract, then enter -2 as the duration and chooseWeek as the period.

5. You can have the application reset the status of the contract after the notice is
sent. To do so, choose a status from the Status LOV.

You can set a contract to any status of type Entered.
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7. To send one or more cancellation notices to the contact if the customer does not
renew the contract the end date, then, for each cancellation notice:

1. Choose Cancellation Notice From the Report Type LOV.

2. From the Report Name LOV, choose the template the application will use to
generate the HTML body of the cancellation notice.

3. To restrict the use of this cancellation notice to a specific time period, then enter
a start date, an end date, or both.

4. Specify when to send the cancellation notice in relationship to the planned start
date for the renewed contract. This is accomplished by entering a positive
number in the Duration field and choosing the time unit of measure from the
Period LOV. For example, to send the cancellation notice two weeks after the
planned start date of the renewed contract, then enter 2 as the duration and
chooseWeek as the period.

5. You can have the application reset the status of the contract after the cancellation
notice is sent. To do so, choose a status from the Status LOV.

You can set a contract to any status of type Cancelled.

Note: The application must periodically run the concurrent
request Service Contracts Autoreminder program to send
reminder and cancellation notices.

Specifying How the Template Sets Are to Be Used
You can:

• Specify a single template set for all electronic renewals, the global level.

• Specify different template sets for use by different organizations within your
company.

• Specify different template sets to be used for different individual customers.

The application looks for an appropriate template set from the most specific to the
global. If the application does not find a template set specified at the customer level, it
looks at the organization level, if none is found at the organization level either, it uses
the template specified at the global level.

For example, if you specify Set 1 of renewal e-mail communications to be used at the
global level, and specify Set 2 to be used for customers A and B. Then any contract for
customers A and B will use Set 2, and contracts for all other customers will use Set 1.

Note: For electronic renewals to work, you must at least associate a
template set at the global level.

Prerequisite

Create the template sets used to generate the renewal communications.

To specify how the template sets are to be used:
1. Navigate to Setup > Global Contracts Defaults.

The Global Contracts Defaults window appears.
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2. Choose a template set to be used for electronic renewals at the global level using the
Template Set LOV in the Global region at the top of the window.

3. To specify different template sets for individual customers, then for each customer:

1. Select the Parties Tab and Electronic Renewal subtab.

2. Choose the customer from the Party Name LOV.

3. Choose the template set from the Template Set LOV.

4. To specify different template sets for organizations in your own company, then
for each organization:

1. Select the Organizations tab and Electronic Renewal subtab.

2. Choose the organization from the Organization Name LOV.

3. Choose the template set from the Template Set LOV.

5. Save.

Viewing PDF Attachments
The application automatically generates and e-mails the PDF attachment with every
electronic renewal communication. You can view the PDF to be sent for a single
contract, all the PDFs being sent to a customer, or all the PDFs generated for an internal
organization.

To view PDF attachments:
1. Navigate to Control > Requests > Run.

The Submit a New Request window appears.

2. Select the Single Request radio button.

3. Click OK.

The Submit Request window appears.

4. Enter Generate Quote in the Name field using the LOV.

The Parameters window appears.

5. Choose the template set name from the Quote Template LOV.

6. Enter any of the following to limit the number of contracts to be generated:

Note: If you do not enter any values, the application generates the
communications for the entire database of contracts.

• To generate communications for an internal organization, then enter the
organization name using the Org LOV.

• For a single customer, choose the customer from the Party LOV.

• For a single contract, choose the contract number from the Contract Number
LOV.

7. Click OK to exit the Parameters window.

8. Click Submit.

Creating and Enabling Templates for E-Mails to Customers 15-19



The Decision window appears with the identification number of the request you
have submitted. Use this number to monitor the progress of your request.

9. Click No if you do not wish to submit another request.

10. Choose Requests from the View menu.

The Find Requests window opens.

11. Click Find to find the requests you have submitted.

The Requests window appears showing the status of your concurrent requests.

The Generate Quotes process you have submitted automatically launches the Service
Contracts Quote request. Both have to complete successfully for the communications
to be generated successfully.

12. Place your cursor in the line displaying the Service Contracts Quote process status.

13. Click View Output to display the generated communications in a separate browser
window.

Viewing Sample Marked-Up Documents Provided with the Application
Oracle supplies sample templates in Oracle XML Publisher with XML name tags already
embedded.

To view the sample documents provided with the application:
1. Log into Oracle Applications under the XML Publisher Administrator responsibility.

2. Click Templates in the Navigator.

The Templates search page appears in a new browser window.

3. Enter %sample% in the Name field.

4. Choose Service Contracts from the Application LOV.

5. Click OK.

6. The window displays the sample documents.

7. To download a document:
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1. Select a link in the Name column.

The View Template page opens.

2. Click Download.
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16
Terminating Contracts

This chapter covers the following topics:

• Overview of Terminating Contracts

• About Terminating Contracts

• How Termination Works?

• Terminating a Contract

• Restrictions for Terminating a Contract

• Terminating a Contract Line

• Terminating a Contract Subline

• Terminating Multiple Contracts at the Same Time

• Viewing the True Value of a Contract

• About Prorating Terminated Contracts

Overview of Terminating Contracts
This group of topics explains how you can terminate contracts, contract lines, and
contract sublines.

About Terminating Contracts
You can terminate a contract, a contract line, or a contract subline. The termination date
must fall between the start and end date of the service or services being terminated. You
cannot terminate a service or contract that has already been terminated. For example, if
you have a future Date Terminated, you cannot change it to an earlier date.

You can terminate multiple contracts and contract lines at one time.

During the termination process a credit amount is calculated by the system. You have
the ability to:

• override the credit

• provide a full credit

• suppress the credit
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How Termination Works?
The following describes various termination scenarios. These scenarios will help you
understand the termination methods that can be used and their impact on the true value
of the contract. See Viewing the True Value of a Contract, page 16-11.

Assumptions for all examples: Your customer has a one year contract valued at
$1,200. The contract start date is December 1 and the termination date is March 1. The
contract has two billing periods, which bill in advance. Billing period 1 has been
billed, billing period 2 has not.

Override the credit example : The customer is due a credit of $300, which is for the
unused portion of the billed amount. However, you and the customer have mutually
agreed to deduct $100 from the credit.

An override amount of $200 is entered during the termination. The customer is issued a
credit of $200.

The contract total is updated to $400 and the terminated amount is updated to $800. The
terminated amount is equal to the override amount plus the unbilled amount in billing
period 2.

Provide a full credit example: The customer is due a credit of $300, which is for the
unused portion of the billed amount. Because this is a very good customer, you allow a
credit for the full amount, not just the unused portion.

The full amount is $600 for the billed amount. The customer is issued a credit of
$600. The contract total is updated to $0 and the terminated amount is updated to
$1,200. The terminated amount is equal to the full credit amount plus the unbilled
amount in billing period 2.

Suppress the credit example: the customer is due a credit of $300. However, the contract
is being terminated for a breach and your company policy is that credit is not issued
when there is a contract breach.

You can suppress the credit, so that the customer receives no credit, which ensures the
credit is not processed by Accounts Receivable. The contract total is updated to $300
and the terminated amount is updated to $900. The terminated amount is equal to the
amount suppressed plus the unbilled amount in billing period 2.

Terminating a Contract

To terminate a contract:
1. From the Contract Navigator, highlight the contract you wish to terminate.
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2. From the Tools menu, select Terminate.

The Terminate Contracts window appears.

3. Select the following:

• Date: the termination date, which must be within the contract start and end
dates.

• Reason: the reason for terminating the contract.

Your administrator can define reasons by navigating to Setup > Contracts >
Termination Reasons.

4. Select Review.

If the customer is due a credit for amounts paid prior to the termination date, the
credit amount, which is prorated based on the Date Terminated and the amount
billed, appears in the Amount field.

5. Optionally, you can use the Override Amount field to override the calculated amount.

The amount entered for override cannot be negative or more than the original
credit. Entering zero in the Override field will not prevent a credit memo from being
generated; it will generate a credit memo for zero dollars.

6. To issue a full credit during termination, check the Full Credit checkbox.
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The Amount field displays the total amount that was billed for contract at the time of
termination.

Note: The Full Credit check box gives you greater flexibility to
control the credit amount. You can also use this check box in
situations where you wish to credit more than the prorated amount
but not the full credit amount, by selecting the Full Credit checkbox
and then entering a value in the Override Amount field.

For example, if the prorated amount is $500 and the Full Amount
is $1,000 and you wish to credit $800, you can select the Full Credit
check box and enter $800 in the Override Amount field.

7. If you do not wish to generate a credit memo, check the Suppress Credit checkbox.

Note: If credits are suppressed in error, you can run the Service
Contracts Program to Process Suppress Credits. This program
allows users to generate credits for contract terminations for which
credits have been suppressed. See About Concurrent Programs,
page 18-7.

8. Click Terminate.

9. A Decision window appears, indicating the contract was successfully
terminated. Click Yes to save your changes.

Note: After you terminate the contract, you can run the Main Billing
program to generate the necessary billing transactions as a result
of the termination.

Restrictions for Terminating a Contract
Be aware of the following restrictions relating to the contract status. If the contract
status is:

• QA Hold: You cannot perform a termination.

• Hold: You can perform a termination irrespective of the status and operation
setting, Eligible for Invoicing.

• All Other Statuses: You cannot perform a termination if the status and operation
setting, Eligible for Invoicing, is not enabled.
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Terminating a Contract Line

To terminate a contract line:
1. From the Contract Navigator, double click the contract.

The Contract Execution window appears.

2. From the Overview tab, highlight the contract line you wish to terminate. You can
select multiple lines if you wish.

3. Right click the mouse, and select Terminate Line.

The Terminate Contract Lines window appears

4. Select the following:

• Date: the termination date, which must be within the contract start and end
dates.

• Reason: the reason for terminating the contract line.
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5. Select Review.

If the customer is due a credit for amounts paid prior to the termination date, the
credit amount appears in the Amount field.

6. Optionally, you can use the Override Amount field to override the calculated amount.

7. To issue a full credit during termination, check the Full Credit checkbox.

The Amount field displays the total amount that was billed for the line at the time of
termination.

8. If you do not wish to generate a credit memo, check the Suppress Credit checkbox.

Note: If credits are suppressed in error, you can run the Service
Contracts Program to Process Suppress Credits. This program
allows users to generate credits for contract terminations for which
credits have been suppressed. See About Concurrent Programs,
page 18-7.

9. Click Terminate.

A Decision window appears, indicating the contract line was successfully
terminated. Click Yes to save your changes.

The Status Meaning for the line shows as Terminated.
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Note: After you terminate the contract line, you can run the Main
Billing program to generate the necessary billing transactions as a
result of the termination.

Terminating a Contract Subline

To terminate a contract subline:
1. From the Service Contracts Authoring window, select the Line tab, Pricing/Products

subtab, and the Effectivity secondary tab, then choose the subline to terminate.
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2. From the Tools menu, select Terminate Subline.

The Terminate Sublines window appears.

3. Select the following:

• Date: the termination date, which must be within the contract start and end
dates.

• Reason: the reason for terminating the contract subline.

4. Select Review.

If the customer is due a credit for amounts paid prior to the termination date, the
credit amount appears in the Amount field.

5. Optionally, you can use the Override Amount field to override the calculated amount.

The amount entered for override cannot be negative or more than the original
credit. Entering zero in the Override field will not prevent a credit memo from being
generated; it will generate a credit memo for zero dollars.

6. To issue a full credit during termination, check the Full Credit checkbox.

The Amount field displays the total amount that was billed for the covered level or
usage at the time of termination.

7. If you do not wish to generate a credit memo, check the Suppress Credit checkbox.
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8. Click Terminate.

Terminating Multiple Contracts at the Same Time

To terminate multiple contracts at the same time:
1. From the Contracts Navigator, highlight the contracts to terminate.

To select multiple contracts hold down the Control key and select the contracts you
wish to delete. To select a block of rows, select the first contract row, hold down the
Shift key, and then select the last contract row.

2. From the Tools menu, select Terminate.

The Terminate Contracts window appears.

3. Select the following:

• Date: the termination date, which must be within the contract start and end
dates.

• Reason: the reason for terminating the contract.

4. Select Preview.
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The Selected Contracts for Termination region appears with a listing of the contracts
that you have selected to be terminated.

5. Confirm whether the customer is due a credit for amounts paid prior to the
termination dates. The amount is indicated in the Amount field for each associated
contract number.

6. Optionally, you can use the Override Amount field to override the calculated amount.

The amount entered for override cannot be negative or more than the original
credit. Entering zero in the Override field will not prevent a credit memo from being
generated; it will generate a credit memo for zero dollars.

7. For each contract, you can enter a different:

• Termination Date

• Reason

8. To issue a full credit during termination, check the Full Credit checkbox for the
associated contract number.

The Amount fields display the total amount that was billed for the associated
contract number at the time of termination.

9. If you do not wish to generate a credit memo, check the Suppress checkbox for
the associated contract number.

Note: If credits are suppressed in error, you can run the Service
Contracts Program to Process Suppress Credits. This program
allows users to generate credits for contract terminations for which
credits have been suppressed. See About Concurrent Programs,
page 18-7

10. Click Terminate.

A Decision window appears, indicating the contracts were successfully
terminated. Click Yes to save your changes.
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Note: After you terminate the contracts, you can run the Main
Billing program to generate the necessary billing transactions as a
result of the terminations.

Viewing the True Value of a Contract
When you terminate a contract, a contract line, or a subline, the contract Total in the
header is automatically adjusted to reflect the terminated amount.

To view the true value of a contract:
1. From the Service Contracts Authoring window, review the following in the header:

• Total: reflects the true value of the contract incorporating any price adjustments
or credits that have been applied to the contract.

• Terminated: reflects a sum of the following after a termination is submitted:

• the unbilled amount for the original contract

• the termination credit issued

• any termination amounts that were suppressed

2. Alternatively, navigate to the Summary tab and Pricing/Billing subtab.

3. Select Billing.

The Billing window appears.

4. Review the following:

• Amount: reflects the true value of the contract.

• Total field in the terminated region: reflects the amount credited, after the
termination was submitted.

• Billed: reflects the amount originally billed.

About Prorating Terminated Contracts
If a contract is terminated during a billing period, credits are prorated by the
application. The calculation of the prorated amount varies among line types. Following
are descriptions of how the prorated amount is handled for each line type.

Service Lines
For service lines, the line is prorated based on the date terminated and the amount
billed. For example, if $100 was billed for April, and the line was terminated in the
middle of the month, a $50 credit is due.
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For information on service lines, see About Service Lines, page 4-2.

Usage Lines
For usage lines, you must define the termination method that the application will use to
calculate the usage and credit the customer upon termination. You can choose between
the Amount Based Termination and Counter Based Termination method.

Amount Based Termination

Charges the customer based on the amount of usage recorded when the contract is
terminated. The customer is charged based on the actual usage. This is the default
method for all usage types.

Counter Based Termination

The application credits the unused portion of the service based on price the customer
would pay if they continued consumption at the same rate for the rest of the period. This
means that the customer receives any price break based on the estimated usage.

For information on usage lines, see About Crediting a Customer in Terminations, page
5-13.

Subscription Lines
For subscription lines, how the terminated contract is prorated depends on whether it is
for a tangible or an intangible subscription.

Tangible Subscription Termination

Termination for tangible subscriptions can only be done for quantities (or fulfillment
periods), that have not been interfaced to Oracle Order Management. The termination
amount correlates to the quantity terminated. For example, if there are 12 fulfillment
periods for the subscription line, then the line can only be terminated in 1/12th
increments of the total line value. If the end date of the latest fulfilled period is greater
than termination date, the termination date for the subscription line will be moved
forward to be equal to the end date of the latest fulfilled period.

Suppose you have a 12 month subscription with a start date of January 1. The billing
amount for each month is $10. The months of January, February, and March have
interfaced with Oracle Order Management. If a termination date of February 15 is
entered, the termination date is moved to March 31 because this is the end date of the
latest fulfilled period. The months of April through December are included in the
terminated amount, which is $90.

Intangible Subscription Termination

Termination for intangible subscriptions can be either fulfillment based or effectivity
based, depending on if the system profile, OKS: Intangible Subscription Pricing Method
is set to Effectivity Based or Subscription Based. Effectivity Based is the same as the
termination functionality for terminations performed against Service Lines. Subscription
Based, is the same as the termination of tangible subscriptions.

For information on subscription lines, see About Subscriptions, page 6-1.
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17
Managing Your Work

This chapter covers the following topics:

• Overview of Managing Your Work

• Finding Contracts by Status or Notification Type

• Finding Your Most Recently Accessed Contracts

• Bookmarking Contracts

• Finding Bookmarked Contracts

• Creating Groups

• Organizing Contracts by Group and Subgroup

• Finding Contracts Using the Contract Groups Hierarchy

• Removing a Contract from a Group

• Searching for Contracts Using the Entitlements Search Window

• Using the Index to Navigate through Contracts

Overview of Managing Your Work
This group of topics explains how to manage your work in Oracle Service Contracts.

You can access contracts from multiple points within the application. Oracle Service
Contracts provides the ability to find contracts by status or notification type, and to open
recently accessed, or bookmarked contracts.

You can also organize your contracts into a hierarchy of groups, which can be viewed
from the Contract Navigator. Contract groups provide a convenient way to organize
contracts using any criteria. They are similar to folders and can be created for private
or public use.

You will generally access contracts from either the Launchpad or the Contract Navigator.

Finding Contracts by Status or Notication Type

To nd a contract by status or notication type:
1. Navigate to the Launchpad.
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2. In the Inbox region, click Find.

The Inbox Find window appears.

3. Select your search criteria:

1. To find a contract with a particular status, select a status from the Select Status
list.

2. To find a contract with a particular notification type, select a notification type
from the Select Notification Type list.

For example, you could perform a search for contracts with an open status that
require contract approvals or you could simply search for contracts that require
contract approval.

4. Select Find.

The Inbox is refreshed with contracts that meet your criteria.

5. To sort the results, click the column heading by which you would like the results
sorted.

You can sort columns in ascending or descending order.

6. Highlight the contract to review.

7. From the Inbox region, select Open.

The contract appears in the Service Contracts Authoring window.

Note: For information on responding to notifications, see Approving
Contracts, page 10-1.
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Finding Your Most Recently Accessed Contracts

To nd your most recently accessed contracts:
1. Navigate to the Launchpad.

2. In the Recent Documents region, scroll through the listing of contracts.

These are the contracts that you have most recently accessed.

3. To sort the list, click the column heading by which you would like the list sorted.

You can sort columns in ascending or descending order.

4. Highlight the contract to review.

5. From the Recent Documents region, select Open.

The contract appears in the Service Contracts Authoring window.

Note: You can also double click the contract number to open the
Service Contracts Authoring window.

Bookmarking Contracts

To bookmark contracts:
1. From the Service Contracts Authoring window, select the Actions menu and

chooseBookmark.

A note appears, indicating that the contract has been successfully bookmarked. This
adds the bookmark to the Bookmarked Documents region in the Launchpad. The
Bookmarked Documents region is a personal listing of contracts that you can access
quickly.

Managing Your Work 17-3



2. To review bookmarked contracts, see Finding Bookmarked Contracts, page 17-4.

Note: You can also bookmark a contract from the Contract
Navigator by:

• Highlighting a contract in the right panel

• Selecting Add Bookmark from the Tools menu.

Finding Bookmarked Contracts

To nd bookmarked contracts:
1. Navigate to the Launchpad.

2. In the Bookmarked Documents region, scroll through the listing of contracts.

Creating Groups
Groups help you to organize and find contracts more efficiently. A contract can be in
more than one group at a time. For example, a contract can be in your personal group
My Contracts and also be in the public group Business World Contracts. You can also
use groups to help you identify contracts that can be processed through actions such as
mass change, or reports.

To create a group:
1. From the Navigator, navigate to Contract Groups > Contract Groups.

The Contracts Groups window appears.
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2. In the Name field enter the group name. For example, Service Agreements.

3. In the Description field, provide a description of the group.

4. If you would like for this folder to be public, select the Public check box.

Note: If you do not check the public check box, you will create a
private folder that only you will see.

In order to have the ability to create public folders, your
administrator must set the profile OKC: Public Group Creator to Yes.

5. Save.

Note: If you would like to see a listing of all groups, you can use
the query function to display the groups in the Contracts Groups
window.

• From the View menu select Query by Example and then choose
Enter. The form changes to query mode.

• Enter% in the Name field.

• From the View menu select Query by Example and then choose
Run. A complete listing of the Contract Groups appears.

Organizing Contracts by Group and Subgroup

To organize contracts by group and subgroup:
1. From the Navigator, navigate to Contract Groups > Assign Contract Groups.

The Contracts Groupings window appears. The Groupings region on the left
provides a hierarchy you can use to navigate the contract groups.
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You can click the + icon to expand a node

You can click the - icon to collapse a node.

2. Select a node from the Global region, for example, Service.

The contracts that are currently a part of the group appear in under the Currently
Assigned Contracts heading.

3. Click Find.

The Search templates and Contracts window appears. You can use this window to
search for contracts that you would like to add to the criteria.

4. Enter your search criteria and click Search.

The results appear in the Available Contracts region of the Contract Groupings
window.
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5. To add a contract to the group highlight the contract in Available Contracts and
select the left arrow.

The contract is moved to Currently Assigned Contracts, which indicates that it is a
part of the group.

6. To remove a contract from the group, highlight a contract in Currently Assigned
Contracts region and select the right arrow.

The contract is moved to Available Contracts, which indicates that it is not a part
of the group.

7. To add a subnode to the Group, select the Groups tab.
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The Currently Assigned Groups and Available Subgroups regions are populated
with a listing of subgroups.

You can change the view of the Available Subgroups by selecting either Unassigned
or All Groups from the View list.

8. To add a subgroup to the group, highlight the subgroup in the Available Subgroups
region and select the left arrow.

The subgroup is moved to Currently Assigned Groups, which indicates that it is a
subgroup of the group.
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9. To remove a subgroup from the group, highlight a subgroup in Currently Assigned
Groups region and select the right arrow.

The contract is moved to Available Subgroups, which indicates that it is not a part
of the group.

10. Save.

Finding Contracts Using the Contract Groups Hierarchy

To nd a contract using the contract groups hierarchy:
1. Navigate to the Contract Navigator.

2. In the left panel, review the group hierarchy.

You can expand a node by selecting the + icon. You can collapse a node by selecting
the - icon.

3. Select a node to view the contracts, in that contract group node.
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For example, you could select the Global node to view all contracts within that node.

The contracts included in this group appear in the right hand panel.

4. To sort the results, click the column heading by which you would like the results
sorted.

You can sort columns in ascending or descending order.

5. Highlight the contract you wish to review.

6. Right click and select Open.

The contract appears in the Service Contracts Authoring window.

Note: You can double click the contract number if you would like to
open the Contract Execution window.

Removing a Contract from a Group

To remove a contract from a group:
1. Navigate to the Contract Navigator.

2. In the left panel, select a Group such as Service.

A listing of contracts appears.

3. Highlight the contract to remove from the group.

4. You can either:

1. Right click the contract and select Remove from Group, or;

2. From the Tools menu, select Remove from Group.
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A decision box appears, asking whether you are sure you wish to remove the
contract from the group.

3. Click Yes.

The contract is removed from the group.

Note: You can also add or remove a contract from a group by
updating the Contracts Group region within the Administration
subtab of the contract.

Searching for Contracts Using the Entitlements Search Window

To search for contracts using the Entitlements Search window:
1. From applications navigator, navigate to Entitlements Search.

The Entitlements Search window appears.

You can use this window to search for all contracts that match your search criteria, or
limit the search to Entitled contracts.

You can search for contracts based on their covered levels attributes, header
attributes, or line attributes, or a combination of these.

2. From the Search Option region, select whether you want to search all contracts or
entitled contracts.

Entitled contracts are those that are within their start and end date as of the time of
the search, and are in a status that has the operation Eligible for Entitlement set to Yes.

3. From the Contract Covered Levels region, specify the contract covered levels to
use in your search.

You can search by the following covered levels: product, item, site, system, account,
and party.
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This region has specific attributes associated with each covered level, which are
separated by rows. For example, if you select a product, the row with the Product
Name field also contains a Serial Number field and Reference Number field. These
additional attributes are used to narrow your search.

4. From the Lines region, specify lines attributes.

For example, you could add a service name, a status, and a duration to the search
criteria.

5. From the Header region, specify header attributes.

For example, you could add a contract status, party, and duration.

Note: To clear the form and re-enter your search criteria, you can
select Clear.

6. Select Search.

The Results window appears, which shows the details of the contract lines that
match the search criteria.

7. To view the coverage for a specific contract and line, select the line and click View
Coverage.

The Coverage Template appears in read-only form.

8. To open the contract, select the contract line and click Open.

The Service Contracts Authoring window appears. From this window, you can
manually adjust Warranty Start and End dates on installed products.

Note: If the entitlements search is used for any application other
than Oracle Service Contracts, the Line Detail window appears in
read-only mode. For example, a service agent could use entitlement
search from Oracle TeleService.

Using the Index to Navigate through Contracts
The index helps you find parts of the contract and allows you to navigate to them
directly, for example, to a particular line number.
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To use the index to navigate through contracts:
1. From the Service Contracts Authoring window, choose the Actions menu and select

Show Index.

The Contract Index window appears.

From this window you can view details of the contract such as the parties, line
level service items, the covered level products at the sublines, and the names of any
terms attached to the contract.

You can expand the hierarchy by selecting the + icon next to the node.

You can collapse the hierarchy by selecting the - icon next to the node.

2. To navigate to a specific point within the contract:

1. Highlight the node.

2. Click Go.

For example, if you highlight the Lines node and click Go, the Service Contracts
Authoring window displays the Lines tab.

3. Optionally, you can close the Contract Index window, by selecting Cancel.
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18
Running Reports and Programs

This chapter covers the following topics:

• Overview of Running Reports and Concurrent Programs

• About Reports

• About Concurrent Programs

• Running Reports and Programs

Overview of Running Reports and Concurrent Programs
This group of topics explains the reports available in Oracle Service Contracts.

Oracle Service Contracts provides several reports and concurrent programs designed to
help you analyze information and manage the application.

About Reports
The following provides a high level description of various reports that are available in
Oracle Service Contracts and describes the parameters that are available for each. Some
parameters are required while other parameters can optionally be used to narrow the
scope of the information that is included in the report.

Reports also create output information, that can be used to analyze your contracts.

For information on how to submit a report, see Running Reports and Programs, page
18-11.

Contracts QA Report
This report allows you to run a QA check on multiple contracts. This is particularly
useful when run immediately before the billing process, to help identify issues on
contracts before they are submitted to Accounts Receivable.

With this report, you can define the following parameters:

• From Contract Number (required)

• To Contract Number

• From Start Date (required)
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Note: When running the report, the From Start Date and To Start
Date will both default to the current date. If your contracts start
prior to this date, you will not see a report. Be sure to check your
start dates.

• To Start Date

• Contract Status

• Level of Details (required)

You can choose a report that details all contracts selected, all contracts that pass the
QA check, or all contracts that fail the QA check.

• Submit for Approval: If this parameter is set to Yes, the contract is automatically
submitted for approval if it passes QA.

• Ignore QAWarning: If this parameter is set to Yes, QA warnings are ignored

The report output includes details of the data checked including whether the checked
data had warnings and errors and if so, what results were found.

OKS Products Not Renewed Report
This report helps the sales representative identify customer products that have extended
warranties in an Expired or Terminated status. The extended warranty must have a
valid customer and vendor, and must also include a vendor contact role of sales person
or support sales. In addition, the product must not have been renewed to any other
extended warranty with in a Signed or Active status.

You can define the following parameters:

• Contract Group

• Org

• Sales Rep

• Customer

• From End Date

• To End Date

The report output includes a listing the part number, product description and serial
number, along with details of the line amount and the installed base start and end dates.

Service Contracts Bookings Report
This report lists the value of all service agreements, warranties and extended
warranties, in an Active, Approved, or Signed status with a valid customer or vendor
role specified. To be included, contracts must also have a valid vendor contact role
of sales person or support sales.

Contracts are grouped by the sales representative assigned to the contract.

You can define the following parameters:

• Contract Group

• Organization

• Sales Rep
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• Start Date From (required)

• Start Date To (required)

• Approved Date From

• Approved Date To

• Value Exceeding

• Sort By

You can choose to sort the report output by any of the preceding parameters or by
contract number, contract value, currency, customer name, date approved, invoice
date, invoice number, invoice value, modifier, sales representative, or start date.

Service Contracts by Status Report
This report allows sales representatives to track contracts by status. It includes service
agreements, warranties and extended warranties with a valid customer and vendor role
specified. To be included, contracts must also have a valid vendor contact role of sales
person or support sales.

You can define the following parameters:

• Contract Group

• Organization

• Sales Rep Name

• Customer Number

• Customer Name

• To Start Date (required)

• From Start Date (required)

• To End Date

• From End Date

• Status Code

• Status Type

• Currency Code

• Detail Report

The report output provides a listing of service contracts by status. It is sorted by sales
representative and provides status, customer, and start and end dates as well as the
contract value, selected status product value, and the annual rate.

Service Contracts Detail Report
This report displays key details of the contract headers, contract lines, and covered
products for contracts in the warranty and extended warranty categories. The report does
not extract all Service Agreement information. The report focuses on covered products.

You can define the following parameters:

• Contract Group

• Contract #
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• Customer

• Status Type

• Status Code

• Start Date From

• End Date From

• Start Date To

• End Date To

The report output provides a listing of:

• header level details such as the contract number, modifier, vendor, start and end
dates, customer, status, total value, currency code.

• service level details for each line such as the line number, the service, start and end
dates, and total value.

• product level details for each line such as line number, product name, start and end
dates, installed base number, serial number, reference number, quantity, pricing
attributes, and final price.

Service Contract Forecast Management Report
This report allows the sales representative and management to track the anticipated close
of contract renewals. It checks service agreements, warranties, or extended warranties in
an Entered status with a valid and customer role specified. To be included, contracts
must also have a valid vendor contact role of sales person or support sales.

You can define the following parameters:

• Contract Group

• Org

• Sales Rep

• Status Code

• Currency Code

• Minimum Contract Value

• Maximum Contract Value

• Forecast Start Period

• Forecast End Period

• Recognized Revenue Date

The report output provides a listing of forecast information by sales representative, such
as customer, contract number, modifier, status, start and end date, forecast
percentage, forecast date, last update date, contract value, contract forecast, revenue to
be recognized, and currency code.

Service Contracts Forecast Summary Report
This report lists the contracts eligible for renewal for a given period as well as the
recognized revenue date. It checks service agreements, warranties and extended
warranties in an Entered status with a valid customer and vendor role specified. To
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be included, contracts must also have a valid vendor contact role of sales person or
support sales.

You can define the following parameters:

• Contract Group (required)

• Org

• Currency Code

• Start Date (required)

• End date (required)

• Minimum Contract Value

• Maximum Contract Value

• Recognized Revenue Date (required)

The report output provides a listing of the following information by status type
and status code, such currency code, number of contracts, contract value, booking
forecast, revenue recognized value, forecast value.

Service Contracts Setup Report
This report is a diagnostic tool that facilitates debugging of implementation issues. It
also summarizes the setups and provides information on mandatory setup items. The
report provides a comprehensive overview of the setup performed in any application
environment and highlights the incomplete mandatory setups in red.

The report output is a PDF which can be seen by clicking View Output on the concurrent
request form after the report is complete.

Profile Setup:

Provides a list of User Profile Option Names and the values set for them. If any of the
mandatory settings are missing or not properly set, they are highlighted in red.

Transaction Type Setup:

Checks for Batch Transaction Source OKS_CONTRACTS and Transaction Type
Invoice-OKS and Credit-OKS.

Service Key Flexfield Setup:

Checks whether the key Flexfield Code SERV has been set up.

Category Setup:

Displays the categories and responsibilities set and the access level for Service and
Warranty Categories.

Order Capture Integration Setup:

Validates that OKS is set for Order Capture Integration.

Time Units Mapping:

Displays the user-defined time code units.

Global Contract Defaults:

Shows the values set in the Global Contract Defaults form.
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Coverage Template Setup:

Shows if a coverage template is defined for:

• Warranty

• Service

Statuses and Operations:

Displays all the contract statuses and operations for each status type.

Service Contracts Summary Report
This report allows the sales representative to track all contracts by customer. It includes
service agreements, warranties and extended warranties with a valid customer and
vendor role specified. To be included, contracts must also have a valid vendor contact
role of sales person or support sales.

You can define the following parameters:

• Contract Group

• Org

• Rep Name

• Customer Number

• Customer Name

• Form Date

• To Date

• Currency Code

The report output provides a summary listing of contracts for each customer, which
is sorted by sales representative. The report includes customer number, customer
name, contract number, modifier, status type, start and end dates, total value, currency
code, and when the contract was last updated.

Service Contracts Quote Printing Program for US
This report allows you to print the quotes or draft contracts along with a cover letter, after
the contracts have gone through the renewal process. It checks service agreements or
extended warranties with a valid customer and vendor role specified. Contracts must
also have a customer account at the line level. For service agreements, the covered
level should be System or Customer Account. For extended warranties covered level
should be covered product.

You can define the following parameters:

• Party

• Org

• Contract Number

The report output provides a sample letter that can be tailored to meet the needs of the
organization.
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Generate Quote
This report integrates with XML Publisher, to generate a PDF file using the quote
template that you specify in the parameters.

You can define the following parameters:

• Quote Template (required)

• Cancellation Notice - Sample

• Cover Letter - Sample

• Quote Letter - Sample

• Reminder Notice - Sample

• Org

• Party

• Contract Number

The report output provides a PDF file based on the quote template that you select.

List of Contracts By Contract Group
This report provides a list of contracts by contract group. You can define the following
parameters:

• Group

• Role (required)

• Category

• Start Date From

• Start Date To

• Status

• Currency

• Order By Amount

The report output lists the contract number, modifier, short description, date signed
currency code, estimated amount and the status. The output is sorted by the contract
group and the role, such as customer.

About Concurrent Programs
The following provides a high level description of concurrent programs that are
available in Oracle Service Contracts and describes the parameters that are available for
each. Some parameters are required while other parameters can optionally be used to
narrow the scope of the information processed. These programs are used to initiate
processes that enable particular functionality in the application.

For information on how to submit a report, see Running Reports and Programs, page
18-11.
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Service Contracts Main Billing
This program generates a log file of the total value processed, total value successful, and
total value rejected for billing. For all unsuccessful transactions, further contract
information will be displayed so that you can pinpoint the contract and/or line that
caused the issue.

You can define the following parameters:

• Contract Number

• Default Date

• Organization

• Customer Name

• Category

• Group

• Preview

AutoInvoice Import Program
This program is owned by Oracle Receivables. It imports the billing transactions from
the Service Contracts Main Billing Program into Oracle Receivables.

You can define the following parameters:

• Transaction Source (required)

• Default Date (required)

• Transaction Type

• (Low) Bill To Customer Number

• (High) Bill to Customer Number

• (Low) Bill to Customer Name

• (High) Bill to Customer Name

• (Low) GL Date

• (High) GL Date

• (Low) Ship Date

• (High) Ship Date

• (Low) Transaction Number

• (High) Transaction Number

• (Low) Sales Order Number

• (High) Sales Order Number

• (Low) Invoice Date

• (High) Invoice Date

• (Low) Ship To Customer Number

• (High) Ship To Customer Number

• (Low) Ship To Customer Name
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• (High) Ship To Customer Name

• Base Due Date on Trx Date

• Due Date Adjustment Days

For more information on this program, refer to the see the Oracle Receivables User Guide.

Service Contracts Fetch Receivables Info for Billing
This program fetches the invoice number and tax from Oracle Receivables and updates
the contract billing history. There are no parameters to define for this report.

Service Contracts Concurrent Program for Reassigning Resources
This program ensures that contract assignments are correct and that no contract is left
assigned to an inactive contact.

Service contracts are generally assigned to a resource that is responsible for following
through on inquiries from the customer through the life of the contract, from the initial
sale through the renewal process. If that person moves to another department, or leaves
the company, the appropriate level of attention may not be given to the contract.

This concurrent process can be scheduled to run as often as necessary, for
example, nightly. The process will check all contracts in an Entered status type. It will
compare the Vendor Contact resource that is assigned to the contract with the resource
assigned to the territory that the contract maps to in JTF territory management. If
the resources are different, the resource associated to the territory will overwrite the
resource that was assigned to the contract. The resource to which the contract is being
assigned will receive a workflow notification.

The following prerequisites are required to run this program:

• The JTF Territory assignments must be set up.

• The profile option OKS: Use Territories to Default Sales Person should be set to
Yes to use this process.

• The profile option OKS: Enable Sales Credits should be set to Derive.

• The resource must be assigned to the contract on the Summary Parties tab in the
Contacts region for the vendor.

You can define the following parameters:

• Contract Number

• Contract Status

• Organization

• Sales Person

Service Contracts Program to Process Suppress Credits
This program is used to send credits to Oracle Receivables in cases where the suppress
credit check box was selected during termination.

You can define the following parameters:

• Contract Number

• Organization
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• Category

Service Contracts Usage Averaging
This program is used to calculate usage averaging based upon the averaging interval
defined for each usage line in a contract.

Usage averaging allows you to give price benefits to customers for higher
consumption, by allowing you to average invoices over multiple periods. This ensures
the consumption is evenly distributed and customers can take advantage of price breaks.

See Charging for Reported or Estimated Usage Per Period, page 5-9.

You can define the Contract Number parameter.

Service Contracts Usage Settlement
This program is used to calculate usage settlement based upon settlement frequency
defined for each usage line in a contract. It calculates the settlement of any customer
undercharges or overcharges using the value defined in the Settlement Interval LOV.

Usage settlement reconciles discrepancies between actual consumption and the
estimated billed quantity. Discrepancies may arise if consumption is not captured before
you run the Service Contracts Main Billing program. When the consumption is not
captured before the billing program runs, the billing program estimates the consumption
for the period. Because the consumption captured for the billing period after running the
billing program may be greater or less than the actual billed quantity, you can use this
program allows to settle the discrepancies.

Your administrator should determine how frequently to run this program, monthly,
quarterly, or at the end of the contract.

See Charging for Reported or Estimated Usage Per Period, page 5-9.

You can define the Contract Number parameter.

Service Contracts Instance Relationship Program
This program is used to associate the parent instance created for a subscription line with
any child instances that are created when a tangible subscription ships.

You can define the Contract Number parameter.

Contracts Status Change by Contract
This program allows you to execute contract status change programs for a given
contract. This process changes the contract status if the selected contract qualifies for a
status change.

You can define the following parameters:

• Contract Number (required)

• Contract Number Modifier

Contracts Status Change by Range
This program allows you to execute contract status change programs for a range of
contracts. This process changes the contract status if the selected contracts qualify for a
status change.

18-10 Oracle Service Contracts User Guide



You can define the following parameters:

• Category

• from Number

• to Number

• from modifier

• to modifier

• Last Run Date

Running Reports and Programs

To run to reports and programs
1. From the View menu, select Requests.

The Find Request window appears.

2. Select Submit a New Request.

The Submit a New Request window appears.
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3. Select the Single Request radio button and click OK.

The Submit Request window appears.

4. From the Name LOV, select the report you would like to submit, for
example, Contracts QA Report and click OK.

The parameters window appears.

5. Define all mandatory parameters.

6. Click OK.

The Submit Request window appears with a concatenated listing of the parameters.
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7. Select Submit.

A Decision window appears with the request id. You should make a note of this
id. The application asks if you wish to submit another request.

8. Click No.

The Find Request window appears. You can use this window to track your request.

9. Verify the View All My Request radio button is selected, and click Find.

The Request window appears.
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19
Creating Contract Items in Oracle Inventory

This chapter covers the following topics:

• About Contract Item Types

• Creating Service Items

• Creating Warranty Items

• Creating Subscription Items

• Creating Usage Items

• Defining Serviceable Products

• Restricting How Items Can be Used

About Contract Item Types
This group of topics explains how set up items in Oracle Inventory for use in contracts.

Whether a contract is authored in Oracle Service Contracts or created automatically from
Oracle Order Management or Oracle Install Base, a contract must include lines.

The line types used in a contract are items that are created in Oracle Inventory. For
example, a computer manufacturer could set up an service itemWR23763 to cover the
Extended Notebook PC Service Plan.

Items are classified into four contract item types, including service, subscription, usage,
and warranty. How you classify these items restricts which contract categories can use
them. See Restricting How Items Can be Used, page 19-16.

Because an item must be defined as a serviceable item to be covered on a contract, you
must also ensure that there are items in the Item Master, which are serviceable. See
Defining Serviceable Products, page 19-15.

Creating Service Items
Services are items defined in the item master that determine the coverage terms that
are given or sold to a customer.

You must define service items in the item master.

This procedure highlights an example of how a service item can be set up, for additional
information on setting up product items in Oracle Inventory refer to the Oracle Inventory
User’s Guide.
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For information on entering service lines, see About Service Lines, page 4-2.

Prerequisite

Confirm that a Coverage Template is defined. See Defining a Coverage Template, page
20-3.

To create a service item:
1. Open Oracle Inventory and Navigate to Inventory > Items > Master Items.

The Master Items window appears.

2. Enter an Item.

3. Enter a Description.

4. From the Main tab:

1. Select the User Item Type, Service Pgm / Warranty.

2. Select a Unit of Measure, from the Primary LOV.

Note: A service must have a time Unit of Measure, such as
Year. For example, you should not set up a service item with a
quantity Unit of Measure, such as Each.

5. Select the Order Management tab:
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1. Select the Customer Ordered check box.

The Customer Orders Enabled check box is automatically selected.

2. Select the OE Transactable check box.

3. Select the Internal Ordered check box.

The Internal Ordered Enabled check box is automatically selected.

6. Select the Invoicing tab:
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• Select the Invoiceable Item and Invoice Enabled check boxes

7. Select the Service tab.

1. In the Contract Item Type, select Service from the LOV.

2. Select a Duration and Duration Period.

The Duration and Duration Period are used for defaulting service duration for
the service item, when it is selected in the Quoting application.

3. From the Template LOV, select a coverage template.

8. Save.

Creating Warranty Items
Warranties are services that are given to the customer free of charge, since the price is
assumed to be included in the price of the associated product.

You must define warranty items in the item master.

This procedure highlights an example of how a warranty item can be set up, for
additional information on setting up product items in Oracle Inventory refer to the
Oracle Inventory User’s Guide.

For information on warranties, see About Ordering Service in Oracle Order Management,
page 7-2.

The following table distinguishes between warranties and services. Extended warranties
are considered services:
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Warranties Services

Non-orderable and managed automatically Can be sold on a quote, order or a service
contract

Cannot be authored, can only be created when
products under warranty are sold from Oracle
Order Management or are manually created in
the Install Base

Can be authored or created via the Order
Management interface

Do not have a price Have unit or percentage based pricing

Associated with serviceable items in Bill of
Materials (BOM)

Are not included in a BOM

Have warranty inheritance rules Do not have warranty inheritance rules

Cannot be renewed, can be extended or
terminated

Can be renewed, extended or terminated

Prerequisite

Confirm that a Coverage Template is defined. See Defining a Coverage Template, page
20-3.

To create warranty items:
1. Open Oracle Inventory and Navigate to Inventory > Items > Master Items.

The Master Items window appears.

2. Enter an Item.

3. Enter a Description.

4. From the Main tab, select the User Item Type, Service Pgm/Warranty.
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5. Select the Order Management tab:

• Select the OE Transactable check box.

6. Select the Invoicing tab:

• Select the Invoiceable Item and Invoice Enabled check boxes.

7. Select the Service tab.
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1. In the Contract Item Type, selectWarranty from the LOV.

2. Select a Duration and Duration Period.

3. From the Template LOV, select a coverage template.

4. You may enter Starting Delay (Days).

For Warranty items, you can enter Starting Delay (Days), which will affect the
start date for the contract. The start date for the contract is equal to the ship date
plus the value entered in the Starting Delay (Days) field. The same date is also
used by Oracle Install Base as the installed date of the product.

For information on modifying warranty dates, see Modifying the Dates a
Warranty Is Effective, page 7-13.
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8. Save.

Note: After a warranty has been defined, it must be associated with
a serviceable product in the Bill of Materials for a warranty contract
to be automatically created. Refer to the Oracle Bills of Material User’s
Guide for further information.

When that product is shipped or is manually created in the installed
base, the warranty is automatically created in Oracle Service
Contracts. Warranties allow a support service to be automatically
associated with a product. The warranty is automatically associated
with the customer product in the installed base upon ordering and
fulfillment of the product to the customer.

Each serviceable product can be fulfilled with one or more base
warranties defined as components in the product’s bill of material.

9. Select the Enable Contract Coverage check box.

This makes the product serviceable. The Track in Installed Base check box is
automatically selected.

10. If defects for this item are to be tracked, then select the Enable Defect Tracking
check box.

11. Select the Enable Service Billing check box.

12. Select the Billing Type field. For example, Material, Labor, or Expense.

13. Select the Recovered Part Disposition speed.

This indicates if replaced parts are to be recovered and how quickly.

14. Save.

The product item is now a serviceable product.
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Creating Subscription Items
For subscription items to be priced and sold on a contract, they must be defined in
the item master.

A Subscription Item Type can either be selected as a contract line item on subscription
agreement, or as a subline to a service line.

• When a subscription is on a line, you are selling that subscription. An example is a
magazine subscription, delivered once per month for a year.

• If you want to sell service that provides coverage on a subscription, an example
is a subscription used to track the duration that a user has access to a web based
service. The service coverage on that subscription would be used to provide support
if the customer has problems with the service, such as a login issue.

This procedure highlights an example of how a subscription item can be set up, for
additional information on setting up product items in Oracle Inventory refer to the
Oracle Inventory User’s Guide.

For information on entering subscription lines, see About Subscriptions, page 6-1.

Prerequisite

Confirm that a Subscription Template is defined. See Setting Up a Subscription Template,
page 20-12.

To create subscription items:
1. Open Oracle Inventory and Navigate to Inventory > Items > Master Items.

The Master Items window appears.

2. Enter an Item.

3. Enter a Description.

4. From the Main tab, select the User Item Type.
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5. From the Order Management tab:

1. Select the Customer Ordered check box.

The Customer Orders Enabled check box is automatically selected.

2. For tangible subscriptions, select the Shippable check box.

3. Select the OE Transactable check box.

4. From the Contract Item Type LOV, select Subscription.

5. Select the Subscription Template that should be associated with this item.

This defines the fulfillment schedule defaults.

Note: You must select a Subscription template. If you do
not select a template, the subscription cannot be used on the
authoring form, it will display an error.

6. Select the Invoicing tab.
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• Select the Invoiceable Item and Invoice Enabled check boxes.

7. From the Service tab:

1. To enable the ability to file service requests against this item, select Enabled
from the Service Request list.

2. Select the Enable Contract Coverage check box to identify this product as being
serviceable.

The Track in Installed Base check box is automatically selected.
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3. From the Contract Item Type LOV, select Subscription.

4. Select the Subscription Template that should be associated with this item.

This defines the fulfillment schedule defaults.

Note: You must select a Subscription template. If you do
not select a template, the subscription cannot be used on the
authoring form, it will display an error.

8. Save.

The subscription item is now an inventory part as well as a serviceable product.

Creating Usage Items
For usage items to be priced and sold on a contract, they must be defined in the item
master. Usage includes things such as the number of copies made on a printer or the
number of calls made to Support.

This procedure highlights an example of how a usage item can be set up, for additional
information on setting up product items in Oracle Inventory refer to the Oracle Inventory
User’s Guide.

For information on entering usage lines, see About Charging a Customer for Usage,
page 5-1.

To create a usage items:
1. Open Oracle Inventory and Navigate to Inventory > Items > Master Items.

The Master Items window appears.

2. Enter an Item.

3. Enter a Description.

4. From the Main tab, select a User Item Type.
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5. Select the Order Management tab.

1. Select the Customer Ordered check box.

The Customer Orders Enabled check box is automatically selected.

2. Select the Internal Ordered check box.

3. The Internal Orders Enabled check box is automatically selected.

6. Select the Invoicing tab.
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• Select the Invoiceable Item and Invoice Enabled check boxes.

7. Select the Service tab.

1. In the Contract Item Type, select Usage from the LOV.

8. Save.
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Dening Serviceable Products
For a product to be covered by a service item, subscription item, warranty item, or
extended warranty item, the product item must be classified as a serviceable product.

Prerequisites

Confirm product items exist in Oracle Inventory.

For additional information on setting up product items in Oracle Inventory refer to
the Oracle Inventory User’s Guide.

To dene a serviceable product:
1. Open Oracle Inventory and Navigate to Inventory > Items > Master Items.

The Master Items window appears.

2. Query an item.

1. From the View menu, select Query By Example > Enter

2. Enter a value in the Item field, for example %AS5%.

3. From the View menu, select Query By Example > Run

The queried item appears in the form, You can arrow down to see additional
items that matched your query.

3. Select the Service tab.

4. To enable the ability to file service requests against this item, select Enabled from
the Service Request list.

5. Select the Enable Contract Coverage check box.

This makes the product serviceable. The Track in Installed Base check box is
automatically selected.
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6. If defects for this item are to be tracked, then select the Enable Defect Tracking
check box.

7. Select the Enable Service Billing check box.

8. Select the Billing Type field. For example, Material, Labor, or Expense.

9. Select the Recovered Part Disposition speed.

This indicates if replaced parts are to be recovered and how quickly.

10. Save.

The product item is now a serviceable product.

Restricting How Items Can be Used
Contract categories restrict the line types that can be added to a contract. Accordingly,
how you classify an item in Oracle Inventory impacts which contract categories can
use the item.

The following table shows the contract line items that can be used by each of the contract
categories.

Contract Line
Item

Service
Agreement

Subscription
Agreement

Warranty and
Extend Warranty

Warranty

(automatically
generated from
Oracle Order
Management)

Service contract
item type

Yes Yes Yes.
Line Type
indicates
Extended
Warranty rather
than Service.

No

Subscription
contract item type

Cannot be used as
a contract line, but
can be used as a
subline

Yes Cannot be used as
a contract line, but
can be used as a
subline

No

Usage contract
item type

Yes Yes No No

Warranty contract
item type

No No No Yes
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20
Setting Up Coverage and Subscription

Templates

This chapter covers the following topics:

• Overview of Coverage and Subscription Templates

• Specifying What is Covered in a Coverage Template

• Defining a Coverage Template

• Setting Up a Subscription Template

Overview of Coverage and Subscription Templates
This group of topics explains how can set up coverage and subscription templates.

Oracle Service Contracts enables you to define a standard set of templates, to create
offerings for a common set of agreements used by your organization, and modify them
to meet your customers’ requirements.

In order to create a:

• Service item in Oracle Inventory, you must first define a Coverage Template.

• Subscription item in Oracle Inventory, you must first define a Subscription Template.

Coverage Template
A coverage template contains attributes, that can be associated to a Service Item in Oracle
Inventory. It provides key information on how service should be carried out on products
covered under the contract. For each business process covered, it defines the times of
coverage, days of coverage, reaction and resolution times for a service request, preferred
resources, and the discounted rates that would be applied when work is performed on
covered products, see Specifying What is Covered in a Coverage Template, page 20-2.

You can use a coverage template to define warranty inheritance rules and transfer rules.

You can also link a Preventive Maintenance (PM) program to a coverage template, which
includes the schedule to perform a particular set of activities, such as changing toner
in a copy machine.

Note: The preventive maintenance schedule is created in a manner
similar to the billing schedule. Multiple maintenance streams can be
defined for a preventive maintenance program. Preventive Maintenance
programs are defined in Oracle Complex Maintenance, Repair, and
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Overhaul. For more information, see the Oracle Complex
Maintenance, Repair, and Overhaul User’s Guide.

The following topics and procedures define and describe how to set up a coverage
template:

• Specifying What is Covered in a Coverage Template, page 20-2

• Defining a Coverage Template, page 20-3

Subscription Template
A subscription template contains attributes, that are associated to a subscription item
in Oracle Inventory. The attributes include Subscription type, Media and Property
type, Fulfillment Channel, and Frequency.

A subscription item can be a tangible item like a magazine, or an intangible item like a
membership.

Currently Oracle Order Management is supported as the fulfillment channel. If
no fulfillment channel is specified, it is considered an intangible item, and
no delivery schedule is created for that item. Subscription Frequency such as
Yearly, Monthly, Weekly, and Daily identifies how often an item should be delivered.

The following procedure describes setting up a subscription template, Setting Up a
Subscription Template, page 20-12.

Specifying What is Covered in a Coverage Template
Service coverage describes the situations under which the customer is covered for
service. Services are broken down into business processes, which are related the
service, such as Depot Repair. Coverage Terms are then defined for these business
processes.

Creating a Coverage Template

The preceding diagram represent the steps necessary to complete a coverage
template. Following is a description of the steps and an example:
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• Define Coverage: Specify coverage name, type, importance level, effective
dates, warranty inheritance, transfer rules, or attach a preventative maintenance
program.

• Define Business Process: Specify the business processes that the coverage template
will use.

For example, select the Field Service business process. You will need to define
coverage times, reaction times, resources, and billing types for each business process
that you add.

• Define Coverage Times: Specify the days of the week and hours used to calculate
reaction and resolution times. A customer can request service anytime. If they
call up support, the service agent will not turn down the call if the call is beyond
the coverage times. The coverage times simply determine the starting point from
where you start counting reaction and resolution times. For example, if coverage
ends at 5 p.m. on a Monday and starts again at 9 a.m. on a Tuesday, with a two hour
response time; if the call comes in at 4 p.m., the respond by time will be 10 a.m. on
the Tuesday (assuming work through is not checked). If the coverage is 24 hours per
day and seven days a week, the respond by time would be 6pm. Coverage times
are defined for each business process as part of coverage terms, and are applicable
to one time zone.

• Define Reaction Times: Specify the amount of time allowed by which action must
be initiated for a particular process being requested.

For example, set up reaction times of two hours Monday through Sunday, which
means that you must respond within two hours of being notified by the customer.

Reaction times are tied to severity.

• Define Resolution Times: Specify a fixed time per contract by which a normal
operation should be restored. The Resolution Times will be made available to other
functions, such as Service Request.

For example, you could set up resolution times of eight hours Monday through
Friday, which means if the customer calls Monday through Friday you must resolve
the issue within eight hours.

Resolution times are tied to severity.

• Define Resources: Specify the list of resources that are eligible to work on a
specific task when a service request is created. Resources can be classified as
Primary, Preferred, or Excluded.

For example, identify a primary service engineer that responds to service calls.

This information is used by Assignment Manager to assign a service engineer.

• Define Billing Types: Specify for each Business Process, what type of work is
covered, to what limit, and at what rate. The billing types and rates are used when
calculating the amount to charge a customer when work has been performed.

For example, define a replacement transaction type where the customer is charged
for material and labor.

Dening a Coverage Template
Prerequisites
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The following must be defined as part of your implementation:

• Coverage Type Lookup Code (Oracle Service Contracts)

• Business Processes (Oracle TeleService)

• Price List (Oracle Order Management)

• Time Zone

• Service Request Severity (Oracle TeleService)

• Resource Types (Oracle TeleService)

• Resources (Oracle TeleService)

• Billing Types (Oracle TeleService)

• Billing Rates (Oracle TeleService)

• Preventive Maintenance Program (Oracle Complex Maintenance, Repair and
Overhaul)

To dene a coverage template:
1. From the Navigator select the Coverage Templates function.

The Service Contracts Coverage Template window appears.

2. In the Coverage region, enter the following:

Name: Enter the name of the coverage.

Type: Select the type of coverage such as Gold, Silver, or Bronze from the LOV.

After you select a coverage type, the Importance Level field and start dates for the
Effective Dates fields are populated with values.

The effective Start Date is required and the End date is optional.
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Note: When reviewing a service request, a service agent can click
the Line Details button to open the Line Details form, which enables
the service agent to view the covered level details and compare the
products covered under the contract with those that are related to
the service call.

The Line Details button is active only when the contract coverage
is viewed from the Service Request form. It is disabled when you
create or update a coverage template.

Access to the Line Details option is controlled by application
function security so that only authorized users are able to see the
contract line details. You must ensure that your administrator has
added the Service Contracts function named Covered Level Details
to the appropriate user menus.

Description: Enter a brief description for the coverage.

Exception: Optionally, enter an exception coverage for the period between when the
contract is expired and when it is renewed.

Suitable as Exception check box: Select this check box if you want this coverage
template to be used as an exception coverage for other coverage templates.

Note: You can add a note the coverage template, by selecting the
Notes button. This opens the Notes window.

For information on notes, see Communicating Using Notes, page
13-1.

1. Define warranty inheritance rules as follows:

Warranty check box: Select this check box to define warranty inheritance, which
allows the warranty to continue if the product is replaced. This check box controls
whether or not this coverage can be selected against a warranty item in the item
master.

Inheritance: Select value if the warranty should continue when the product is
replaced.

Remaining Duration: Replacement product’s warranty is the remaining duration
of the original warranty.

Full New Duration: Replacement product’s warranty is a brand new warranty
duration.

Note: The Warranty check box can be updated. However, if an
Inheritance has been entered in conjunction with the Warranty check
box, the Inheritance must be set to NULL before the Warranty check
box can be unchecked.

Billing Types may be set up for warranties as for any other type
of coverage.

Synchronize date installed check box: Select this check box, if you
want to set the warranty start date to be the same as the installation
date.
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When a product installation date is changed, Service Contracts
checks for contracts that cover that product. For every service that
covers the product, the coverage definition is checked for warranty
coverage that has the attribute set to allow the installation date
synchronization.

If this option is selected, Service Contracts checks whether any
service request has been logged on dates that would be outside the
warranty period if it were changed to start on the new installation
date. If no service request exists, the warranty start date is changed
to the installation date. To preserve the original duration of the
warranty, the end date is also changed. The effect of the change is
automatically cascaded to the coverage definition.

Define other coverage template rules as follows:

Free upgrade check box: Select this check box if you want to track this coverage as
having a free upgrade.

This flag does not provide any automated functionality at this time.

Transfer: Determine the status of the contract in case a customer product is
transferred from one owner to another. This is a required field.

No Change: There would not be any changes in the existing owners contract. No
new contract is created for the new owner.

Terminate: The current contract subline is terminated. The termination date would
be the transfer date. No new contract is created for the new owner.

Terminate if Not Related: If the new owner is related to the current owner, no
changes are made to the contract. If the parties are not related, the current contract is
terminated. The termination date would be the Transfer date.

Transfer: The current contract subline is terminated with the Termination date set to
Transfer date. If the Contract Transferred is a Warranty Contract, then a Contract for
the new Owner is created in Active Status. If the Contract transferred is an Extended
Warranty or Service Contract, a contract is created for the new owner in the status
defined by the profile option OKS: Transfer Status. The contract will have a one-time
billing schedule and advance billing.

Transfer if Not Related: If the new owner is related to the current owner, this
option keeps the current owners contract in force. If the owners are not related, the
current contract is terminated and a contract for the new owner is created. If the
contract transferred is a Warranty contract, then the new contract is created in the
Active status. If the contract transferred is an Extended Warranty or Service type
contract, the contract will have an advance one-time billing schedule and the status
of the contract would be defined by the profile option OKS: Transfer Status.

Define Preventive Maintenance programs as follows:

Program Name: Select a Preventive Maintenance Program.

The program description displays after you select a program name.

Preventive Maintenance programs are setup in Oracle Complex
Maintenance, Repair, and Overhaul.
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Note: You can open the Preventive Maintenance Schedule form and
view or modify the information related to the selected Preventive
Maintenance program., by selecting the Schedule button.

For more information on setting up Preventive Maintenance
programs, see the Oracle Complex Maintenance, Repair, and Overhaul
User’s Guide.

3. In the Business Process region, enter the following:

Business Process: Select a Business Process from the LOV, such as Depot Repair.

Offset Duration: Enter the offset duration or amount of time you would like the
service to be offset from the authored contract’s start date.

For example, set onsite support to start one month after the contract comes into effect
and set hotline support to be available immediately.

Offset Period: Specify the unit of measure for the offset duration, such as hour or
day.

If the Offset Duration is modified, the Start and End dates are automatically adjusted
as long as they’re within the range of the service coverage dates, and conversely, if
the Start and End dates are modified, the Offset Duration is automatically adjusted.

Price List: Select the default price list that should be used when billing service
charges.

Discount: Select the percentage of discount allowed for the transaction group, for
example 10%, from the LOV.

4. From the Coverage Times tab, enter the following:
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Timezone: Select a Time Zone from the LOV.

You can define more than one time zone for each business line. However, you must
define at least one time zone for every business process line.

Default check box: Select a timezone as the default for the selected business process.

Apply Default to Other Time Zones check box: To have the Default coverage
times applied to any other timezone for which you have not entered any coverage
times, select the Apply Default to Other Time Zones check box

In the Covered Times region: Enter a Start Time, End Time, and select the check
boxes for the applicable days for each time zone.

For a given business process, the coverage time for at least one day must be entered.

You can enter multiple coverage times for a specific time zone.

You can also define multiple coverage times for the same day, as long as the coverage
time records do not overlap.

Note: You can select the Always Covered button, to set to set the
Start Time and End Time for all days to 00:00 and 23:59 respectively.

5. From the Reaction Times tab, enter the following:
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Severity Name: Enter a name for the severity definition, for example, Level 1 or
Important.

Severity: Select the level of severity, for example High, from a LOV.

Workthrough check box: If selected, this check box overrides the normal coverage
times for that transaction.

For example, suppose you have support, Monday through Friday from 9 a.m. to 5
p.m., with a 2 hour reaction time. If a customer calls midweek for support at 4:45
p.m., and Work Through is checked, the customer is entitled to receive support by
6:45 p.m. that evening. If the Work Through option is not selected, then the support
representative has until 10:45 a.m. the next morning to respond to the call.

Active check box: If selected, this check box indicates this severity level is active and
makes the reaction times available through an entitlements call.

Reaction Times for days of the week: Enter specific reaction times, in hours, for
each applicable day.

For example, 2:00 in the Monday field, indicates a service call must be made within
two hours if there is a call on Monday.

Workflow: Select the applicable workflow for each reaction time name specified.

6. From the Resolution Times tab, enter the following:
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Severity Name: Defaults from the Severity Name on the Reaction Times tab.

Severity: Defaults from the Severity on the Reaction Times tab.

Workthrough check box: If selected, this check box overrides the normal coverage
times for that transaction.

Active check box: If selected, this check box indicates this severity level is active and
makes the resolution times available through an entitlements call.

Resolution Times for days of the week: Enter specific resolution times, in hours, for
each applicable day.

For example, 4:00 in the Monday field, indicates the issues must be resolved with
four hours if there is a call on Monday.

7. From the Resources tab, enter the following:
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Type: Select a resource type from the LOV. For example, Engineer.

Name: Select the resource by name.

Classification: Select the proper classification for the resource from the LOV.

You can classify a resource as Preferred, Primary or Excluded.

If you classify a resource as Excluded, the Assignment Manager removes the
resource from the list of available resources.

8. From the Billing Types tab, enter the following:

Service Activity Billing Type: Select the billing type from the LOV.

Duplicates are not allowed.

If the billing type is Labor, then the Billing Rates button is enabled.

Up To Amount: Enter the maximum allowed amount.

If you leave this field blank, the upper limit would only be restricted by the
percentage covered or discount you enter in the % Covered field.

% Covered: Enter the percentage covered or discount.

For example, if new parts have been installed to fix a problem at a customer site, the
bill for the work needs to be calculated, taking the coverage on the service contract
into account. If parts are covered 50% up to a maximum of $300, and the charge for
parts was $800, after applying the rates agreed on the contract, the charge would be
calculated as $500, after the maximum discount of $300 has been applied. For the
same contract rates, if the charge for parts came to $500, the customer would receive
the full 50% discount ($250) since the discount is below the $300 maximum.

Allow Full Discount check box: If selected, this check box provides 100% coverage
for warranties without requiring setup of billing types. If unchecked on the
template, the box will be grayed out on the contract. Any bill types data populated
on the template will override the use of this check box.

Billing Rates: Select this button to open the Billing Rates form.
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9. Save.

Setting Up a Subscription Template

To set up a subscription template:
1. From the Navigator select the Subscription Template function.

The Subscription Template window appears.

2. In the Name filed, enter a name for the template.

Examples of names include Monthly or Yearly.

3. In the Description field, enter a description for the template.

Examples of descriptions include Monthly Subscription or Yearly Subscription.

4. In the Subscription Type field, select the type of subscription from the LOV.

Examples of subscription types include journals, magazines, or news letters.

5. In the Media Type field, select the type of medium from the LOV.

Examples of medium include document, image, and audio.

6. In the Fulfillment Channel field, select of one the following options:

• Order Management: for tangible items that need to shipped

• None: for intangible items

7. In the Frequency field, select a subscription frequency:

• Daily

• Weekly

• Monthly

• Yearly

8. Enter any additional information in the Comments field.

9. Verify the Active check box is selected, to ensure the subscription template is active.
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10. Select OK.
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